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Introduction 

Your Creative Labs' multimedia kit includes: 

•!• Sound Blaster 16: A high-quality 16-bit, 20-voice audio card that 
produces CO-quality sound and music through your computer. 
Included are Windows and DOS applications and utilities, such as: 

• Monologue for Windows: Have all or part of a document, 
including electronic mail and spreadsheet data, read to you 

• EnsembleAV: Control audio players (CD, MIDI, and wave) 
through an on-screen display that duplicates the features of the 
remote control for your home sound system. 

• Talking Scheduler: A computer-generated voice reminds you of 
appointments, or record your own voice messages 

• WaveStudio 2.0: Record, edit, and add effects to sound files 

• Soundo'LE: Link and embed sound files in a files created by 
applications that support OLE (object linking and embedding) 

• Sound Blaster 16 Mixer: Sophisticated control over audio input 
and output 

• Intelligent Organ: Learn to use your computer keyboard as a 
musical keyboard, add accompaniment as you play a melody 

•!• CD-ROM Drive: Double-speed, 300 KB/second transfer rate 
improves viewing of Video for Windows and Quicktime multimedia 
presentations; multi-session photo CD compatible; play music CDs 
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System Requirements 
To use Sound Blaster 16, the CD-ROM drive, and the software, you need: 

•:• An IBM-compatible 386SX or above 

•:• 4MB RAM (random access memory) 

•:• 4MB of storage space on your hard disk (for the software) 

•:• MS-DOS 3.1 or higher 

•:• SVGA card (640x480, 256 colors minimum) 

•:• 3.5-inch, 1.44MB floppy disk drive 

•:• Windows 3.1 (for Windows applications) 

•:• Available 16-bit expansion slot (for Sound Blaster 16) 

•:• Available half-height drive bay (for CD-ROM drive) 

Disk Backup 
Before you start, make backup copies of the original disks. Use the 
backup disks; keep the originals in a safe place. 
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Conventions 
The following typographical conventions are in effect throughout this 
document. 

Bold Bold face type identifies words and phrases that are to be 
entered exactly as shown. For example: 

SET SOUND=C:\SB16 

Italic Italic type identifies words and phrases that are to be 
replaced by you. For example: 

voc2wav sample.VOC 

When using this command, you must supply a value for 
sample. 

Italic is commonly used to emphasize a word/phrase, or to 
identify a word/phrase that is being defined. In the text of 
this document, it is also used to identify a button or menu 
item that you are to select with the keyboard keys or the 
mouse; for example, "Select the Play button on the main 
menu." 

[Brackets] Brackets indicate command parameters that are optional; 
if you choose not to include optional values, there may be 
default values that are automatically inserted. For 
example: 

PCXDriver=[ONIOFF] 

In this command, you may choose to set PCXDriver on or 
off; the choice is optional because the command has a 
default that is substituted if you do not make a selection. 

{Braces} Braces indicate command parameters that must be 
included. For example, 
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SETVOL {source 1-vol}[,r-vol] 

In this command, you must enter values for source and 
1-vol; a value for r-vol is optional. If required parameter 
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values are not included, the command is ignored or 
returns an error message. 

Ellipses indicate that the preceding parameter can be 
repeated. For example, in the command below, you can 
include any number of source values: 

SET [RECJIIX I OUTMJ:X] 
level source[+source][ ••• ] 

ALL CAPS A word in all capital letters identifies a key you are to 
press. For example, "Select the Yes button and press 
ENTER." 
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One 

Installing 
Creative Multimedia Kit 

f nstalling the Creative multimedia kit on your computer requires you to 
do the following: 

•:• Install the Sound Blaster 16 card in your computer 

•:• Install the CD-ROM drive in your computer 

•:• Connect speakers or headphones as well as other devices to the 
Sound Blaster 16 

•:• Run the installation program (to install the Creative software on your 
hard disk and initialize Sound Blaster 16 and the CD-ROM drive) 

•:• Test the Sound Blaster 16 and its hardware settings, and the 
CD-ROM 

•:• Set up the Windows 3.1 drivers and applications 

Each of these procedures is described in detail on the following pages. 
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Installing the Sound Blaster 1 6 
Audio Card 
If you currently have Sound Blaster, Sound Blaster Pro, or any audio 
card installed on your computer, remove it before you install 
Sound Blaster 16. You will need a Phillips screwdriver for removing the 
computer cover, for removing the slot cover, and for securing the sound 
card. 

To install Sound Blaster 16: 

1 . Tum off your computer and monitor. Disconnect the monitor from the 
computer and set it aside. 

2. Position the computer so that you can work on the back. Remove the cover 
from the computer. Review your computer manual for specific instructions 
for removing the cover and follow them explicitly. 

Most computer covers are held in place by a number of screws inserted in 
the back panel. After removing these screws (put them aside for replacing 
the cover), lift the cover carefully and pull away from the computer. If the 
cover does not lift away easily, do not use excessive force-look for 
additional screws that need to be removed or some portion of the cover that 
is not free of the computer. 

3. If there is a game card or a card with a joystick port installed in your 
computer, either remove the card or change the JYEN jumper on 
Sound Blaster 16 to disable its joystick port. (Disabling the joystick port 
does not affect its use as a MIDI port.) For more information on the JYEN 
jumper, see "Changing the Joystick Port Jumper" in Appendix B, 
"Changing Sound Blaster 16's Configuration." 

NOTE For highest quality playback, ~n externalamplifi~~ i;reco;;;;~nd~d.""~ 
#-BAA 6 &i£i'i"'-%MM 6&9 kRWR · &i'5&Mi#·l§hdWm" @ttE:ZSI!bS&ii·-·z •·S•··ll-·;±tl ,.,.,~;.·~~ 

4. Choose a 16-bit slot for Sound Blaster 16 (8-bit slots are noticeably 
smaller); the slot must accommodate the two tabs extending from the 
bottom of the card (see figure 1-1). Make sure there are no installed cards 
or add-ons that will hinder positioning and inserting the card. If the 
external opening for the slot at the back of the computer is covered, remove 
the screw holding the cover in place, then remove the slot cover. (Keep the 
screw-you will need it later to secure the card.) 
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FIGURE 1-1: Position of Sound Blaster 16 

5. Insert the Sound Blaster 16 card: Align the gold-striped tabs on the bottom 
of the card with the socket on the computer board and the metal bracket 
(figure 1-2) with the external opening, then push down firmly on the top of 
the card. You should feel the card settle into place; the top of the metal 
bracket should match the slot screw hole. 

Une In 

Microphone 

line Out 

Speakers 
Out 

Joystick/MIDI 
Adapter 

FIGURE 1-2: Location of the volume control, connectors, and jacks on the 
external end of the Sound Blaster 16 

6. Use the screw from the slot cover to secure Sound Blaster 16 to the frame of 
the computer. (Securing Sound Blaster 16 with the screw assures it is 
properly grounded.) 
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Installing the CD-ROM Drive 

The information that follows describes how to install the CD-ROM drive 
in your computer. See Chapter 3, "Installing the Creative Software," for 
information on the software installation that allows you to control the 
CD-ROM drive. 

Disc 

(( ~~~till~ l'Jli~ ] .~ay 
~====~============~ 
Phones Vol Busy 

®~CJ 
Eject 

I• I 

t ... 
Stereo I 
phone 
jack Volume 

control 

t t 
Eject 
hole 

t 
Eject 
button 

Busy 
indicator 

FIGURE 1-3: Front panel of the CD-ROM drive 

l < >"' -~} 1 .................... :ll• •• •Jf r::rn !················ .... r, •• ~ •••• r 
Power-in ID jumper 

connector switch 
Interface 

connector t AudiO 
EIAJ output 

connector connector 

FIGURE 1-4: Rear panel of the CD-ROM drive 

NOTE The CD-ROM drive installation instructions that follow require that 
the Sound Blaster 16 card be installed. If you have not done so, 
install Sound Blaster 16 before proceeding. 
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To install the CD-ROM drive: 

1. With the computer cover removed (see "Installing the Sound Blaster 16 
Audio Card," earlier in this chapter), remove the cover of a vacant drive bay 
for the CD-ROM drive. Most personal computer have vacant drive bay(s) 
above or below your floppy disk drive(s). The cover may pop out or require 
that you remove one or more screws. 

2. Carefully insert the CD-ROM drive into the vacant drive bay. 

Some drive bays require rails to be attached to the sides of the CD-ROM 
drive. If the drive does not fit the bay properly, use the rails supplied with 
your computer; if no rails are included, contact the manufacturer or your 
dealer. 

3. Secure the CD-ROM to the computer by inserting and tightening the screws 
on the sides of the drive bay. 
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Connecting the CD-ROM 
Drive to the Sound Blaster l 6 
Your Sound Blaster 16 has the connections necessary for the control and 
operation of your CD-ROM drive. 

To connect the CD-ROM drive to your Sound Blaster 16 card: 

1. Connect the data cable to the CD-ROM drive as shown in figure 1-5. The 
data cable connector is designed to fit into the CD-ROM connector only 
when inserted in the correct position; if the connectors do not match, try 
turning over the data cable connector and trying again. 

Data Cable 

FIGURE 1-5: Connecting the data cable to the CD-ROM drive 

2. Connect the computer power supply cable and the audio cable to the 
CD-ROM drive. 

3. Connect the data cable and audio cable to the Sound Blaster 16 as shown in 
figure 1-5. 

4. Replace the cover on your computer, reconnect the monitor, and plug in and 
turn on the computer. 
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An 1 

-

A.Jdio 
cable 

Data cable _,...._ ___ L. ____ _j L------------' 

connector Sound Blaster 16 A.Jdio Cord 

FIGURE 1-6: Connecting cables from the audio card to the internal 
CD-ROM drive 
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Connecting Devices to 
Sound Blaster l 6 

Two 

You can connect a wide range of devices-such as cassette players, 
microphones, speakers, amplifiers, MIDI (musical instrument digital 
interface) instruments, and joysticks-to Sound Blaster 16, as shown in 
the illustration below: 

Sound Blaster 16 

FIGURE 2-1: 

Line In 

Microphone In 

Line Out 

Speakers Out 

Joystick/MIDI 
Connector 

Connecting devices to the Sound Blaster 16 
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Connecting Speakers 
to Sound Blaster l 6 

To connect speakers or headphones to Sound Blaster 16: 

1 . Plug the speakers or headphones into the Speakers Out jack to use the 
Sound Blaster 16 built-in amplifier. User Creative Mixer to adjust the 
voume (see Chapter 4, "Creative Mixer"). 

2. If you are using an external amplifier for your speakers or headphones, plug 
the amplifier into the Line Out jack. 

u 1: ~ ' 

i ' 
~ 
u 

.2 10- :jli 
§~~lsi! 
g :!tJ 
lt. ~ 

MltsumiiRQ 
Qnterrupt) 

Socket for .Advanced 
Signal Processor 

... 

D 
II -

CD-In PCSPK 
Connector Connector 

JP15 

1 ~;:::: ::::-:·:n: 
MIDi e·Xtensl0n Connector 

IFSDI APSD l§l 
JVEN l§l 

UneOut 

Speaken; 
Out 

Joysflck/MIDI 
Pdapter 

FIGURE 2-2: Sound Blaster 16 

NOTE stereo power amplifier has a maximum output power of 
four watts per channel with four-ohm speakers and two watts per 
channel with eight-ohm speakers. DO NOT adjust the Creative Mixer 
volume to maximum level if your speakers or headphones cannot 

power--the speakers may be aarna~•ea. 
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Connecting a MIDI Device 
Sound Blaster 16's MIDI interface is compatible with two MIDI 
standards: 

•:• MPU-401 UART 

•:• Sound Blaster MIDI 

You can use only one of the interface standards at a time. To connect a 
MIDI device to Sound Blaster 16, you need the Sound Blaster MIDI kit. 
The MIDI kit contains a cable adapter with a joystick port so you can 
have both a MIDI instrument and a joystick attached to the card at the 
same time. It also contains a MIDI sequencing application that lets you 
write and play MIDI music. Ask your dealer or call Creative Labs for 
the latest information on MIDI software for the Sound Blaster 16. 

Connecting a Joystick 
The joystick port on the Sound Blaster 16 is the same as that on a 
standard PC game control adapter or game 1/0 port. You can connect 
any analog joystick with a 15-pin D-sub connector to the port; it works 
with any application that is compatible with standard PC joysticks. If 
you need to run two joysticks, a Y-cable is available from Creative Labs 
(Y-cables from other sources may not work). 

If your computer has a game card or a card with a joystick port installed, 
either remove the card or change the JYEN jumper on Sound Blaster 16 
to disable its joystick port. (Disabling the joystick port does not affect its 
use as a MIDI port.) For more information, see "Changing the Joystick 
Port Jumper" in Appendix B, "Changing Sound Blaster 16's 
Configuration." 
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Connecting Wave Blaster 
Sound Blaster 16 has a connector for Wave Blaster, a general MIDI 
expansion module. Wave Blaster is an add-on daughter card to 
Sound Blaster 16; it contains a sound generation subsystem that uses 
sampled wave synthesis to produce extremely high fidelity stereo sound 
for computer audio systems. For more information about Wave Blaster, 
ask your dealer or call Creative Labs. 

Connecting the Internal 
Speaker 
You can redirect the sound from your computer's speaker to the speakers 
connected to Sound Blaster 16. Internal speakers in computers are 
installed in a number of ways. If you are not familiar with the internal 
speaker setup, contact a qualified service technician for help. Making 
the wrong connections can damage both your computer and the 
Sound Blaster 16 card. 

To redirect soundfrom the internal speaker to Sound Blaster 16: 

1. Locate the speaker connection on the computer's main board and 
disconnect the internal speaker. 

2. Connect a wire from the speaker connector's +5Vdc pin to pin I of the 
jumper labeled JP15 on Sound Blaster 16 (see Appendix B, "Changing 
Sound Blaster 16's Configuration," figure B-2). 

3. Connect a wire from the speaker connector's signal-out pin to pin 2 of the 
JP15 jumper on Sound Blaster 16. 

4. Once the computer's speaker has been conr1ected, the volume can be 
controlled with the Mixer (see Chapter 4, "Creative Mixer"). 

2-4 GETIING STARTED 



Connecting an External 
Power Amplifier 
Sound Blaster 16 has a built-in stereo amplifier that allows you to 
connect speakers or headphones directly to the card without the need for 
an external amplifier. However, an external amplifier produces a lower 
distortion level and a better frequency response. Simply connect the 
external amplifier to Sound Blaster 16 through the Line Out jack (see 
figure 2-2. 

Connecting Other Devices 
Connecting devices such as cassette players, microphones, and speakers 
to Sound Blaster 16 is just a matter of plugging them into the correct 
jack. Here are some guidelines for using such devices: 

•:• Check the illustration (figure 2-1) on page 2-1 to identify the correct 
jack for the device. 

•:• The built-in stereo amplifier has a maximum output power of four 
watts per channel with four-ohm speakers and two watts per channel 
with eight-ohm speakers. Do not tum the volume up to its maximum 
level if your speakers or headphones cannot handle the full power. 

•:• If you purchase a microphone to use with Sound Blaster 16, select a 
good quality microphone-a 600-ohm, -75db microphone that costs 
around $30.00 is fine. A condenser microphone also works well. 
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Three 

Installing 
Creative Software 

f nstalling the Creative software on your computer requires you to do the 
following: 

•:• Run the installation program to install the software on your hard 
disk, and initialize Sound Blaster 16 and the CD-ROM drive 

•:• Test the card and the hardware settings 

•:• Set up the Windows 3.1 drivers and applications 

Each of these procedures is described in detail on the following pages. 

NOTE J~;tallati"a;in~;;~~;i~~~ fo;.'j.Jo~;loiu~ ~~;·w;~'d;7v;j; in~i;;ded i~~ 
Chapter 9, "Monologue for Windows." Creative Talking Scheduler 
(Chapter 10) is installed with Monologue for Windows. 

~~----~-.-· ~·~w=nmamsm-~msw~wmmRm----~•Eam-~±9m"•mm~ma~~w"'~ 
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Installing the 
CD-ROM Software 
The installation program installs the QuickCD application and the two 
drivers needed to control your CD-ROM drive. 

To install the software: 

1 . Insert the CD-ROM installation disk into a floppy disk drive. 

2. Type A: orB: to change to the appropriate disk drive, type INSTALL, and 
press ENTER. A screen appears followed by the installation main menu. 

3. Select View Readme File and press ENTER. 

4. Select Begin Installation and press ENTER. 

5. The installation program creates a subdirectory in your sound directory for 
the software and drivers. When prompted to select the 1/0 address, select 
the one that matches your Sound Blaster 16--default is 220. 

6. The CD-ROM installation program asks for the installation directory. The 
default is C:\SB 16 for the Sound Blaster 16 software. Accept the default 
unless you intend to change the sound directory. 

7. Enter the boot drive for your computer; the default is C. 

After the CD-ROM software is installed, the program adds the driver 
lines to your AUTOEXEC.BAT and CONFIG.SYS files. (See 
"CD-ROM Drivers" later in this chapter for more information.) You 
must reboot your computer for the newly installed drivers to take effect. 

Windows Applications 

If you have installed Windows prior to installing a CD-ROM drive, you 
must have the MCI CD Audio driver installed for Windows applications 
such as Creative EnsembleA V (see Chapter 6, "Creative EnsembleA V"). 

If you receive an error message when you attempt to play an audio CD 
on the CD-ROM drive, install the MCI CD Audio driver in Windows. 
You need the Windows installation disks if the driver is not on your hard 
disk. 
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To install the MCI CD Audio driver: 

1 . From Windows Program Manager, double click the Control Manager icon. 

2. Select the Drivers icon to display the Drivers dialog. 

3. Scroll through the list of installed drivers to find [MCI] CD Audio. 

+ If the driver is installed, your system is configured to play audio CDs 
from a Windows application. 

+ If the driver is not installed, you must install it before running a 
Windows application that plays audio CDs on the CD-ROM drive. 

4. On the Driver dialog, select Add ... 

5. Scroll the list to find [MCI] CD Audio. Select the driver and select OK. 

+ If the driver is in the \WINDOWS\SYSTEM directory, it is installed. 

+ If the driver is not in the \WINDOWS\SYSTEM directory, you are 
prompted to enter the name of the directory in which it can be found. 

6. Once the driver is located, select OK to add the driver to your system. 

See the Windows documentation for more information on adding drivers. 

CD-ROM Drivers 

Two drivers are needed to control your CD-ROM drive. They are the 
hardware-dependent driver SBCD.SYS and MSCDEX.EXE. 
SBCD.SYS is the device driver for your CD-ROM drive and 
MSCDEX.EXE is the Microsoft CD-ROM Extensions program. 

When you run the installation program, it automatically updates the 
CONFIG.SYS file to include a statement similar to: 

DEVICE=C:\SB16\DRV\SBCD.SYS /D:MSCDOOl /P:220 

The AUTOEXEC.BAT file is updated to include the statement: 

C:\SB16\DRV\MSCDEX.EXE /D:MSCDOOl /V /M:lS 
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SBCD.SYS Settings 

There are some SBCD.SYS parameters that can be edited. To edit the 
parameters listed in the table below, use any ASCll text editor. The 
syntax of the SBCD.SYS entery in the CONFIG.SYS file is: 

DEVICE=C:\SB16\DRV\SBCD.SYS /D:device-name /P:xxx 
[/N:x] [/S: [mode] [ID] [/A] [/X:l] 

Parameter Description 
====~============================== 

/D:device-name Name of the CD-ROM drive; must be identical to the device 
name in the AUTOEXEC.BAT file. Default is 
/D:MSCDOOl. 

/P:xxx Base address used by your Sound blaster 16. xxx can be 
220, 240, 260, or 280. Default is 220. 

/N:x Number of CD-ROM drives connected. x ranges from 1 to 
4. If you have more than one CD-ROM drive, x sets the 
number of drives you can access. 

/S:[mode] [/D] mode can be A (automatic), N (normal), and D (double 
speed). Default is D. For A mode, the transfer speed is 
dependent on the type of disk. For a data disk, the transfer 
speed is 300 KB/sec. For mixed mode CD containing audio 
and data, transfer speed is 150 KB/sec. For normal and 
double mode, transfer speed regardless of the type of disk is 
150 KB/sec and 300 KB/sec, respectively. 

/A 

/X:l 

3-4 

ID is the drive's ID number. Values range from 0 to 3. If it 
is specified after mode, the mode setting applies only to the 
drive specified by /D. For example, /S:A3 means only drive 
3 is in A mode. If ID is omitted, the mode setting is 
effective for all drives connected. For example, /S:N means 
all connected drives are in N mode. 

Enables sound to be be sent to both channels even when the 
application software sends it to one channel. 

Prevents the application from giving an error message when 
software eject is not available. Applies only when you use 
CD-ROM drive model 521 or 523 as the first drive for 
daisy-chaining. 
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MSCDEX.EXE Settings 

The syntax of the MSCDEX.EXE entry in the AUTOEXEC.BAT file is: 

C:\SB16\DRV\MSCDEX.EXE /D:device-name /L:drive-letter 
[/E) [/M: XX] [/V] [/S] 

=P=a=ra~m=e~t~er======D=~=c=r~ip~ti='o=n================================= 
/D:device-name Name of the CD-ROM drive. Default is /D:MSCDOOl. 

/L:drive-letter Drive assigned to the CD-ROM drive. If not specified, the 

IE 
next available drive is used. 

Use expanded memory, if available. (Only applies to 
Expanded Memory Manager LIM version 3.2 or later.) 

/M:xx Number of buffers for temporary storage of the most recent 
data. xx ranges from 2 to 30. CD-ROM drive performance 
increases with the value of xx. Each buffer uses about 2 KB 
of memory; too many buffers may impact programs with 
large memory requirements. 

N 
IS 

Displays summary of RAM and expanded memory at boot. 

Allows sharing of CD-ROM drives on MS-NET file servers. 

Setting Up the CD-ROM Device Driver 

When you change the speed mode of your CD-ROM drive, you need to 
update SBCD.SYS. SETUPCD is the program that updates SBCD.SYS. 

NOTE "SfiTTJPCij.EXE assumes SBCD.SYS and MSCDEX.EXE are i~ the 
sound directory. Run the installation program if they are missing. 

~%-·A,-§k4"§i!,.!f·· f¥-·¥ : ''*&&•b¥9!!f#%%W%9&'wNMf··BMF% 4 " + %¥9¥8 

To run SETUPCD: 

1 . Change to the sound directory. The Sound Blaster 16 default is \SB 16. 

2. Type SETUPCD and press ENTER Follow the CD-ROM Drive Setup 
instructions on each screen. To exit at any time, press the ESC key. 

3. Select the base 1/0 address for Sound Blaster 16 and the speed mode for 
each drive. 

4. The SETUPCD program saves the changes in your CONFIG.SYS. 

5. At the prompt, enter the drive from which your computer boots. 

6. Restart your system for the changes to take effect. 
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Upgrading from 
Sound Blaster Pro 
If your Sound Blaster 16 installation is replacing Sound Blaster Pro, you 
may want to remove the \SBPRO files and subdirectories to make the 
space available on your hard disk. 

When you installed Sound Blaster Pro, a line similar to the following 
was added to your AUTOEXEC.BAT file: 

C:\SBPRO\SBP-SET /M:12 /VOC:12 /CD:12 /MIDI:12 

Before you install the Sound Blaster 16 software, use a text editor to 
remove this line from your AUTOEXEC.BA T file. 
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Installing the 
Sound Blaster 1 6 Software 
To complete your installation of Sound Blaster 16, install the Windows 
and DOS applications. The installation program automatically: 

•:• Creates a directory, \SB 16, and a number of subdirectories on your 
hard disk. 

•:• Copies the Sound Blaster 16 software and the applications into the 
\SB16 directory and subdirectories. 

•:• Copies the AUTOEXEC.BAT and CONFIG.SYS files, saves the old 
versions with the file name extension .B~K, and adds lines to the 
new version. (See Appendix C, "Technical Information," for more 
information.) 

•:• Adds lines to the Windows system files. 

NOTE If you are running a disk-caching program such as SMARTDRV or 
PC -CACHE, remove it from memory before installing the Creative 
software. You may re-install the program after the Creative software, 
including the Windows drivers, has been installed. 

To install the Sound Blaster 16 software on your hard disk: 

1 . Insert Sound Blaster 16 installation disk into a disk drive. 

2. From the DOS prompt in your root directory, type A:INST ALL or 
B:INST ALL to start the installation progam from the appropriate disk 
drive; press EN1ER. 

3. Read the information displayed, then press the appropriate key: 

• README file, press F2. 

• Begin installation, press EN1ER. 

• Learn about the installation program, press Fl. 

• To exit the installation program, press F3. 

4. Press F2 to display new information. When you finish reading the 
README file, press ESC to return to the main menu. 

Installing Creative Software 3-7 



5. From the Sound Blaster 16 installation menu, press ENTER. Follow the 
instructions that appear on the screen-you are presented with two choices: 

+ Full installation 

+ Custom installation 

The full installation includes all of the Sound Blaster 16 software and is 
recommended. Custom installation may be your choice if you have limited 
disk space or you have no need for one or more of the applications. Read 
the information and choose the appropriate installation. 

6. The next installation screen shows the current or default path name for the 
Sound Blaster 16 directory. When the drive and directory are correct, press 
ENTER. 

The following settings will be used for installing Sound Blaster 16 
programs. 

Proceed using the settings shown 

Base I/O address 220 
MIDI Port address 330 
Interrupt setting 5 
DMA setting 1 
High DMA setting 5 

If these settings are correct, press ENTER. 

To change a setting, use i or ~ key to select the setting 
and press ENTER for the alternatives. 

FIGURE 3-1: Hardware Configuration screen showing default settings 

7. If you did not change the jumpers on the sound card, the default settings are 
valid for most computers. (Before making changes to the default settings, 
review Appendix B, '·'Changing Sound Blaster 16's Configuration.") The 
test program, DIAGNOSE, run after the software is installed, lets you know 
if the default settings are valid. Press ENTER to continue. 
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When the installation is complete, the following lines are added to your 
AUTOEXEC.BAT file: 

SET BLASTER=A220 IS Dl H5 P330 T6 
SET SOUND=C:\SB16 
SET MIDI=SYNTH:l MAP:E 
C:\SB16\DIAGNOSE /S 
C:\SB16\SB16SET /P 

The following lines are added to your CONFIG.SYS files: 
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DEVICE=C:\SB16\DRV\CSP.SYS /UNIT=O /BLASTER=A:220 

DEVICE=C:\SB16\DRV\CTSB16.SYS /UNIT=O /BLASTER=A:220 I:S D:l H:S 

DEVICE=C:\SB16\DRV\CTMMSYS.SYS 

FILES=40 

The FILES line is added or modified only if it is missing or fewer than 40 
files are allocated. 

8. You are asked for the Windows directory. The Windows drivers and 
applications are installed using this directory. The Sound Blaster 16 group 
and icons are installed the next time you access Windows, or you may 
install them at any time by running the WINSETUP program from 
Windows. 

Type the path name for the Windows directory and press ENTER. 

9. When the installation program is completed, you must reboot for the 
settings to take effect: 

+ Press FlO to reboot. 

+ Press ENTER to return to the DOS prompt. 

Testing Sound Blaster 16 
The Sound Blaster 16 test program checks your installation to make sure: 

•:• There is no conflict with other components in your computer 

•:• Music and sound are produced properly 

If the program discovers a problem with any of the settings, you need to 
change the setup of either Sound Blaster 16 or the conflicting component. 

To test Sound Blaster 16: 

1 . Type CD \SB16 at the DOS prompt to switch to the directory in which the 
test program is located. 

2. Type DIAGNOSE and press ENTER to start the test program. 

3. When the Sound Blaster 16 Test Program screen appears, read the 
information that is displayed. Press ENTER to start the test. 
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The Sound Blaster 16 test program checks the 1/0 address, interrupt, and 
DMA channels that Sound Blaster 16 uses, then it displays a menu to let 
you test the card's sound and music output. If you discover any 
hardware conflicts or audio problems you cannot resolve or if you have 
any other problems installing Sound Blaster 16, see Appendix A, 
"Troubleshooting." 

Testing the CD-ROM Drive 

After installing the software, run the test program TESTCD to ensure 
that your CD-ROM drive and drivers are installed properly. 

To test the CD-ROM drive: 

1 . Load an audio disk into your CD-ROM drive. 

2. Change to the sound directory, and type TESTCD and press ENTER. 

3. Follow the instructions on the screen. 

The test does the following: 

•:• Checks whether the drive is properly setup. If you see an error 
message on MSCDEX, check that SBCD.SYS is properly installed. 
Also, ensure that the data and power cables are connected to the 
CD-ROM drive. 

•:• Checks whether there is audio output. If there is no audio output, 
refer to Appendix A, "Troubleshooting." 

Resolving Hardware Conflicts 

If the test program hangs or displays an error message while checking 
the 1/0 address, the interrupt setting, or the direct memory access (DMA) 
channels, there may be another card using the same setting. It is best not 
to change the Sound Blaster 16 default settings; many applications are 
designed to work with those settings. If you do find it necessary to 
change one or more settings on the sound card, see Appendix B, 
"Changing Sound Blaster 16's Configuration," for more information. 
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Resolving Audio Problems 

If you hear no sound when you run the sound and music tests, check the 
following: 

•:• Speakers or headphones plugged into the correct jack (see figure 
2-2); plugged in completely. 

•:• Volume control on the Creative Mixer: Move the master control up 
to increase, down to decrease (see Chapter 4, "Creative Mixer"). 

•:• Speaker or headphones volume control: Use it to increase the 
volume. 

•:• External amplifier: Correctly connected to Sound Blaster 16 and 
turned on; speaker or headphone connections to the external 
amplifier. 

•:• Powered speakers: If you are using the Sound Blaster 16 built-in 
amplifier, tum off the power to your speakers. 

If you hear music when you run the FM music tests but no sound when 
you run the 8-bit and 16-bit sound tests, the interrupt or DMA channel 
settings may be wrong or your computer may not be able to handle 16-bit 
DMA transfer correctly. For information about solving either problem, 
see Appendix B, "Changing Sound Blaster 16's Configuration." 
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Installing Application 
Group Windows 
The first time you access Windows after installing the Sound Blaster 16 
software, the group windows and icons are installed automatically. 

To install the Sound Blaster 16 group: 

1 . At the DOS prompt, type WIN and press ENTER to start Windows. 

2. When you first run Windows after installing Sound Blaster 16, a prompt 
informs you: "This program sets up the Sound Blaster 16 program group 
window." Select OK. 

The setup program creates a new Windows program group and adds the 
program items for each of the Sound Blaster 16 applications. (The program 
group appears as a window, and each application is represented by an icon.) 

Adding Drivers and Applications 

If you installed the Sound Blaster 16 software prior to having Windows 
3.1 on your system, you must add the Sound Blaster 16 drivers and 
applications. 

To add Sound Blaster 16 Windows drivers and applications: 

1 . From the Windows Program Manager, open the File menu and choose Run. 
The Run window appears. 

2. Type C:\SB16\INST ALL (substitute the correct drive letter and path name 
if you did not use the defaults when installing) and click on OK. 

Select Windows Setup and follow the on-screen instructions. See 
"Installing the Sound Blaster 16 Software" earlier in this chapter for a more 
complete description of the installation process. 

When Windows restarts, the drivers and applications are ready to use. 
The applications are described in detail in Part II, "Windows 
Applications." Details of the driver setup program are explained in 
Appendix C, "Technical Information." 
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FIGURE 3-2: An example of a Sound Blaster 16 group 

INSTALL may not install the drivers and applications properly if your 
SOUND and BLASTER environment lines are incorrect. You may enter 
the SET command at the DOS prompt to check the settings before you 
run INSTALL. (See "Sound Blaster 16 Software Installation" in 
Appendix C, "Technical Information," for more information.) 

You need to run INSTALL only once. If you run WIN SETUP more than 
once, you may have one or more duplicate icons in the Sound Blaster 16 
group. To remove the duplicate icons, select them one at a time and 
click on Delete in the File menu. 

If you change the jumpers on Sound Blaster 16 or need to select new 
IRQ or DMA channel settings, use SB Configuration (Figure 3-3) in the 
Sound Blaster 16 group to change the settings of the Windows drivers. 

Ia Sound Blaster ConliglJralion 

Be:ae 1/0 Address 

MPU-<401 MIDI Port 

IRQ 

Low Ofr.AA Che nn e l 

High DMA Cha.nne l 

FIGURE 3-3: Sound Blaster Configuration dia log 

Changes made on the Sound Blaster Configuration dialog are written to 
the AUTOEXEC.BAT, CONFIG.SYS, and SYSTEM.INI files; 
however, you must reboot the computer before the changes take effect. 
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Installing Third Party 
Applications 
The Sound Blaster applications produced by Creative Labs work with 
Sound Blaster 16 automatically. Third party DOS applications (from 
producers other than Creative Labs) normally supply the drivers for the 
music and sound cards for which they are designed. Third party 
Windows applications use the Windows drivers when feasible. 

When you are installing a new application, the program usually requests 
that you identify the sound card you are using. If Sound Blaster 16 
appears on the list, choose it. If it is not listed, choose Sound Blaster Pro 
or Sound Blaster instead. If neither of those are listed, choose the Adlib 
Music card. (If you choose Adlib Music, the application uses 
Sound Blaster 16 for synthesized music, but not for digitized sound.) 

If you have problems using applications you have already installed, you 
may need to reinstall them or run the application setup program. For 
information about setting up an application to work with the 
Sound Blaster 16 hardware settings, check the application's manual. 
Some applications check the settings automatically; others must be set up 
manually. 

3-14 GETTING STARTED 



I I 
Windows 

Applications 



Four 

Creative Mixer 

Creative Mixer is a Windows-based mixer that allows you to combine 
and manipulate sound from various audio sources. With Creative Mixer, 
it is possible to control the volume, tone, and gain of an audio source 
while running other Windows applications. You can also select and mix 
different audio sources during playback and recording. 

Starting Creative Mixer 

To start Creative Mixer: 

1. Double-click the Creative Mixer icon in Sound Blaster 16 group window. 
The Creative Mixer window (Figure 4-1) displays. 
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FIGURE 4-1: Creative Mixer window (LED not displayed) 
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Audio Source 

An Audio Source check box allows you to turn on sound fron an audio 
source. A green dot in the box indicates a selected audio source. 

There are seven Audio Source check boxes on the Mixer for the 
following audio sources: 

·:· Master Control 

•!• Wave audio 

•!• MIDI audio 

•!• CD-audio 

•!• Line In 

·:· Microphone 

•!• PC Speaker 

Recording Source 

A Recording Source check box allows you to select the audio source 
from which you want to record. When an audio source is selected, a red 
dot appears in the Recording Source check box. 

There are four Recording Source check boxes on the Mixer for the 
following audio sources: 

•!• MIDI input 

•!• CD-audio 

•!• Line input 

•!• Microphone input 
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LED Display 

The LED display is opened and closed from the control menu. A green 
dot in the LED display check box indicates that the LED Display is 
active. 

Volume Sliders 

Vertical sliders adjust the volume and tone (bass and treble) levels of 
selected audio sources. 

NOTE Bass represents the lower range while treble the higher range of 
sound frequencies in the output. 

Balance Sliders 

Horizontal sliders adjust the balance of selected audio sources. Balance 
represents the volume, base, or treble sent to the right and left speakers. 

When the slider is situated in the middle, equal distribution is given to 
the left and right speakers. This can be quickly achieved by 
double-clicking the slider. 

Control Menu 

When you choose the control menu box 
(upper left corner of the Creative Mixer 
control panel), the control menu (Figure 4-2) 
displays listing commands for operations 
such as Move and Restore. 

n(•::-,lor\' 
Move 
Minimize 

.(;lose 

S't.!itchTo ... 

M]nlmum View 
• .Expanded View 

CystomVIew 

Trtle Bar 
I !.ED Display 

£references ... 

Recording Settings ... 
Output .Gain ... 

J::!elp on Creative Mixer ... 

About Creative Mixer ... 

Alt+F4 

ctri+Esc 

ctrl+l 
ctri+E 
ctri+C 

Esc 
ctri+L 
ctri+P 

FIGURE 4-2: Control Menu 
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LED Display 

The LED Display allows you to view the data of audio sources 
graphically. 

To invoke the LED Display: 

1 . Select LED Display on the Control menu. The LED display appears. 

With the LED display on, you can switch between the three versions: 

•!• The Power Spectrum display (Figure 4-3) shows different frequency 
levels of the output. 

=-___ .....:::;=:::::;o...=- __ 

FIGURE 4-3: Creative Mixer with the Power Spectrum display 

•!• The VU Meter display (Figure 4-4) shows the intensity of the sound 
entering both the left and right speakers. 

FIGURE 4-4: Creative Mixer VU Meter display 

•!• The Scope display (Figure 4-5) shows the combined amplitude of 
waves from the selected audio sources. 

NOTE LED displays are not available during the playback or recording of 
wave files. 
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FIGURE 4-5: Creative Mixer Scope display 

Creative Mixer Controls 
Creative Mixer can be controlled using the mouse or keyboard. 

Mouse Control 

• To select a check box, click on it with your left mouse button. 

• To adjust the slider bar, click on it and hold down the mouse button as 
you drag it to the desired position 

Keyboard Control 

• To display the control menu, press the FlO key. 

• To advance from one option to another, press the TAB key. 

• To move to the previous option, press the SHlFT +TAB keys. 

• To select an option in a check box, press the SPACEBAR. 

• To adjust the volume, tone, or gain of audio sources, use the UP or 
DOWN arrow key. 

• To toggle the title bar, press the ESC key. 

Recording Sources 

You can select recording sources by choosing the check box for the 
audio source(s). Or, you can use the Recording Settings dialog to select 
the audio source(s) for recording. 
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To select a recording source: 

1 . Select Recording Settings from the Control menu. The Recording Settings 
dialog (Figure 4-6) displays. 

2. Select the audio source for recording form Left In and Right In. 

For stereo recording, the left signal (L) of the audio source must be directed 
to the Left In channel and the right signal (R) to the Right In channel. 

3. Use the Gain settings to amplify the level of either channel and the AGC 
(automatic gain control) to automatically adjust input from the microphone. 

FIGURE 4-6: Recording Settings dialog 

4. Choose Close. 

Output Gain 

To control the output gain: 

1 . Select Output Gain from the Control menu. The Output Gain dialog 
(Figure· 4-7) displays. 

FIGURE 4-7: Output Gain dialog 

2. Change the gain setting of the left and right output channels to the desired 
level-click the up or down arrows in the L and R boxes. 

3. Choose Close to close the Output Gain dialog. 
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Customizing Creative Mixer 
You can customize the appearance of Creative Mixer by selecting a view 
from the Control menu. The three choices for customizing the Mixer are: 

•!• Minimum displays the master volume control only . 

•!• Expanded displays all of the controls. 

•!• Custom displays the customized controls only. 

If you want to choose the controls to display with the Custom View 
setting, select Preferences on the Control menu. 

Preferences 

Custom View:.-,-~~~• 

r lrr•l!!ru IX co. 
r B.ASS r J.jne In 

fi< 'tf.ave r MikrOphone 

IX MIDI !X EC Speaker 

IX Show B.alonce Control 

r Always on Iop 

r Save .Settings On Exit 

OK 

Cancel 

tlelp 

FIGURE 4-8: Custom View Preferences dialog 

The Preferences dialog options include: 

•!• Show Balance Control displays or hides the balance sliders. 

•!• Always on Top displays Creative Mixer as the topmost window. 

•!• Save Settings on Exit saves all changes made to settings. 

Quitting Creative Mixer 
To quit Creative Mixer: 

1 . Select Close from the Control menu. 

Alternatively, double-click the Control menu box (in the upper left corner 
of the Creative Mixer control panel. 
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Creative Mixer Control Menu 
Command 

Restore 

Move 

Minimize 

Close 

Switch To ... 

Minimum View 

Expanded View 

Custom View 

Title Bar 

LED Display 

Preferences 

Description 

Returns Mixer control panel to previous size. 

Prepares Mixer control panel for repositioning. 

Reduces Mixer control panel to an icon. 

Close the Creative Mixer. 

Switches to other active applications. 

Reduces Creative Mixer to master volume control. 

Displays complete set of controls including LED. 

Display Creative Mixer control panel in configuration 
specified on Preferences dialog. 

Display/remove Creative Mixer title bar. 

Display/remove the LED. 

Displays the custom display Preferences dialog. 

Recording Settings ... Displays the Recording Settings dialog. 

Output Gain... Displays the Output Gain dialog. 

Help on Creative 
Mixer. .. 

About Creative 
Mixer 

4-8 

Displays the Help utility. 

Displays copyright information. 

WINDOWS APPLICATIONS 



Five 

Creative WaveStudio 

WaveStudio makes it possible for you to record, play, and edit wave 
forms, a graphic representation of recorded sound. You can cut or copy a 
segment of a wave form and paste it back into the wave form at a 
different location-or cut or copy a segment of one wave form and paste 
it into another. You can reverse a wave form, add an echo to it, fade it in 
and out, change its volume, and even create "rap" effects. 

Sound Basics 
Sound is represented visually by sine waves. A sine wav~ displays the 
frequency and amplitude of the sound. Frequency is the number of 
vibration cycles per second and determines the pitch or .timbre of a 
sound; the higher the number of cycles, the higher the pitch. Amplitude, 
represented by the height of the sine wave, determines the volume or 
loudness of a sound; the greater the height of the sound waves, the louder 
the sound. 

A WaveStudio wave form represents an analog sound as a continuous 
sine wave, a line. A digitized sine wave is translated to a series of dot 
patterns that resemble the shape and size of an analog sine wave line. 
Sampling is the process of converting an analog wave form to a digitized 
wave form. The sampling rate is the number of times the translator, such 
as Sound Blaster 16, looks at a sound to create a digitized sound wave 
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FIGURE 5-l: WaveStudio screen 
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image. For example, recording sound at 4 kHz creates 4,000 digitized 
images or samples of the sound wave in one second. 

WaveStudio allows you to record at sampling rates of 11kHz to 44.1 
kHz. The sampling rate determines the quality level of the recording: 
The higher the sampling rate, the better the sound. For example, CD 
audio is high quality and has a sampling rate of 44kHz at 16 bits. 
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Starting WaveStudio 
The WaveStudio icon is installed, by default, in the Sound Blaster 16 
group window. 

To start WaveStudio: 

1. Double-click the WaveStudio icon. 

The WaveStudio window similar to Figure 5-1 appears. 

The WaveStudio interface has four main elements: 

•:• Toolbar 

•:• Edit Window 

•:• Preview Window 

•:• Status Bar 

Tool bar 

The Toolbar is comprised of several buttons and boxes for initiating and 
controlling wave form operations. 

;f~lffJIJiiJMIJU~Id~Iitlfl~c~r~f.;~, .. "' .• ~~~··· .... lit~{~·.... ~.•' 
lll I civil I J_l Flotl JD mart - loan 

Open cut Pasle stop Recold Mxer 

FIGURE 5-2: WaveStudio Toolbar 

Opens a new window containing no data. 

Opens an existing wave file. 

Saves the active wave file. 

Cuts the selected data of the wave file. 

Copies the selected data of the wave file. 
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Pastes cut or copied data onto the wave file. 

Plays the wave file that is currently active in 
WaveStudio. 

Stops the playback of a wave file. 

Pauses/resumes the playback of a wave file. 

Records a wave file. 

Sets the default recording format. 

Activates the Creative Mixer. 

Activates the CD player. (This button will only 
appear if you have a CD-ROM drive installed.) 

Displays the starting position of the wave data 
selection. You can specify the position by typing a 
numerical value in the text box or use the scroll 
arrows to select the starting position. 

Displays the size of the wave data selection. You 
can type the size in the text box or use the scroll 
arrows to increase or decrease the size. 

Displays the zoom ratio of the wave file displayed. 
You can type the ratio in the text box or use the 
scroll arrows to increase or decrease the ratio. The 
smaller the value, the larger the magnification. 
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Edit Window 

The Edit Window is the area in which the content of a wave file is 
displayed. You can open several Edit Windows at a time and display 
them in cascades, vertical or horizontal tiles, or as icons. This allows 
you to perform editing functions such as copying data from one file to 
another easily and quickly. 

For a better view of the data displayed in the Edit Window, use the 
horizontal scroll bar to select the data for viewing and the vertical scroll 
bar to zoom into (or out of) the data. 

FIGURE 5-3: WaveStudio screen with two open Edit Windows-the Edit 
Window on the right is active and its entire wave form is 
shown in the Preview Window 
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Preview Window 

The Preview Window displays the entire wave data in the current active 
Edit Window. When you place your mouse cursor in the Preview 
Window, the arrow changes to the zoom icon. You can also select a 
portion of the file for editing in the Preview Window. 

Progress+ 
Indicator 

FIGURE 5-4: Preview Window with Progress Indicator at bottom 

At the bottom of the Preview Window is the Progress Indicator showing 
the progress of the wave file during playback. If the entire file is 
selected, the Progress Indicator moves from the beginning to the end of 
the file. If only a portion of the file is selected, the Progress Indicator 
moves from the beginning to the end of that selection. 

Status Bar 

The Status Bar displays information related to the wave file in the active 
Edit Window and each menu command when selected. A window has to 
contain data before the information relevant to the file is displayed in the 
Status Bar. 

Time Wave type 

FIGURE 5-5: Status Bar 

Frequency 
(in kHz) 

Size (in KB) 
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Using the Mouse 
A wave file or a portion of a wave file can be selected for editing by 
using the mouse. 

To select a portion of the data: 

Hold down the left mouse button anywhere on the Edit Window and drag 
the mouse. Once the desired portion of the data has been selected, release 
the left mouse button. 

To select the entire data: 

Double-click the wave data in the Edit Window. 

To select data from a specific position back to the beginning of the data: 

Hold down the left mouse button at the specific position and drag the mouse 
above the Edit Window. 

To select data from a specific position to the end of the data: 

Hold down the left mouse button at the specific position and drag the mouse 
below the horizontal scroll bar. 
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WaveStudio Menus 
WaveStudio has seven menus: File, Edit, View, Special, Options, 
Window, and Help. In addition, there is a context-sensitive menu that 
you can activate by clicking the right button of your mouse. 

File Menu 

The File menu contains the following commands: 

Command 

New 

Open 

Close 

Close All 

Save 

Save As 

Save All 

Exit 

Description 

Creates a new window without data. 

Loads an existing wave file. 

Closes an open wave file. 

Closes all open wave files. 

Saves changes made to the wave file. 

Saves the wave file with a new name. 

Saves all open wave files. 

Quits WaveStudio. 

WaveStudio keeps a record of the last four wave flies you have opened 
by displaying them on the File menu after the Exit command. To open 
any of the files, select the file with the left mouse button. 

Edit Menu 

The Edit menu contains the following editing commands: 

Command 

Undo 

Cut 

Paste 

5-8 

Description 

Restores the wave file to the state last saved. 

Copies and then removes the selected portion of the 
wave data. 

Pastes cut or copied wave data into the Edit 
Window. If you have selected a portion of the data, 
that portion is replaced. Otherwise, Wave Studio 
pastes the data at the cursor. 
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Command 

Paste Mix 

Delete 

Crop to Selection 

Select Ail 

View Menu 

Description 

Mixes cut or copied wave data with the one in the 
Edit Window. When you play the wave file, you 
will hear both sounds together. 

Deletes a selected portion of the data. Unlike the 
Cut command, the data is not copied first. 

Deletes the entire data except the portion selected. 

Selects the entire wave file in the Edit Window. 
You can also do this by double-clicking the mouse 
anywhere within the Edit Window. 

The following commands on the View menu allow you to customize the 
WaveStudio workspace: 

Command 

Preview 

Toolbar 

Status Bar 

Fit Wave In Window 

Actual Size 

Cursor Position 

Cursor End 

Zoom 

Creative WaveStudio 

Description 

Toggles the Preview Window on or off. 

Toggles the Toolbar on or off. 

Toggles the Status Bar on or off. 

Scales (adjusts the zoom ration) the wave display to 
fit the size of the Edit Window. 

Resets the zoom ration of the wave display in the 
Edit Window to its actual size (1:1). 

Displays the wave file at the starting position of the 
wave selection. 

Displays the wave file at the ending position of the 
wave selection. 

Zooms into the portion of the wave file selected. 
(Select a portion before using this function.) 
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Special Menu 

The commands on the Special menu allow you to add special effects to 
wave files. These commands are: 

Command Description 

Reverse Reverses the playback of the entire or selected portion of 
the wave ftle. For stereo ftles, there are options for 
reversing either channel. 

Add Echo Adds echo effect to the entire or selected portion of the 
wave file. For stereo ftles, there are options for adding 
echo to either channel. 

Invert Waveform Inverts the wave data for the entire or selected portion of 
the wave file. For stereo files, there are options for 
inverting either channel. 

Rap! Repeats the selected portion of the wave file. 

Insert Silence Inserts silence into the portion of the wave f:tle selected. 

Force to Silence Silences the portion of the wave file selected. For stereo 
files, there are options for silencing either channel. 

Fade In Fades into the entire or selected portion of the wave file. 
For stereo files, there are options for fading either channel. 

Fade Out Fades out the entire or selected portion of the wave file. 
For stereo files, there are options for fading either channel. 

Swap Channels Swaps the entire or selected portion of the wave file 
between the left and right channels. For stereo files only. 

Pan Left to Right Pans the entire or selected portion of the wave file from 
left to right. For stereo files only. 

Pan Right to Left Pans the entire or selected portion of the wave file from 
right to left. For stereo files only. 

Phase Shift Shifts one channel of the entire or selected portion of the 
wave file to the right, causing a delay during playback. 
For stereo files only. 

Convert Format Converts the entire wave file between monaural and 
stereo,~- and 16-bit frequencies. 

Modify Frequency Modifies the frequency (playback rate) of the entire wave 
ftle. 

Amplify Volume Changes the volume level of the entire or selected portion 
of the wave ftle. 
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Options Menu 

The following commands on the Options menu allow you to change 
WaveStudio's default settings: 

Command Description 

Record Settings Sets the default record settings. 

Mixer Settings Launches Creative Mixer. 

Customize Colors Customizes WaveStudio's display colors. 

Display in Bytes Displays wave selection information in bytes. 

Display in Samples Displays wave selection information in samples. 

Display in Milliseconds Displays wave selection information in 
milliseconds. 

Always on Top Toggles WaveStudio as the topmost window. 

Window Menu 

The commands on the Window menu allow you to organize the Edit 
Windows when several wave files are open. For more information 
regarding these commands, refer to your Microsoft Windows manual. 

Help Menu 

The descriptions of the commands on the Help menu are: 

Command 

Contents 

Search for Help on 

System Info 

Description 

Displays contents for WaveStudio Help. 

Searches for a topic in WaveStudio Help. 

Displays information about Windows and your 
system such as CPU and available memory. 

About W aveStudio Opens a window displaying copyright information. 
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Context -Sensitive Menu 

The context-sensitive menu appears when you click the right mouse 
button in the Edit Window. The commands that appear on the menu 
depend on the content of the Edit Window. The commands include: 

Command Description 

Play Plays the entire or selected portion of the wave file in 
the Edit Window. 

Record Records the wave file. If the current active window in 
the Edit Window is an open file, the content in the 
open ftle will be replaced by the recorded file. 

Stop Stops the playback of a wave file. 

Mixer Settings Launches Creative Mixer. 

Fit Wave in Window Scales (adjusts the zoom ratio) the wave display to fit 
the size of the Edit Window. 

Actual Size Resets the zoom ration of the wave display in the Edit 
Window to its actual size (1: 1). 

Cursor Position Displays the wave file at the starting position of the 
wave selection. 

Zoom Zooms into the portion of the wave file selected. 

New Creates a new window. 

Open Loads an existing wave file. 

Save Saves changes made to the wave file. 
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Working with Wave Files 

WaveStudio's interface makes working with wave files easy. The 
information that follows explains how to specify the format for wave 
files, and open, save, and mix wave data. 

Specifying Wave Formats 

Before recording a wave file, you need to ensure the format of the file is 
specified correctly. Wave format refers to the sound channel and 
sampling rate and size of the file. 

To !!>pecify the wave format: 

1 . Select Record Settings from the Options menu. The Record Settings dialog 
(Figure 5-6) appears. 

Fill ij§§.!iiljiiihtb 

~ 0 Mono ~::::::;;;~= 
r' ~-.Channels:-l ' 

@~ ,_[ __ __, 

!
Sampling Rate:~····-- l""[r ~~,_.., 

' 0 11 025 Hz IJ-' .....;;;..,:,..__, 

@ Z.2050 Hz 

Q .14100 Hz 

[

Sampling Size:~l 
@ !lbits 

O, lli_bits 

Select Sle1eo or Mor.o, sample lteqency and c~ .size for the default 
recording settings. 

FIGURE S-6: Record Settings dialog 

2. Select the format for the wave file. 

• Select Mono (monaural) for one sound channel and Stereo for two 
sound channels. 

• Select 11025 Hz for voice, 22050 Hz for cassette, and 44100 Hz for 
CD-quality recording. 

• Select 8 bits for cassette and 16 bits for CD sound quality. 

3. Choose OK. 
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There is a correspondence between the quality of a wave file and the 
amount of storage space required for the file. A wave file with better 
sound quality requires a larger storage space because of its high sampling 
rate. 

Opening Wave Files 

You can open existing wave files using the Open command from the File 
menu or the drag-and-drop method. 

To use the Open command: 

1. Select Open from the File menu. 

The Open Sound File dialog similar to Figure 5-7 appears: 
F--···-----·-------·-====·-------

· Open Sound File 

File Harne: 

lie!! 
chorgex.wov 
chimes.wav 
cho rd.wav 
ding.wov 
fe.nfnre .wav 
toda.wav 

Li st Files of Iype: 

.Qjrectories: 

c:\windows 

t- (0 c:\ 
~ windows 
CJ apw_data 
D osw_dato 
D system 
D temp 

!windows wave format fi les (".WAV) 

Wavefie:Fotrnal 

Wave Fie Sin: 

fioD~et.r.Ti'no: 

FIGURE 5-7: Open Sound File dialog 

OK 

Cancel 

.tlelp 

2. Select the file you wish to open from the File Name list. (You may have to 
specify the directory in which your file(. WA V) resides. To listen to the 
playback of the selected wave file, choose Play.) 

3. Choose OK. 

NOTE If you select a file with raw data (.RAW) or Creative's Voice format 
(. VOC ), you are prompted to confirm the conversion of the file to 
. WA V format. 
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To use the drag-and-drop method: 

1 . Start File Manager and open the directory containing the wave file. 

2. Arrange the windows to display both the file and the WaveStudio window. 

3 . Hold down the left mouse button as you drag the file into the WaveStudio 
window. The drag-and-drop icon appears while you are dragging the file. 

4 . Drop the file by releasing the mouse button. The file opens automatically. 

You can open multiple files by using drag-and-drop: Hold down the 
SHIFT key and click on the files in the File Manager. 

Recording Wave Files 

WaveStudio allows you to record new or over existing wave files. 

To record a new file: 

1 . Choose New on the Toolbar. 

2. Choose Record on the Toolbar. 
displays. 

The New Recording dialog (Figure 5-8) 

New Recording ... 

Recording Level :-------~---, 
Start 

Cancel 

Mixer ... Settings ... 
Right channel 

!:;.0 Player 

Record To File:~-~--,.,"---~.---'--'----; 

I 

r CD Sync 

c:\windows 

~mmiii"--=====-- .-----..,~,..., !ielp 
JIUI4.1UIC!'ffl"j I " se ]] 
~~·--_ .. _--~~====~=~=ow=·= .. ~ 
Ree01ding F01rm~t Stereo 8 btts. 22050 Hz 

Available Oi;k Space: 24842240 bytes 

Aec01ding Time (maximumt 563 'econds 

FIGURE 5-8: New Recording dialog 

3 . Ensure the settings in the dialog are specified correctly. 

• Check the recording level in the Recording Level box. If the level is 
too low or high, adjust it using the Mixer button. 
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• Check the path and file name created in the Record To File group box. 
you can change the file name and directory by using the Browse button. 

• Check the recording format shown at the bottom of the dialog. You 
can change the format by choosing the Settings button. 

• Check your system's storage space shown at the bottom of the dialog. 
If there is insufficient storage space for your file, free up more disk 
space or choose another drive before recording the file . 

4. Choose Start. 

NOTE If you have a CD-ROM drive installed, you can choose the CD Player 
button to launch the CD player. Also, you can select the CD Sync 
check box to synchronize the start of the recording and playback of 
audio CDs. 

To record over an existing file: 

1. Activate the file over which you want to record. 

2. Choose Record on the Toolbar. The Record Over dialog (Figure 5-9) 
appears. 

Record Over- [C:\WINDOWSIFANFARE.WAVJ 

Left channel 

Mixer ... 
Right channel 

Recording F01mat· Stereo 8 bits, 22050 Hz 

Available Disk Space: 247S0320 bytes 

Recording Time (maximum~ 561 $econds 

FIGURE 5-9: Record Over dialog 

3. Choose Start. 
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Cancel 

!;;.0 Player 

I CO Sync 

J::!.elp 
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Saving Wave Files 

To save a wave file: 

1. Choose Save on the Toolbar or select Save from the File menu. 

2 . Enter the name of the file and the path if prompted. 

3 . Choose OK. 

To save a wave file with a new name or format: 

1 . Select Save As from the File menu. The Save Sound File dialog (Figure 
5-10) displays. 

Save Sound File 

FileName: Q.i rec1ories : I 
I 

OK 

I~ c:\windows 

I Cance l 
chorgex.wo.v 10 c:\ 
dnmes.wnv e windows 
chord wav CJ apw_data .!::ielp 
dmgwnv CJ osw_doto 
funfure wuv Ll system 
h:tdawuv LJ temp 

Drives: . I"" c: w 
Save File as Iype: Compression/Conversion: 

lwave format (•_WAV) [!I 1- None - [!j 

W~~Flefoor.OC PCM-StereoSbib.2205{)Hz 

'Wttve f1e Size; 385024 bj.tes 

Av~Dtsk.S~e: 24!)3)688bytes 

FIGURE 5-10: Save Sound File dialog 

2. Enter a new name for the file and the path if prompted. 

3 . Select the desired file format and compression method from the Save File as 
Type and Compression/Conversion drop-down list boxes respectively. 

4. Choose OK. 

NOTE Compression is not available for 8-bitfiles. Also, you can convert a 
wavejlle to a differentfonnat by selecting PCM Conversion from the 
Compression/Conversion list. 
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Mixing Data of Wave Files 

When you mix the data of two wave files, you are actually adding the 
data of one file to another to create a new file. After mixing, you can 
play back the new file to hear the new sound generated. 

To mix the data contents of two wave files: 

1. Activate the first (source) file and select the desired portion of the data for 
mixing. 

2. Select Copy from the Edit menu. The data copied is stored in a buffer. 

3. Activate the second (target) file and select the location to which you want 
the copied data to be mixed. 

4. Select Paste Mix from the Edit menu. The Paste Mix dialog (Figure 5-11) 
displays. 

Paste Mix 

From Buffer Use:---

@ l\i.~i.~·:.i2b:~~~.fi.i:i! 
0 ),.eft Channel 

0 B.ight Channel 

Stereo 8 bls. 22050 Hz 

Mix With Wave:·-----, 

Ste~eo 8 bh_ 22050 Hz 

OK 

Cancel 

Help 

Specify the individual channel(s) of the bulfer and the de>tination wave to mil< 
with. 

FIGURE 5-II: Paste Mix dia log 

5. Select the desired channel(s) for copying data from the source file in the 
From Buffer Use box and for mixing data with the target file in the Mix 
With Wave box. 

• Select Mono Channel for monaural file. 

• Select Left Channel, Right Channel, or both channels for stereo file. 

6. Choose OK. 
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If a portion of the target file is not selected, the data is mixed at the 
cursor position. If a portion of the target file is selected, the copied data 
in the buffer is mixed with the portion selected. 

NOTE You cannot mix 8-bit with 16-bit wave data. However, you can 
convert both files to the same sampling size, either 16-bit or 8-bit, 
before mixing them. 

Adding Special Effects 

WaveStudio allows you to enhance your wave files with special effects 
from the Special menu. These effects include Reverse, Add Echo, Invert 
Waveform, Rap!, Insert Silence, Force to Silence, Fade In and Fade Out, 
Swap Channels, Pan Left to Right and Pan Right to Left, Phase Shift, 
convert Format, Modify Frequency, ;;md Amplify Volume. 

Reverse 

This effect reverses the sequence of the data in the wave file such that the 
sound is played from the end to the beginning. You can specify a 
selected portion of the file to be reversed. If a portion of the file is not 
selected, the entire file is reversed. 

To reverse a file: 

1. Select Reverse from the Special menu. The Reverse dialog (Figure 5-12) 
displays . 

Reverse 

Reverse Playback:--
OK 

<!• i!'i~!~:¢F~~ri~i~l 
0 _Left Channel Cancel 

0 Right Channel 
!:!.elp 

Reverse the playback of the wave data for the selected channel[s). 

FIGURE 5-12: Reverse dialog 
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2. Select the desired channel(s): Select Left Channel, Right Channel, or both 
channels for a stereo file. (No options are available for editing a monaural 
file.) 

3. Choose OK. 

Add Echo 

This effect adds echo to the sound file. You can create a metallic sound 
by continually applying echo to the same wave file until you achieve the 
desired result. 

To add echo to a file: 

1 . Select Add Echo from the Special menu. The Add Echo dialog (Figure 
5-13) displays. 

Add Echo 

~,p Magnitude: fr ffi% OK _j ::} 
[100 ~ msec I Echo Delay: Ce.ncel 

Add Echo To: 

@ J;l.oth Channels J:ielp ] 
Left Channel 

0 Bight Channel 

Add echo to the sound by specifying echo magnitude in pe1centage and delay in miUi$ecoo:k 

FIGURE 5-13: Add Echo dialog 

2. Enter the echo magnitude (loudness of the echo) in the Magnitude box. 

3. Enter the delay (time between sound and echo) in the Echo Delay box. 

4. Select the desired channel for stereo file. 

5. Choose OK. 

Invert Waveform 

This effect inverts the wave file along its horizontal axis. You can 
specify a selected portion of the file to be inverted. If a specific portion 
of the file is not selected, the entire file will be inverted. To create an 
unusual effect, invert only one channel of a stereo file. 
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To invert a .file: 

1. Select Invert Waveform from the Special menu. The lnvett Waveform 
dialog (Figure 5-14) displays . 

Invert Waveform:-----, 

@ [JiQiF :¢H~~~~~~! 
0 .Left Channel 

0 B.ight Channel 

Invert the wave data for the selected chanr.el(s). 

OK ] 
Cancel ] 

!::!_elp J 

FIGURE 5-14: Invert Waveform dialog 

2. Select the channel(s): Left Channel, Right Channel, or Both Channels for 
stereo wave file. (No options are available for editing a monaural file.) 

3. Choose OK. 

Rap! 

Rap! repeats the selected portion of the wave file, creating a jerky or 
stuttering effect. 

To repeat a selection: 

1 . Select a portion of the file. 

2. Select Rap! from the Special menu. 

Insert Silence 

This feature inserts silence into a selected portion of the wave file . 

To insert silence into a .file: 

1 . Select a portion of the wave file. (The length of the silence depends on the 
length of the portion selected.) 

2. Select Insert Silence from the Special menu. 

A straight line represents the silence inserted into the selected portion . 
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Force to Silence 

This feature mutes the selected portion of the wave file-the selected 
portion is not heard during playback. 

To mute a file: 

1 . Select a portion of the file. 

2. Select Force to Silence from the Special menu. The Force to Silence dialog 
(Figure 5-15) displays. 

Force to Silence 

Silence Out:----~ 

@ !iii!E .¢E~~:il~i~J 
0 Left Channel 

0 Bight Channel 

OK ] 

Cancel I 
Help I 

Farce the selected region to silence for the selected channel(s). 

FIGURE 5-15: Force to Silence dialog 

3. Select the desired channel(s): Left Channel, Right Channel, or Both 
Channels for stereo wave file. (No options are available for editing a 
monaural file.) 

4. Choose OK. 

A straight line represents the si lence replacing the selected portion. 

Fade In and Fade Out 

You can create a fading in (soft to loud) or fading out (loud to soft) effect 
for your wave files . 

To use Fade In (or Fade Out): 

1. Select Fade In from the Special menu. The Fade In dialog (Figure 5-16) 
displays. 

2. Enter the starting magnitude in the Magnitude box. 

3. Select the desired channel(s) for stereo files. 
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Fade In 

Magnitude: r ~% 

Fade ln:----~4 

@ f!_oth Channels 

0 _Left Channel 

0 B_ight Channel 

OK 

Cancel 

!::!elp 

Fade in the wave data by specifying the starting magnitude in pe1centage. 

FIGURE 5-16: Fade In dialog 

4. Choose OK. 

NOTE For Fade In, the file is linearly faded in from the starting magnitude 
(volume) to a 100 percent magnitude. For Fade Out, the file is 
linearly faded out from a 100 percent magnitude (volume) to the 
ending magnitude. 

Swap Channels 

This feature switches the entire or selected portion of wave data between 
the left and right channels-only applicable to stereo files. 

To swap the channels of a wave: 

1 . Select Swap Channels from the Special menu. 

Pan Left to Right and Pan Right to Left 

The Pan Left to Right effect pans the data of wave files from the left to 
the right channel. The Pan Right to Left effect pans the data from the 
right to the left channel. This feature is useful if you want to simulate the 
movement of a sound source from one end of the sound stage to the other. 

To use Pan Left to Right (or Pan Right to Left): 

1 . Select Pan Left to Right from the Special Menu 
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Phase Shift 

This effect allows you to delay the playback of the selected channel of 
stereo wave files. 

To create a phase shift effect: 

1. Select Phase Shift from the Special menu. The Phase Shift dialog (Figure 
5-17 appears. 

Phase Shift 

Phase Delay: ~ t§] 

[

Delay Resolution:--­

(i' Milliseconds 
0 ~amples 

OK 

Ce.ncel 

tlelp 

·[Apply Phase Shift To: J 
@ !.eft Channel 

B_ighl Channel 

--~-:-h_ ..... __ h .... -.~ 
FIGURE 5-17: Phase Shift dialog 

2. Select the desired measurement unit from the Delay Resolution box. 

3. Enter the desired delay in the Phase Delay box. 

4. Choose the desired channel from the Apply Phase Shift To box. 

5. Choose OK. 

You can convert a monaural wave file to stereo by applying this effect, 
giving the converted monaural file a pseudo-stereo effect. 

Convert Format 

This effect allows you to convert between monaural and stereo files, 
8-bit and 16-bit files, and different frequencies. 

To convert the format of a file: 

1. Select Convert Fmmat from the Special menu. The Convert Format dialog 
(Figure 5-18) displays. 
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Convert Format 

rt; [~iii, 
Sampling Rate:--

0 11025 Hz 

@£2050Hz 

0 .14100 Hz 

[

Sampling Size:-­

@ J!_bits 

0 1§. bits 

OK 

Cancel 

!:!elp 

Select Ste1eo 01 Mono, hequency and sample size (8 m 16 bit). 

FIGURE 5-18: Convert Format dia log 

2. Select the desired channel from the Channels box. 

3. Select the desired sampling rate and size from the Sampling Rate and 
Sampling Size boxes respectively. 

NOTE Conversion is a complex process and may take a long time to 
complete depending on the size of the file. 

Modify Frequency 

You can modify the frequency (playback rate) of wave files by selecting 
from three fixed frequencies: 11 kHz, 22kHz, or 44kHz. Selecting a 
higher frequency results in a faster playback while a lower frequency 
results in a slower playback This effect is applied to the entire file. 

To modify the frequency of a file: 

1. Select Modify Frequency from the Special menu. The Modify Frequency 
dialog (Figure 5-19) displays. 

2, Select the desired frequency. 

3. Choose OK. 
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Playback Rate:---. 

Q 11025 Hz 

@~?_!I§Q__t.j!l 
0 .1_4100 Hz 

OK 

Cancel 

!::!.elp 

Modify the pleybeck rate of the wave by selecting a new frequency. 

FIGURE 5-19: Modify Frequency dialog 

NOTE If your file is already at the maximum frequency of 44kHz, use 
Convert Format from the Special menu to convert it to 22 kHzfirst 
before using Modify Frequency. 

Amplify Volume 

This feature allows you to change the volume of wave files, either the 
entire or a selected portion of the wave file . 

To change the volume of a file: 

1. Select Amplify Volume from the Special menu. The Amplify Volume 
dialog (Figure 5-20) displays . 

Amplify Volume 

ffll Magnitude: llimil li] % 

Amplify Volume:---, 

@ !!,oth Channels 

0 !..eft Channel 

Bight Channel 

OK 

Con eel 

J:j_elp 

FIGURE 5-20: Amplify Volume dialog 

2. Enter the magnitude in the Magnitude text box. 

3. Select the desired channel(s). 

4. Choose OK. 
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Customizing WaveStudio 
WaveStudio allows you to customize the default settings for recording, 
Creative Mixer, and the display color of the WaveStudio interface. 

Recording 

When you customize the record settings, future recordings of wave files 
will be based on those settings. 

To customize the record settings: 

1 . Select Record Settings from the Options menu. The Record Settings dialog 
(Figure 5-2) displays. 

2. Specify the desired settings. 

3. Choose OK. 

Creative Mixer 

To adjust the settings for Creative Mixer: 

1 . Choose Mixer on the Toolbar. Creative Mixer appears. 

2. Specify the desired settings. 

NOTE 

Display Color 

You can customize the display color of both the Edit and Preview 
Windows. WaveStudio also allows you to reset the colors of both 
windows to their default color scheme. 
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To customize the display color: 

1 . Select Customize Colors from the Options menu. The Customize Colors 
dialog (Figure 5-21) displays. 

Custom1ze Colors 

~~ 
Edit Window D1sploy Colors: 

OK .II ~Ch.annei:J Con eel .I Right ChefmeL. I I 0 1 I 
Qefoults 

Bockground ... I I .I I 
tLelp 

Silence Bftseline ... 

• I left/Right T exL. I j 
rev;ew w;ndow o;,ptoy Color.: 

d • I Left Channel... 

.I Right Cbo.nneL I 

.I Background ... 

101 Progress Indicator ... 

FIGURE 5-21: Customize Colors dialog 

2. Select the display element(s) you want to customize in the Edit Window 
Display Colors and Preview Window Display Colors boxes. A color dialog 
appears . 

3. Select the color you want. 

4 . Choose OK. 

To restore the display element(s) to the original color scheme: 

1 . Choose Defaults. 
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Using WaveStudio Effectively 

To use WaveStudio effectively, you need to know the amount of memory 
needed to run WaveStudio, how to manage your files, and how to work 
with compressed files. 

Memory Requirements 

WaveStudio requires about 1 MB of memory. The memory requirement 
increases when you playback or record wave files-sufficient memory is 
needed for the buffers. Run WaveStudio on at least a 386-based system 
with 4 MB of RAM and Windows 3.1. 

When you open a file for editing, WaveStudio allocate a certain amount 
of memory for storing the necessary information and does not load the 
entire file into memory. The file is edited directly from your hard 
disk-you can edit files as large as your hard disk can hold. 

File Management 

This section explains how you can optimize your system for speed and 
manage your wave files effectively. 

System Optimizing 

When you record wave data, WaveStudio will store recorded data 
directly to the hard disk. High resolution recording of data, particularly 
16-bit data at 44 kHz, would take longer to write to your disk if it is not 
optimized for speed. 

You can reduce the amount of time your system spends reading and 
writing data by compacting your hard disk using a disk-compacting 
utility such as DEFRAG and installing a hard disk cache such as 
SMARTDrive. 
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Number of Open Files 

WaveStudio does not limit the number of ftles you can open, but the 
number of open files depends on how your operating system is 
configured. For more information, consult your operating environment's 
documentation. 

Use of DOS SHARE Utility 

Use the DOS SHARE utility to allow proper file sharing and locking. 
SHARE prevents you from accidentally deleting a file while WaveStudio 
is accessing it. For more information on how to use this utility, consult 
your DOS documentation. 

Compressed Wave Files 

To work effectively with compressed wave files, you need to know how 
compressed files are opened and edited. 

Opening Compressed Files 

WaveStudio currently supports five compression formats: Microsoft 
ADPCM, CCITT A-Law, CCITT J.L-Law, IMNDVI ADPCM, and 
Creative ADPCM. 

When you open a compressed wave file, WaveStudio decompresses the 
file before displaying it. The file must reside on a drive that has 
sufficient disk space to accommodate the uncompressed data. 

The amount of space required depends on the compression format 
adopted. For CCITT A-Law and !-l-Law, the compression ratio is 1:2 
(compressed:uncompressed). For ADPCM, the ratio is 1:4. For 
example, if you are working with a 1 MB ADPCM file, you need to have 
at least 4 MB of free disk space. 
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Editing Compressed Files 

When you open a compressed wave file for editing, WaveStudio 
automatically compresses the file when you save it. This can be time 
consuming for large files. Save your work as an uncompressed wave 
(PCM) file first. Once you have fmished editing, save the file with the 
desired compression format. 

Using CD Sync 

CD Sync allows you to synchronize the start of the recording and 
playback of audio CDs. This option is only available if you have a 
CD-ROM drive installed in your system. 

If you have mistakenly placed a CD-ROM disk in your drive, the 
program informs you of the error. But the recording will continue. To 
stop the recording, choose Stop on the Toolbar. Insert the correct audio 
CD and then choose Record on the Toolbar to record over your file. If 
you do not want the CD Sync option, uncheck it before proceeding with 
the recording. 

Quitting WaveStudio 
To quit WaveStudio: 

1 . Select Exit from the File menu. 

If changes to the file have not been saved, a dialog prompts you to save 
the changes. 
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Six 

Creative EnsembleAV 

Creative EnsembleAV is a set of on-screen control panels for audio 
compbnents. The EnsembleRemote is a multi-control interface that 
resembles the remote control of a stereo hi-fi system. You can use the 
EnsembleRemote to play audio through different devices individually or 
concurrently. And, for more direct control, you can display a control 
panel for each of three audio devices. 

The Creative EnsembleA V set of audio control panels consists of: 

•:• EnsembleRemote: Controls any of the other three devices. 

•:• EnsembleCD: Controls a CD-ROM drive playing audio CDs. 

•:• Ensemble Wave: Controls the recording and playback of wave 
(.WAV) files. 

•:• EnsembleMIDI: Controls the playback of MIDI (.MID) files. 
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Ensemb.leRemote 
You can use the EnsembleRemote to control the EnsembleCD, 
Ensemble Wave, and EnsembleMIDI. However, the remote control only 
allows you to control one at a time. 

Starting EnsembleRemote 

To start EnsembleRemote: 

1. Double-cl ick the EnsembleRemote icon in your Sound Blaster 16 group 
window. The EnsembleRemote interface (Figure 6-1) displays. 

Touch-sensitive display 
(system time) 

Power on/off 

Menu 

Minimize 

Playback controls 

Track selector 

G.;:] 

~ w 
c:::LJ CLJ 

I,AJ,/,. J..u..lrC:. l 
I. ,y. l, Me I.MJ. H- I 
~ -""" 

kiJw 

Active device (CD) 

Select device 

Playlist 

Volume control 

Two-d igit mode selector 

FIGURE 6-1: EnsembleRemote interface with EnsembleCD the active device 
and the system time in the touch-sensitive display 

Touch-Sensitive Display 

The touch-sensitive display allows you to change the LED-like window 
to show: 

•:• Current system time 

•:• Title of the current play list 

•:• Title of the current track 
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L ... 

FIGURE 6-2: EnsembleRemote with EnsembleMIDI active and the current 
track in the touch-sensitive display 

Menu Button 

The Menu button displays the control menu listing the commands 
available from EnsembleRemote. 

H('StOtE' 

.Move 

..S.ize 
Minimize 
MCQSirniLe 

.Close Alt+F4 

S'O'ItCh To ... ctri+Esc 

J Stack £layers 
Clos.eAII 
].oadAII 

C.o.lor Scheme ' Always On Iop 

Mi~er Settings ... ctri+M 

l:l.elp on Ensemble Remote ... 

8bOlJt Ensemble Remote ... 

FIGURE6-3: EnsembleRemote control menu 

Minimize Button 

The Minimize Button minimizes the EnsembleRemote to an icon. 

Active Device 

The icon of the active device is displayed. You can click on the icon to 
display the icons of available devices . 

(a) 

FIGURE6-4: 
[b) (c) 

Active device icons: (a) EnsembleCD, (b) EnsembleWave, (c) 
EnsembleMIDI 

Creative EnsembleAV 6-3 



Invoke Player Button 

The Invoke Display button displays the icons for the three devices 
available. 

(a) 

FIGURE6-5: 
(b) (c) 

Invoke Display icons: (a) EnsembleCD, (b) Ensemble Wave, 
(c) EnsembleMIDI 

Playlist Button 

The Play list button allows you to compile the desired tracks/sound files 
for playing through the Play list dialog. 

Playback Control Buttons 

The Playback Control buttons allow you to perform the playback 
operations on the active player. 

6-4 

Stops the track/sound file. 

Plays the track/sound file. 

Pauses the track/sound file. 

Records sound from a selected source; Ensemble Wave 
only. 

Plays the previous track/sound file. 

Rewinds the track/sound file. 

Forwards the track/sound file. 

Plays the next track/sound file. 

Loads or unloads the CD; EnsembleCD only. 
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Volume Control Buttons 

The Volume Control buttons decrease and increase the 
volume. 

Track Selector 

The track selector consists of buttons that you can press to select a 
track/sound file in the play list. For example, to play track/sound file two, 
press button 2. 

Q 
ll ill~ l 
I. .'i,L z. 1. .~ 1 

I, x, .I"* Ia ~.J,. ~J 

Two-Digit Mode Selector 

The Two-Digit Mode Selector allows you to select a track/sound file 
number above ten in the playlist. When the icon is highlighted, the track 
selector accepts only two-digit entries. 

Power Off Button J 
The Power Off button allows you to quit the EnsembleRemote. 

Activating an Audio Device 

Before you can control an audio device with the EnsembleRemote, you 
need to activate the device's control panel. 

To activate a device: 

1. Choose the Invoke Display button on EnsembleRemote .. 

2. Choose the button of the player you want to activate. 
0 1\, 

The selected device becomes active and its icon appears 
in the active device display. 

Creative EnsembleAV 
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Playing Tracks/Sound Files 

You can use EnsembleRemote control buttons to play tracks/sound files 
from the play list for the current audio device. You can also select a track 
and play it using the track selector. 

To play a track/sound file using the track selector: 

1 . Choose the two-digit mode selector for track numbers ten and above. 

2. Choose the button(s) from the track selector that correspond to the track(s) 
you want to play. 

NOTE If you choose a track number that does not exist, the last track in the 
playlist is selected. 

Compiling a Playlist 

You can compile a playlist by choosing the Playlist button. The Play list 
dialog allows you to create a new play list, and add, delete, and rearrange 
tracks/sound files. 

NOTE For more information, refer to the playlist section for the specific 
device. 

Selecting an Audio Device 

You can select a device to perform operations such as playing tracks in 
random order and previewing the beginning of each track in the play list. 
You can control the current device with EnsembleRemote. 

To select a device: 

1 . Choose the Invoke Player button to display the device icons. 

2. Choose the button for the audio device. 

Alternatively, to display the controller for the selected device, 
double-click the active device icon. 
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Using the Keyboard with EnsembleRemote 

You can use the keyboard to perform operations from EnsembleRemote. 

Key 

A 

B 

c 
CTRL+D 

D 

E 

F 

Fl 

H 

K 

L 

N 

0 
p 

R 

s 
SPACEBAR 

T 

u 
w 
Oto9 

Action 

Pauses the track/sound me. 

Plays the previous track/sound me. 

Activates the Invoke Player icons. 

Switches the touch-sensitive display. 

Decreases the volume. 

Loads/ejects the CD. 

Plays the next track/sound me. 

Displays on-line help. 

Activates the Invoke Player button. 

Rewinds the track/sound file. 

Opens the play list. 

Minimizes EnsembleRemote to an icon. 

Quits EnsembleRemote. 

Plays the track/sound me. 

Records the wave me. 

Stops the track/sound file. 

Confirms selection. 

Activates two-digit mode. 

Increases the volume. 

Fast-forwards the track/sound file. 

Selects the tracks/sound file. 
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EnsembleCD 

You can use EnsembleCD to perform operations such as playing audio 
COs, compiling the playlist, and giving names to the tracks on your CD. 

Starting EnsembleCD 

Use EnsembleCD to play audio COs, create a playlist, and name the 
tracks on the CD. 

To start EnsembleCD: 

1 . Double-click the EnsembleCD icon in the Sound Blaster 16 group window 
to start EnsembleCD from Windows, or use the Invoke Player icons on the 
EnsembleRemote. 

The EnsembleCD interface is similar to Figure 6-8. 

Power 
I ff on o 
l 

Mfnu 

Touc h -sensitive 
display 

I 
CJU / / 

II CR:Z:C!TIV:Z: 
lD ...... ~ I ' 

~· 
CLJ 

®-0 DE! ill 

t I. J. L~ I. ~ I, g I, 5 L~. l , ' I. ' 1,& I 0 I 

I I 
Minim ize Track selector 

FIGURE 6-6: EnsembleCD 
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Playback 
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I 
Playlist 

..~ I, s 
~ J. u 

II.D-. 

Alternatively, select the EnsembleCD icon on the EnsembleRemote. 

Touch-Sensitive Display 

The touch-sensitive display allows you to switch between: 

•!• CD-ROM drive status (indicates whether a CD is in the drive) 

•!• CD and track titles 

•!• Track number and duration 

I 
I 
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For CD and track titles or track number and duration display, the 
touch-sensitive display is similar to the following: 

Repeat 
mode 

Graphic volume 
Control 

Drive 
selector 

\ 
Graphic 
slider 

Shuffle 
mode 

FIGURE 6-7: CD track touch-sensitive display 

Two-digit 
mode 

Drive Selector Allows you to control up to four CD drives-CD 
1, CD 2, CD 3, and CD 4-if you have more than 
one CD-ROM drive installed in your system. The 
highlighted drive is the one cunently active. 

Graphic Slider Indicates the percentage of the cunent track that 
has been played. It also allows you to control the 
position of the playing track. 

Graphic Volume Shows the volume level. 
Control 

Two-digit Mode Allows you to select a track number above nine in 
the play list when it is highlighted. 

Repeat Mode Repeats the play list after the final track is played. 

Introduction Mode Plays the first few seconds of each track in the 
playlist. 

Shuffle Mode Randomly selects and plays tracks from the 
play list. 
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Menu Button 

The Menu button displays the EnsembleCD control menu with the list of 
available commands. 

Bestore 
.Move 
~ize 

Minimize 
M~imize 

i;lose Alt+F4 

S~itch To .. . ctri+Esc 

Mi~er Settings ... ctri+M 

Help on Ensemble CD ... 

8bout Ensemble CD ... 

FIGURE 6-8: EnsembleCD control menu 

Playlist Button 

The Play list button allows you to select the tracks that you want to play. 
Choose the Play list button to display the CD Playlist dialog (Figure 6-9). 

CD Playhst 

r I Cll. Arnst/ Tille: I.rack Title: 

lmi!m! I ITmck 01 

Plox_list Tro.ck,Li s t 

01 Trock 01 . I E.lay 

I Add 

I Add All 

I ,C.Iear 

. I Removo 

o,. II Cemce l II tle lp 

FIGURE 6-9: EnsembleCD Playlist dialog 

CD Artistffitle Name of your CD. 

Track Title Names of the tracks on your CD. 
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Playlist Displays the tracks in the playlist. 

'frack List Displays the tracks on your CD. 

Play Plays selected tracks in the Play list or Track List. 

Add Adds selected tracks in the Track List to the 
Play list. 

Adds All Adds all the tracks in the Track List to the Play list. 

Clear Clears the tracks in the Playlist. 

Remove Removes selected tracks from the Playlist. 

Done Confirms the selection of the tracks in the Play list. 

Cancel Cancels changes made to the tracks in the Playlist. 
The Playlist reverts to its last saved copy. 

Help Displays the on-line help facility. 

Playback Control Buttons 

The Playback Control buttons allow you to select playback operations on 
EnsembleCD. 

~ 
kxMJJ 
IJJLJ 

Stops the track. 

Plays the track. 

Pauses the track. 

Plays the previous track. 

Quickly rewinds the track. 

Quickly forwards the track. 
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~ 
~ Plays the next track. 

Loads or unloads the CD. 

Track Selector 

The track selector allows you to select a track that you want to play. 

Power On/Off Button 

The Power On/Off button allows you to quit EnsembleCD. 

Playing Tracks 

You can play the tracks using the Playback Controls or Track Selector. 

To play a track using the Track Selector: 

1 . Choose the two-digit mode selector if the track number is above nine. 

2. Choose a button from the Track Selector that corresponds to the track you 
want to play. 

If you choose a track that does not exist, the last track on the playlist is 
played. 

If you want to play a track starting at a certain point, use the Graphic 
Slider to change the track's playing position. You can reposition the 
Graphic Slider before playing the track or while it is playing. 

To play a track from a chosen point: 

1 . Click and hold down the left mouse button on the Graphic Slider and move 
it to the point at which you want to start playing the track. 

2. When the Graphic Slider reaches the chosen point, release the mouse button. 

If your CD is already playing, the track immediately moves to the point you 
chose and starts playing. 

If your CD is not playing, choose Play to start playing the track at the point 
you chose. 
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Adjusting the Volume 

You can adjust the volume with the Graphic Volume Control. 

To adjust the volume: 

1 . Click and hold down the left mouse button on the Graphic Volume Control. 

2. While holding down the mouse button, adjust the volume to the level you 
want by moving the Graphic Volume Control up or down. 

Editing the CD Playlist 

A play list is a set of audio CD tracks organized for playing in a particular 
order. You can compile the tracks by using the CD Play list dialog. 

To compile and edit the playlist: 

1. Choose the Play list button on EnsembleCD. The CD Play list dialog 
displays (see Figure 6-10). 

CD Playilst 

CO. Artist/Title: Ir10.ck Title: 

I 
lmm j jTrack 01 

Plo.:t,list Trac1).Ust: 

01 Track 01 . I £ lay I 

I ll_dd 

I AddA[I 

I Clear . I Aom.ove 

D.u.ne II Cancel II l!elp 

FIGURE 6-10: EnsembleCD Playlist dialog 

2. Perform the desired operations to the play list. 

• Preview tracks 

• Add tracks 

• Remove tracks 

• Rearrange tracks 

• Name the tracks and play list 
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3. Choose Done when you are satisfied with the play list. 

Choose Cancel to cancel all changes made to the play list. 

Adding Tracks to the Playlist 

To add track(s) to the playlist: 

1. Select the track(s) to add to the playlist from the Track List. 

2. Choose Add to add the track(s) to the Playlist. 

Choose Add All to add all the tracks in the Track List to the Play list. 

Previewing Tracks 

To preview track(s): 

1. Select the track(s) from the Playlist or Track List. 

2. Choose Play. The track starts playing. 

NOTE You can also preview a track by double-clicking the track in Playlist 
or Track List. 

Removing Tracks from the Playlist 

To remove track(s)from the Playlist: 

1. Select the track(s) to be removed from the Play list. 

2. Choose Remove. 

Choose Clear to remove all tracks from the Play list. 

Selecting Tracks from the Playlist 

You can select multiple tracks for previewing, adding, or removing by: 

•!• Pressing the CTRL key to randomly select the tracks. 

•!• Pressing the SHIFT key to select a set of adjacent tracks. 
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Rearranging Tracks in the Playlist 

If you are not in Shuffle Mode, you can rearrange the tracks in the 
playlist in the order you like by using the right mouse button. Shuffle 
mode directs your computer to randomly arrange tracks in the play list. 

To rearrange a track in the playlist: 

1. Click and hold down the right mouse button on the track in the Play list and 
drag it to the new position. 

The track is moved to the new position and the preceding tracks rearranged 
below it in the Play list. 

NOTE 
.=,-'.':: :_-;~:,:G;·, , .-~: :_;:..::;_~:t£.-::;;·::.;:·:s;. __ ,·::~_:::r.-: :· -~' ,_.-;:,c.c;r-::- .. , •.... - • -~-__:: .- , -~.,.-- __ ,_ -~ . ~ -···'"-'-~ 

If you are in Shuffle Mode, rearranging the order does not change the 
original playing order of the tracks. 

Naming the Playlist 

Once you have one or more titles in the Playlist, you can save the Playlist 
by giving it a name. 

To give your Play list a title: 

1. Select the CD Artist/Title box and type the title of the Playlist. 

Naming the Tracks 

To name a track on your CD: 

1 . Select the track in the Track List. The track title is placed in the Track Title 
box. 

2. Select the Track Title box and type the new name. 

3. Press ENTER. 
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Using the Keyboard with EnsembleCD 

You can use the keyboard to initiate EnsembleCD operations. 

Key 

A 

B 

CTRL+D 

E 

F 

Fl 

G 

H 

I 

K 

L 

M 

N 

0 
p 

s 
SPACEBAR 

T 

w 
Oto9 
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Action 

Pauses the track. 

Plays the previous track. 

Changes touch-sensitive display. 

Loads/ejects the CD. 

Plays the next track/sound file. 

Activates OJ:?.-line help. 

Activates the Graphic Volume Control. 

Activates Shuffle Mode . 

Activates Introduction Mode. 

Rewinds the track. 

Accesses the Play list dialog. 

Activates Repeat Mode. 

Minimizes EnsembleCD to an icon. 

Quits EnsembleCD. 

Plays the current track. 

Stops the current track. 

Confirms selection. 

Activates the Two-digit Mode. 

Fast-forwards the track. 

Selects tracks. 
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Ensemble Wave 
You can use Ensemble Wave to perform operations such as playing wave 
files, compiling a play list, and recording a MIDI file or audio CD into 
wave format. 

Starting EnsembleWave 

To start Ensemble Wave: 

1. Double-click the Ensemble Wave icon in your Sound Blaster 16 group 
window. The EnsembleWave controller (see Figure 6-11) is displayed. 

Power 
on/off 

l M/nu 

Touch-sensitive 
display 

I 
H {;, 

Playback 
controls 

1 
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I I 
Track selector 

I 
Record 

I 
Play list Minimize 

setting 

FIGURE 6-11: Ensemble Wave 

Alternatively, start Ensemble Wave from EnsembleRemote. 

Touch-Sensitive Display 

By selecting the touch-sensitive display, you can switch among the 
following: 

•!• Wave file playing status (showing whether a selected wave file is 
currently playing) 

•!• Titles of the wave file and play list 

•!• Number and elapsed time of the current wave file 
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The following touch-sensitive display shows the wave file and play list 
titles, or wave file number and length. 

Graphic 
Slider 

Introduction 
mode 

Repeat 
mode 

Shuffle 
mode 

Graphic Volume 
Control 

Two-digit 
mode 

FIGURE 6-12: Ensemble Wave track touch-sensitive display 

Graphic Slider Indicates the progress of the wave file that is 
currently playing. Also, allows you to control the 
starting position of the current wave file. 

Graphic Volume Shows the volume level ofEnsembleWave 
Control 

Repeat Mode Repeats the whole play list when the final wave file 
is played. 

Introduction Mode Plays the first few seconds of each wave file in the 
play list. 

Shuffle Mode Randomly plays the wave files in the play list. 

Menu Button 

The Menu button displays the Ensemble Wave control menu with the list 
of available commands. 
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Bes tore 
Move 
~ize 

Minimize 
M<llSimize 

.Close Alt+F4 

S~itch To ... Ctri+Esc 

Mi~er Settings ... Ctri+M 
Wavefditor - CHARGEX.WAV 

CQ Sync 
MjDI Sync 

!:lelp on Ensemble Wave ... 

8bout Ensemble Wave ... 

FIGURE 6-13: Ensemble Wave control menu 

Minimize Button 

The minimize button minimizes the Ensemble Wave to an icon. 

Playlist Button 

The Playlist button allows you to compile the desired wave files for 
playing. When you choose this button, the Wave Play list dialog (see 
Figure 6-14) appears: 

Wave Playllst 

Collection: 

± j Sound (• .wav) l±l 
I ~ave II SavnAs ... II Q.elete I f.i les· Directories: 

Pte.y;Jist chorgex.wov e c:\ 
01 CHARGEXWAV . I I 

chimes.wov ~windows 

02 CHI~ES .WAV 
Ptnv cho rd.wav D apw_doto 

OJ CHORD.WAV I I 
ding.wnv D asw_dolo 

" OIN G.WAV 
Add fanfr~ ro .we.v a system 

OS FANFARE WAV I I 
llllda.wav D tomp 

06 TAOA.WAV 
Add All 

I Qear I . I Rumovo• I 
Or i:~£.es : 

1•1 1 I D.o.ne II Cancel II .tlelp I . l liil c: 

FIGURE 6-14: Ensemble Wave Playlist dialog 

Collection Title of your current play list. 

List Files of Type Only files of the selected type are included in the 
Files list. 
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Drives Displays the selected drive. 

Directories Displays the directory search path. 

Files Displays files of the type specified in List Files of 
Type. 

Playlist Displays the files you have included in the play list. 

Play Plays the selected wave files. 

Add Adds selected wave files to the Playlist. 

Add All Adds all the wave files to the Play list. 

Clear Clears the wave files in the Play list. 

Remove Removes selected wave files from the Play list. 

Done Confirms the wave files in the Play list. 

Cancel Cancels changes made to the Playlist. The playlist 
reverts to its last saved copy. 

Help Displays the on-line help facility. 

Save Saves the play list under the name in the Collection 
box. 

Save As Saves the play list under a new name. 

Playback Control Buttons 

The Playback Control buttons allow you to perform the playback 
operations. 

Stops the wave file. 

Plays the wave file. 
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Pauses the wave file . 

Records a wave file from a selected source. 

Plays the previous wave file in the play list. 

Quickly rewinds the wave file. 

Quickly forwards the wave file . 

Plays the next wave file in the play list. 

Record Setting Button 

The Record Setting button displays a dialog that allows you to define the 
settings for recording . 

OK 

Cancel 

O lfi.bits 

I Select Stereo or Mono. sample frequency and 
sample size for the default recording settings. 

FIGURE 6-15: Ensemble Wave Choose Wave Format dialog 

Fast Track Selector 

The Fast Track Selector allows you to select and play a wave file from 
the playlist. 

Power Off Button 

The Power Off button closes the Ensemble Wave controller. 
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Playing Wave Files 

You can play wave files by using the Playback Control buttons and 
Track Selector. 

To play a wave file using the Track Selector: 

1. Choose Two-Digit Mode if your wave file number is more than nine. 

2. Choose a button from the Track Selector corresponding to the wave file you 
want to select. 

NOTE 
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If you choose a wave file number that does not exist, the last wave file 
is selected. 

To start playing a wave file from a specific point, use the Graphic Slider 
to change the wave file's playing position. You can reposition the 
Graphic Slider before playing the track or while it is playing. 

To start playing the wave file at a different position: 

1 . Click and hold down the left mouse button on the Graphic Slider and go to 
the position at which you want to start the wave file. 

When the Graphic Slider reaches the chosen position, release the mouse 
button. 

If your player is already playing, the track immediately moves to the 
position you chose and starts playing. 

2. If your player is not playing, choose Play to start playing the wave file from 
the position you chose. 

Adjusting the Volume 

You can adjust the volume ofEnsembleWave using the Graphic Volume 
Control. 

To adjust the volume: 

1 . Click and hold down the left mouse button on the Graphic Volume Control. 

2. Adjust the volume to the level you want. 
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EnsembleWave Playlist 

A play list is a set of wave files that is organized for playing in a 
particular order. You can compile the files in the playlist using the 
Ensemble Wave Playlist. 

Compiling and Editing the Playlist 

To compile/edit a play list: 

1. Choose the Playlist button. The Ensemble Wave Playlist dialog (Figure 
6-14) is displayed. 

2. Perform the desired operations on the playlist: 

• Preview wave files 

• Add wave files 

• Remove wave ftles 

• Rearrange or name wave ftles 

3. Choose Done when you are satisfied with the compilation of the play list. 

Choose Cance 1 to cancel all changes made to the play list. 

Adding Wave Files to the Playlist 

To add wavefile(s) to the playlist: 

1. Select the wave ftle(s) to add to the playlist from the Files. 

2. Choose Add to add the wave file(s) to the Playlist. 

Choose Add All to add all the wave files in the Files list to the Play list. 

Previewing Wave Files 

To preview wavefile(s): 

1. Select the wave file(s) from the Playlist or Files list. 

2. Choose Play. The wave file starts playing. 

NOTE 
~~m'rfl'~~\I!~Hli.'lliii®m~1~~~l 

You can also preview a wave file by double-clicking the wave file in 
the Playlist list. 

Creative EnsembleAV 6-23 



Removing Wave Files from the Playlist 

To remove Wavefile(s)from the playlist: 

1. Select the Wave file(s) from the playlist. 

2. Choose Remove. 

Or choose Clear to remove all Wave files from the Play list. 

Selecting Wave Files in the Playlist 

You can select multiple Wave files for previewing, adding, or removing 
by holding down the CTRL or SHIFf key while you choose them. 

•:• Pressing CTRL allows you to randomly select the Wave files. 

•:• Pressing SIDFf allows you to select a group of adjacent tracks by 
choosing the first and last Wave file in the group. 

Rearranging Wave Files in the Playlist 

If you are not in shuffle mode, you can organize the Wave files in the 
play list in the order you like using the right mouse button. Shuffle mode 
plays Wave files randomly from the playlist. 

To rearrange a Wave file in the play list: 

1. Click and hold down the right mouse buttom on the Wave file in the Playlist 
land drag it to a new position. 

The Wave file moves to that position and the preceding Wave files are 
rearranged following it in the Playlist. 

NOTE 
-~~. •.::. ]~_ ~-~=···-

Ifyou are in shuffle mode, rearranging the order does not change the 
playing order of the Wave files. 
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Naming the Playlist 

You may want to save an edited play list under a new name. 

To give your playlist a title: 

1. Choose Save As. The New Collection dialog (Figure 6-16) is displayed. 

New Collection 

&_nter a new collection name : 

OK l I Cancel ] 

FIGURE 6-16: Ensemble Wave New collection dialog 

2. Enter the title of the play list. 

3. Choose OK. 

If you choose Cancel, you are returned to the Play list dialog without saving 
the title. 

Defining Recording Settings 

To define the settings of a recording: 

1. Choose the Record Setting button. The Choose Wave Format dialog 
(Figure 6-15) is displayed. 

2. Enter the wave fmmat for the recording. 

• Mono (monaural) or stereo channel 

• 11025 Hz, 22050 Hz, or 44100 Hz sampling rate 

• 8- or 16-bit sampling size 

3. Choose OK. 
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Recording a Wave File 

You can record from various audio sources as defined by Creative 
Mixer. If you want to record from CD or MIDI audio, you can use the 
Sync options in the Control menu to synchoronize your recording with 
the playing of the audio. The audio is recorded in wave format and 
saved as a wave file. 

NOTE The format of the recording is set using the Choose Wave Format 
dialog. 

To record a wave file: 

1. Select CD Sync or/and MIDI Sync from the Control menu. 

2. Choose the Record button The Wave Recording dialog (Figure 6-17) is 
displayed. 

File Name: 

lmnn 
chergex.wav 
chimes.wav 
chord.wav 
ding .wa.v 
fenfare .wev 
leda.wav 

Wave Recording - File Name 

Q.irectories: 

c:\windows 

Be:\ 
f:')windows 
LJ apw_data 
0 asw_data 
a system 
Otemp 

list Files of Iype: Dril(es: 

1Ls_ou_n_d(~*.w_a_0~----~~~~ Lls~c: __________ ~l!.l 

ll_tart 

Cancel 

FIGURE 6-17: Ensemble Wave Wave Recording dialog 

3. Enter the directory path and name of the file to which you want to record. 

4. Choose Start. The recording starts. 

NOTE When using the Sync options, the playing of the audio is synchronized 
with the recording only if the audio player is activated. For example, 
if you choose CD Sync from the Control menu, then either 
EnsembleCD or EnsembleRemote running audio CD is activated. 
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Using the Keyboard 

You can use the keyboard to operate the Ensemble Wave control panel. 

Key 

A 

B 

CTRL+D 

F 

Fl 
G 

H 

I 

K 

L 

M 

N 

0 
p 

R 

s 
SPACEBAR 

T 

w 
0 to 9 

Action 

Pauses the wave file. 

Plays the previous wave file. 

Changes the touch-sensitive display. 

Plays the next wave file. 

Activates on-line help. 

Activates the graphic slider. 

Activates shuffle mode. 

Activates introduction mode. 

Rewinds the wave file. 

Invokes the play list. 

Activates repeat mode 

Minimizes Ensemble Wave to an icon. 

Quits EnsembleWave. 

Plays the wave file. 

Records the wave file. 

Stops the wave file. 

Confirms selection. 

Activates the two-digit mode selection. 

Fast-forwards the wave file. 

Selects wave files. 
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EnsembleMIDI 

You can use EnsembleMIDI to perform operations such as playing a 
MIDI file and compiling a playlist. 

Starting EnsembleMIDI 

To start EnsembleMIDI: 

1. Double-click the EnsembleMIDI icon in your audio card's group window. 
The EnsembleMIDI control panel (Figure 6-18) is displayed. 

Touch-sensitive 
Power display 
on/off M;nu / 1 

t 

Playback 
contro ls 

1 
jl, ,[;;. ), ·~ ),. II. :: ~ f/ I I I a jl, "" CP:Zf\TIV!i.: . ;l,lo I, " - I. .!.1. l..d!. 

c:::i:J 
[A.] [ILDI, Lt. I • .:;. I ~ ii. J .. r;. 1,.&. ],J. I "- I • ..L.~ J """' l ~:. l 

I 
Minimize 

r 
Track selector 

r . 
Playl1st 

FIGURE 6-18: Ensemble Wave control panel 

Alternatively, select EnsembleMIDI from EnsembleRemote. 

Touch-Sensitive Display 

By clicking the touch-sensitive display, you can change between: 

•:• MIDI file play status (showiing whether a selected MIDI file is 
currently playing) 

•:• MIDI file number and elapsed time of the playing MIDI file 

•:• Titles of the MIDI file and play list 

The following touch-sensitive display, gives the file and play list titles or 
file number and length: 

l 
I 
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Length of 
wave file 

Repeat 
mode 

Graphic Volume 
Contro l 

Graphic 
Slider 

Shuffle 
mode 

Two-digit 
mode 

FIGURE 6-19: EnsembleM!DI track touch-sensitive display 

Graphic Slider Indicates the percentage of the current MIDI file 
that is playing. It also allows you to control the 
position of the playing MIDI file. 

Graphic Volume Shows the volume level of the MIDI player. 
Control 

Two-Digit Mode Allows you to select a MIDI file number higher 
Selector than ten in the play list when it is highlighted. 

Repeat Mode Repeats the whole play list when the final MIDI 
Selector file is played. 

Introduction Plays the first few seconds of all the MIDI files in 
Mode Selector the play list. 

Shuffle Mode Randomly arranges MIDI files in the playlist. 
Selector 

Menu Button 

The Menu button displays the Control menu showing the following list 
of commands: 
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Restore 
Move 
~ize 

Minimize 
MCQSimiLe 

.Close 

Switch To ... 

J Stack f' layers 
Clo.:;e AII 
J..oacl All 

CQ.Ior Scheme 
Always On Iop 

Alt+F4 

ctri+Esc 

Mi~e r Settings... ctri+M 

!:!elp on Ensemble Remote ... 

_8bout Ensemble Remote ... 

FIGURE 6-20: EnsembleM/DI control menu 

Minimize Button 

The Minimize button minimizes the EnsembleMIDI to an icon. 

Playlist Button 

The Play list button allows you to compile a selection of MIDI files that 
you want to play. When you choose the Play list button, the Playlist 
dialog (Figure 6-21) is displayed. 

MIDI Playllst 
---- -- --

Collection.. Ust Files of Iype: 

jNoTitle I"' ) I MIDI Sequencer {•.mid;• .rmi) H 
.S.avo II Sov.e.As ... II Q.elete ] f iles : Directories: 

Pla)!Jist: canyon .mid . 103c:\ 
Of CANYON. MID . I ~windows 

P.lul esystem 

I Add 

I jAddAU 

I _kleor 

. I Rnmovl 
Dr~e s: 

D.Q.ne II Cancel II !ielp . lsc: 1 ~ 1 

FIGURE 6-21: EnsembleMIDI Playlist dialog 

Collection Allows you to name your playlist. 

List Files of Allows you to specify the types of files you want to view 
Type in the Files list. 
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Drives Displays the selected drive. 

Directories Displays the directory search path. 

Files Displays the files specified in List Files of Type. 

Playlist Displays the files you include in the play list. 

Play Plays the selected MIDI files. 

Add Adds the selected MIDI files to the Playlist. 

Add All Adds all the MIDI files to the Play list. 

Clear Clears the MIDI files in the Play list. 

Remove Removes selected MIDI files from the Playlist. 

Done Confirms the compilation of MIDI files in the Play list. 

Cancel Cancels changes made in the Play list. The Play list reverts 
to its last saved copy. 

Help Displays the on-line help facility. 

Save Saves the play list using the name provided in Collection. 

Save As Saves the Play list under a new name. 

Playback Control Buttons 

The Playback control buttons allow you to perform playback operations. 

Stops the MIDI file. 

Plays the MIDI file. 

Pauses the MIDI file. 
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~ 
~ Plays the previous MIDI file in the playlist. 

I»A~W Quickly rewinds the MIDI file in the playlist. 

r;:-;;;:::] 
~ 

~ 

Quickly forwards the MIDI file. 

Plays the next MIDI file. 

Fast Track Selector 

The Fast TrackSelector allows you to select and play a MIDI file in the 
Play list. 

Power On/OFF Button 

The Power On/Off button closes the EnsembleMIDI control panel. 

Playing MIDI Files 

You can play MIDI files using the Playback control buttons and Fast 
Track Selector. 

To play a MIDI file using the Fast Track Selector: 

1 . Choose the Two-Digit Mode Selector if your MIDI file number is higher 
than nine. 

2. Choose a button from the track selector corresponding to the MIDI file you 
want to select. 

NOTE If you choose a MID/file number that does not exist, the last MIDI 
file in the play list is selected. 

If you want to start playing a MIDI file from a certain position, you can 
use the Graphic Slider to change the MIDI file's playing position. You 
can do this before playing it or while it is playing. 
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To start playing the MIDI file at a different position: 

1 . Click and hold down the left mouse button on the Graphic Slider and move 
the pointer to the position at which you want to start the MIDI file. 

2. When the highlighted portion of the Graphic Slider has reached the position 
you have chosen, release the mouse button. 

If the MIDI file is already playing, it immediately changes to the position 
you have chosen. If your player is not playing, choose Play to start playing 
the MIDI file from the position you have chosen. 

Adjusting the Volume 

You can use the Graphic Volume Control to adjust the EnsembleMIDI 
volume. 

To adjust the volume: 

1 . Click and hold down the left mouse button on the Graphic Volume Control. 

2. Adjust the volume to the level you want. 

EnsembleMIDI Playlist 

A play list is a set of MIDI files organized in a particular order. You can 
organize the files in the playlist using the EnsembleMIDI Play list dialog. 

Compiling the Playlist 

To compile and edit the playlist: 

1. Choose the Play list button. The MIDI Play list dialog (Figure 6-20) displays. 

2. Perform the desired operations in play list: 

• Preview MIDI files 

• Add MIDI files 

• Remove MIDI files 

• Rearrange MIDI files 

• Name the play list 
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3. Choose Done when you are satisfied with the compilation of the play list. 

Choose Cancel to cancel all changes made to the play list. 

Adding MIDI Files to the Playlist 

To add MIDI file( s) to the play list: 

1. Select the MIDI file(s) to add to the play list from the Files list. 

2. Choose Add to add the MIDI ftle(s) to the Play list. 

Choose Add All to add all the MIDI files in the Files list to the Play list. 

Previewing MIDI Files 

To preview MIDifile(s): 

1. Select the MIDI file(s) from the Playlist or Files list. 

2. Choose Play. The MIDI file starts playing. 

You can also preview a MIDI file by double-clicking the file name in the 
Files list. 

Removing MIDI Files from the Playlist 

To remove MIDifile(s)from the playlist: 

1. Select the MIDI file(s) from the Playlist. 

2. Choose Remove. 

Choose Clear to remove all MIDI files from the Play list. 

Selecting MIDI files from the Playlist 

You can select multiple MIDI files for previewing, adding, or removing 
by holding down the CTRL or SHIFf key while you choose them: 

•:• Pressing CTRL allows you to randomly select the MIDI files. 

•:• Pressing SHIFf allows you to select a group of adjacent tracks when 
you select the first and last MIDI file in the group. 

6-34 Windows Applications 



Rearranging MIDI Files in the Playlist 

If you are not in shuffle mode, you can rearrange the MIDI files in the 
playlist in the order you like using the right mouse button. (In shuffle 
mode, MIDI files in the play list are randomly arranged and played.) 

To rearrange a MIDI jlle in the play list: 

1. Click and hold down the right mouse button on the MIDI file in the Play list 
and drag it to the new position. 

The MIDI file moves to the new position and the preceding MIDI files are 
rearranged following it in the Playlist. 

NOTE If you are in shuffle mode, rearranging the order does not change the 
playing order of the MIDI files. 

Naming the Playlist 

Once you have compiled your playlist, you may want to give the play list 
a title. 

To give your playlist a title: 

1. Choose Save As. The New Collection dialog (Figure 6-22) displays. 

New Collection 

.Enter a new collection name : 

OK I I Cllncel 

FIGURE 6-22: New Collection dialog 

2. Type the title of the playlist in the dialog. 

3. Choose OK. 

If you choose Cancel, you are returned to the Play list dialog without saving 
the title. 
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Using the Keyboard 

You can use the keyboard to perform operations from EnsembleMIDI. 

Key 

A 

B 

CTRL+D 

F 

Fl 

G 

H 

I 

K 

L 

M 

N 

0 
p 

s 
SPACEBAR 

T 

w 
Oto9 
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Action 

Pauses the MIDI file. 

Plays the previous MIDI file. 

Changes the touch-sensitive display. 

Plays the next MIDI file. 

Activates on-line help. 

Activates the graphic slider. 

Activates shuffle mode. 

Activates introduction mode. 

Rewinds the MIDI file. 

Invokes the playlist. 

Activates repeat mode 

Minimizes EnsembleMIDI to an icon. 

Quits EnsembleMIDI. 

Plays the MIDI. 

Stops the MIDI. 

Confirms selection. 

Activates the two-digit mode selector. 

Fast-forwards the MIDI. 

Selects MIDI files. 
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Seven 

Creative Soundo'LE 

Creative Soundo'LE records and plays both compressed and 
uncompressed sound files. Soundo'LE allows you to insert sound files 
into other applications by linking and embedding (OLE). For more 
information on OLE, refer to your Microsoft Windows manual. 

Starting Soundo'LE 
To start Soundo'LE: 

1. Double-click the Soundo'LE icon in the Sound Blaster 16 group window. 
The Soundo'LE window (Figure 7-1) displays . 

Soundo'LE - FANFARE.WAV II 
file .E.dit .Qptions 8bout 

Length of 

~ Icon wa ve fil e -

Current 
position 

Slider ~ 

Play Rewind Stop 

Pause Forward Record 

FIGURE 7-1: Soundo'LE window 
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Button 

Play 

Pause 

Reverse 

Forward 

Stop 

Record 

What it does 

Plays the sound file . 

Pauses the playback of the file. You can click either the 
Pause button or the Play button to resume playing the file. 

Moves toward the beginning of the file a step at a time. 

Moves toward the end of the file a step at a time. 

Stops the playback of the file. 

Records a new sound file. For more information, see 
"Recording a Sound File." 

To use the keyboard to press the buttons, use the TAB key to select a 
button, then press the SPACEBAR to initiate the action. 

Opening a Sound File 

You can open files in Soundo'LE identified by the file name extension 
.WAY. 

To open a soundfile: 

l. Choose Open from the File menu. The File Open dialog displays: 

FileName; 

li~:!! 

I 
chorgex.wov 
chimes .wov 
cho rd.wav 
ding .we.v 
fonlore.wov ! todo.wov 

File Open 

Q.iredories: 

c:\windows 

e c:\ 
~ windows 
LJ e.pw_dota 
LJ osw_doto 
LJ system 
CJ temp 

Ust Files of Iype: Dr~es: 

lsoundo'LE r .WAVJ I ~I lr.::lii~c=, ----I"'! I 

OK 

Con eel 

l'loy I 
I 

I W~Fkfc.Nl -- ---' 

'WavefleS!le 

FieOate&Tine: 

FIGURE 7-2: File Open dialog 

2 . Select the file you want from the File Name list, then choose OK. The 
name of the file appears in the title bar at the top of the Soundo'LE window. 
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Playing a Sound File 
To play a sound file: 

1 . Open the file you want to play. 

2. Click the play button. 

3. To stop playing the sound file , click the stop button. 

Recording a Sound File 

You can make a sound recording from: 

•!• Microphone plugged into Sound Blaster 16 

•!• Device such as a cassette or CD player connected to the line-in jack 

•!• CD-ROM drive 

Soundo' LE saves the recording to your hard disk; the size of the 
recording you can make depends on the amount of space available on 
your hard disk. 

The higher the audio quality the more space the recording requires on 
your hard disk. As a rule of thumb, a 16-bit recording consumes space at 
twice the rate of an 8-bit recording; a sample rate of 22 kHz requires 
twice the space as an 11 kHz sample rate. As an example, recording at 
settings of 16 bits and 44 kHz requires four times the storage space as 
recording at settings of 8 bits and 22 kHz. 

Compression: INane 

ktrncel 

Sample Rate: 

Q BkHz 

O n kHz 

0 22 kHz 

I :hl @44kHz 

FIGURE 7-3: Recording Settings dialog 
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To record a sound file: 

1. If there is a sound file currently open, choose New from the File menu. 

2. Choose Recording Settings from the Options menu. The Recording 
Settings dialog (Figure 7-3) displays. 

3. Select the settings you want to use: 

Record In: 

Sample in: 

Mono 

Stereo 

8 bits 

User for monaural recording (for example, voice 
recording using a single microphone). 

Use for stereo recording (for example, tape 
cassette or CD). 

Use for normal recording. 

16 bits Use for high-quality recording. 

Sample Rate: 11 kHz Suitable for voice recording. 

22 kHz Equivalent to the quality of AM radio; suitable for 
voice or low-quality musical recording. 

44 kHz Equivalent to the quality of a compact disc; with 
16-bit sample-in, suitable for musical recordings. 

Compression: None Records without compressing the sound data. 

NOTE 

ADPCM Adaptive Differential Pulse Code Modulation 
(ADPCM) is a 16-bit compression technique. The 
compression is 4 to 1 for 16-bit files and 2 to 1 for 
8-bit files. 

CCITT Follows the CCITI standard for compression. The 
A-Law level of compression is 2 to 1. 

CCITT Follows the CCITI standard for compression. 
J.L-Law The level of compression is 2 to 1 . 

. '"-,,,,• 

The differences between CCITF A-Law and CCITF J.L-Law are subtle. 
Experiment with them to see which one you prefer. 

',, '1:~;··,-.·,: ' 

4. Choose OK to return to the Soundo'LE window. 

5. Choose the Mixer Settings from the Options menu to make sure the 
appropriate settings are correct. (For information about how the mixer 
works, see Chapter 4, "Creative Mixer.") 
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NOTE If the Creative Mixer is currently active, you can use it for mixing 
multiple audio sources in Soundo 'LE. 

6. Cue up the source if necessary. 

7. Click the Record button. The Recording display appears 
showing you the progress of the recording. 

Recording in progress: 

Data format: Stereo/16 bits /44 kHz 

Compression format: None 
Data size: 1653572 bytes 

Time recorded : 9 seconds 

9% 

FIGURE 7-4: Recording display 

8 . Choose Stop to end the recording. The length of the recording is shown 
below Total on the Soundo'LE window. For information about saving the 
new file, see "Saving a Sound File" later in this chapter. 

You may record or playback compressed wave files using Soundo'LE, 
however, the loudness indicator is not updated for compressed files. 
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Linking and Embedding 
Sound Files 
When you use Soundo'LE to link or embed a sound file in a document, 
you can start Soundo'LE from inside the document. You can link or 
embed a sound file in a document only if the application used to create 
the document supports object linking and embedding. (For details on 
linking and embedding, see the Microsoft Windows User's Guide.) 

Embedding copies a sound file and makes the copy part of the document. 
The embedded file is physically separate from the original sound flle. If 
you make changes to the embedded file, the original is not affected. If 
the document is copied to another computer, an embedded file is 
included in the copy. 

Linking places a pointer in the document. The pointer gives the name of 
the sound file and its location. Any change you make to the sound file 
affects the original. If the document containing a linked sound file is 
copied to another computer, the sound file must be located in the same 
directory path as the original in order to properly link to the copy. 

Embedding a Sound File from Soundo'LE 

To embed a sound file starting from Soundo'LE: 

1 . Open the sound file you want to embed, or create a new one. 

2. From the Edit menu, choose Copy Sound as an Object. A copy of the 
sound file is placed on the clipboard. 

3. Start the application that created the document in which you want to embed 
the sound file, then open the document. Place the cursor at the point at 
which you want to embed the sound file. 

4. Choose Paste from the application's Edit menu. 

7-6 

A Soundo'LE icon is placed in the document to indicate that a 
sound file has been embedded there. To play the embedded 
sound file, double-click the Soundo'LE icon. 
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Embedding a Sound File from 
the Target Application 

To embed a sound file in the document currently open: 

1. Open the document in which you want to embed the sound file. 

2. Choose the menu command in the application that lets you embed an object 
in a document. (For example, in Write, choose Insert Object from the Edit 
menu; in Word for Windows, choose Object from the lnsett menu.) The 
Insert Object dialog displays. 

PowerPoint Presentation ~ PowerPoint Slide 
Sound 1--

OK 

CanceiJ . . . 
Word Document "' 

FIGURE 7-5: Insert Object dialog 

3. Select Soundo'LE and choose OK. The Soundo'LE window appears. 

NOTE If Soundo'LE does not appear on the list, it means it has not been 
registered properly as an OLE application. See Windows online help 
for the Registration Information Editor (REGEDIT.EXE.) 

4. Open an existing sound file, or record a new one. 

5. From the Soundo'LE File menu, choose Exit & Return to application. 

A Soundo'LE icon appears in the document to indicate that a 
sound file has been embedded there. To play the embedded 
sound file, double-click the Soundo'LE icon. 

Embedding a Sound File Using Drag-and-Drop 

To embed a sound file using drag-and-drop: 

1. Open Soundo'LE and the application. Position the Soundo'LE and the 
application windows so that both are in view. 
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2. In Soundo'LE, open the wave file that you want to embed in the application 
document. Alternatively, you can create a new recording before you 
include it in the document. 

Soundo'LE displays its icon when a wave file is opened; no icon is 
displayed if there is no available wave file. 

3. Open a document in the application. 

4. Use the mouse cursor to select the Soundo'LE icon. Holding the mouse 
button down, drag the icon to the document. 

Ill Soundo'LE - FANFARE WAV II Write - (Untilled) 

,Charac ter f:a ragraph .D.ocument 

Introduction 

~ 
FANFAAEWAV 

Welcome to Soundo'LE 
In thiS sectJOn, you Will learn to drag~ and~ drop wave f1tes from 
Soundo'LE to an application document 

.. 
FIGURE 7-6: Drag-and-drop icon from Soundo'LE window to application 

document 

5. Release the mouse button to place the wave file in the document. 

Linking a Sound File 

To link a sound file to a document: 

1. Open the sound file you want to link, or create a new one. 

2. From the Edit menu, choose Copy Sound as an Object. A copy of the 
sound file is placed on the clipboard. 

3. Start the application that contains the document in which you want to link 
the sound file, then open the document. Place the cursor at the point at 
which you want to link the sound file. 

4. Choose Paste Link from the application's Edit menu. A 
Soundo'LE icon appears in the document to indicate that a 
sound file has been linked to it. 

To play the linked sound file, double-click the Soundo' LE icon. 
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Saving a Sound File 
To save a sound file: 

1 . Choose Save from the File menu. If you have named and saved the file, 
Soundo'LE saves the changes. If you are saving the file for the first time, 
the Save As dialog displays: 

Filefiome 

Iii!!! 

D 
D,irectones 

c\sb16\w~nappl 

IC>c:\ 
esb16 
~wincppl 

List File• ol Iype Or¥!s: 
lsoundo'LE("'WAVJ !:1:1 i';i;jliiJO"~:.:...._ __ ------r.lli) 

l!K I 
CMcel I I 

FIGURE 7-7: File Save As dialog 

2. Select the directory in which you want to save the file , give it a name, then 
choose OK. Soundo'LE saves the file. 

Quitting Soundo'LE 
To quit Soundo'LE: 

1. Choose Exit fmm the File menu. The Soundo'LE window closes. If you 
have made changes to a sound file that you have not saved, a message 
appears that asks if you want to save the changes. 

Soundo'LE 

(!) File is changed. Do you wish to save it? 

2. Choose Yes if you want to save the changes, or choose No to discard the 
changes and quit Soundo'LE. 
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Soundo'LE Menus 
File Menu 

New 

Open 

Save 

Save As 

Exit 

Edit Menu 

Copy Sound as 
an Object 

Options Menu 

Wave Info 

Mixer Settings 

Recording 
Settings 

About Menu 

About 
Soundo'LE 
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Description 

Removes the current sound file from memory so you can 
record a new wave form; you are prompted if the current 
sound file has unsaved changes. 

Displays the Open dialog for opening an existing sound file. 

Saves the sound file. 

Saves the sound file with a new name. 

Quits Soundo'LE. 

Description 

Makes a copy of the sound file and places it on the clipboard. 
You can then embed or link the sound file to a document 
from any application that supports OLE. 

Description 

Displays information about the current sound file. 

Displays the Sound Blaster 16 Mixer so you can adjust the 
settings that control volume, tone, gain, and source. 

Sets the recording mode (mono or stereo), sample size (8- or 
16-bit), sample rate, and compression. 

Description 

Displays the version number of Soundo'LE you are using 
and the application's copyright information. 
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Eight 

Creative Mosaic 

Creative Mosaic is a tile game that challenges your mental agility . You 
must analyze the tile locations and plan your moves carefully in order to 
arrange them in correct numerical order or complete the image. You can 
change the skill level and customize the image. 

Starting Mosaic 
To start Mosaic: 

1. Double-click the Creative Mosaic icon in the Sound Blaster 16 
group window. The Creative Mosaic game board (Figure 8-1) is 
displayed: Mosaic 

Starts game and shuffles 
image or restarts game 
and reshuffles image 

Tums game sound orv'off 

13 

FIGURE 8-1: Mosaic window 

15 

Totals number of moves 

Exits Mosaic 

11 

14 10 
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2. Choose the number of tiles from the Size menu. The choices give the 
dimensions, such as 4x4 for a 16-tile puzzle. 

3 . Choose a level from the Skill menu. (The higher the skill level, the more 
the tiles are shuffled.) 

4. From the Options menu, choose to play with numbered tiles or a picture. 

If you choose Picture from the Options menu, a dialog lists pictures you can 
choose for Mosaic. (You can use any image having a file name extension 
of .BMP, .DIB, or .RLE.) 

When you choose a picture rather than numbered tiles, you can choose 
Hints from the Help menu to display the complete picture next to the puzzle 
grid. 

5. Click the Start button to scramble the tiles and begin the game. 

Playing Mosaic 
In a grid with numbered tiles, the objective is to arrange the tiles in the 
correct numeric sequence. You arrange the tiles by moving them around 
the grid. A move is made by clicking a tile adjacent to the empty 
square-the tile on which you click moves into the vacant square. You 
continue repositioning the tiles until you have successfully arranged the 
tiles in numeric sequence. 

Creative Mosaic a 
~ize SJ<,i ll .Qptions J:!elp 

7 

10 11 12 

13 14 15 

FIGURE 8-2: Creative Mosaic with numbered tiles, 4x4 grid, in sequence 

In a grid with picture tiles, the objective is to arrange the tiles so that the 
image is correct. To select a bitmap image, choose Picture on the 
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Options menu-the Open dialog is displayed to allow you to select a 
picture file . You can use any bitmap image file having the file name 
extension of .BMP, DIB, or .RLE. 

The image puzzle includes an option on the Help menu, Hint, that allows 
you to display the completed image alongside the scrambled tiles, see 
Figure 8-3 . 

FIGURE 8-3: Creative Mosaic with picture tiles, 4x4 grid, and completed 
picture in Hints window 

The four-digit counter in the upper right comer of the game board counts 
the total number of moves during the current game. 

Each move on the board is accompanied by a sound. 
If you do not want sound, select this icon- a finger 
appears to plug the ear. When sound is active, a 
musical note appears with the ear. 
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Exiting Mosaic 
To quit Mosaic: 

1 . Click the Exit button. 

The Creative Mosaic window disappears from the screen. 

Mosaic Menus 
Size Menu 

Displays available sizes, in number of tiles, for Mosaic: 
3x3 
4x4 
5x5 
6x6 
7x7 
8x8 

Skill Menu 

Displays the list of skill levels from which you can choose: 
Beginner 
Intermediate 
Advanced 

Options Menu Description 

Number Displays numbered tiles. 

Picture Displays a picture broken up into tiles. 

Help Menu Description 

Mosaic Help Displays the list of topics for which you can get on-line help. 

Hints Displays the completed picture you are trying to reconstruct. 

About Displays the version number of Mosaic you are using and the 
application's copyright information. 
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Nine 

Monologue for Windows 

Monologue for Windows allows you to add the element of speech to 
virtually every Windows application: 

•!• Any application that can express data as text can have that data 
spoken. 

•!• Data transferred to the clipboard can be spoken, or the DDE or DLL 
interfaces can be used to customize spoken data from your Windows 
applications. 

•!• Resource management ensures that Monologue for Windows can 
work with even your most memory-intensive Windows applications. 

•!• You can use your ears to assist you in providing an extra degree of 
confidence in data entry/retrieval-your data is read exactly as it is 
entered or retrieved. 

•!• A software approach eliminates the need for additional hardware. 

To fully utilize Monologue for Windows, you must understand its basic 
concepts. Familiarize yourself with the information in this section and 
refer to it before using Monologue for Windows' more advanced features. 
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Uses of 
Monologue for Windows 
Monologue for Windows' is the perfect addition to many of your 
Windows applications. Your applications can use spoken data to 
improve productivity and efficiency during hand-eye coordination tasks: 

•!• Speech can be added to your Windows applications such as Ami Pro, 
Word for Windows, and Excel. 

•!• Monologue for Windows' easy-to-use interface makes it readily 
available to all users. 

•!• Proofreading of text and data can be improved by having Monologue 
for Windows read data as you compare it to the printed version. You 
can select a row, column, paragraph, or total document to be read. 

•!• You can add Monologue for Windows speech capability to enhance 
word processing, the use of spreadsheets, electronic mail, etc. 

•!• Important parts of speech or grammar are often incorrectly used or 
accidentally omitted in a document. Hearing the document spoken 
can be an invaluable aid in ensuring it is grammatically 
correct-your ears assist your eyes in proofreading the document. 

•!• Your computer can read any document while you perform other 
activities. For example, use Monologue for Windows to read your 
electronic mail while you perform other tasks. 

•!• Programmers can make calls to the DLL interface, and define 
macros to interface with either the DOE or DLL to interface with the 
speech engine. You can, for example, have Monologue for 
Windows locate and read a spreadsheet value that changed as the 
result of a formula value change. 

•!• Programmers can add speech by interfacing with the programming 
tools used to create Windows applications. Monologue for Windows 
technology allows you to call the speech engine as a Windows 
function (see "Programming with Monologue" later in this chapter). 
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•!• Monologue for Windows allows you to select the pitch, speed, and 
volume at which selections are spoken. The Dictionary Manager 
allows you to save preferred pronunciations in several dictionaries; 
you may select any one as the active dictionary. 

Multimedia Extensions Environment 

Monologue for Windows uses the capabilities of Sound Blaster 16 with 
Multimedia Extensions for Windows. This configuration provides 
optimal functionality with hardware independence, coordinated 
allocation of system resources, and time synchronization capabilities. 

Using Monologue for Windows with Multimedia Extensions for 
Windows requires: 

•!• Standard PC environment plus properly installed and configured 
Windows 3.1 or Multimedia Extensions for Windows 3.0. 

•!• Properly installed and configured Sound Blaster 16. 

NOTE 
m;,+,;;.;t.t:~:i<11;r1fi!l1Wm;,Tilllf~~;Fltt';lrur.W!tJllt'Jjj1J'l!!r~IW'li:~;liJt.JlJ11Jlli:i::J!!ITk'lffDT<::::';JU:mm-..~!!1;1&1ml.WJ..mlltiil~~'l.:!l!'~tt 

Documentation and software in this release of Monologue for 
Windows precede the general availability of the Multimedia 
Extensions for Windows. While efforts have been made to assure that 
the software functions properly with the release version, it is possible 
that changes may render Monologue for Windows inoperative. 
Contact First Byte for an updated version of the drivers and libraries. 
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Speech Generation 
Techniques 
The two commonly used techniques for generating speech are: 

•!• Table-based: Each word is stored in both a text version and a sound 
version. A search is performed to locate the text version and the 
corresponding sound is spoken. 

•!• Rule-based: No text is stored and no voice recording is necessary; 
rules are used to convert text to speech. The rules, or sound 
descriptors, are converted to digital patterns that you hear as speech. 

How Monologue for Windows Works 

Monologue for Windows generally uses the rule-based method to 
generate speech, and can pronounce each word it encounters. However, 
English words that do not follow the rules are often mispronounced. For 
this reason, Monologue for Windows uses the table-based method for 
exceptions. You can enter your own exceptions that do not follow the 
phonetic rules or pronunciation by using the Dictionary Manager. 

Monologue for Windows has three distinct modes of operation: 

•!• Clipboard 

•!• Excel 

•!• DOE Server 

Clipboard Mode 

When Monologue for Windows is in Clipboard mode, all text input is 
spoken from the Windows clipboard. The clipboard is an area in 
memory in which data can be placed and later read by the same or 
another application. 

Clipboard mode is the default mode of operation for Monologue for 
Windows. Data can be placed on the clipboard by selecting the data, 
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then choosing the Copy command. This command is located on the Edit 
menu of most Windows programs. When Monologue for Windows 
receives the command to begin speech, the contents of the clipboard are 
retrieved, converted to speech, and speech output begins. 

Excel Mode 

When Monologue for Windows is in Excel mode, input data is extracted 
from the current Microsoft Excel. This mode bypasses the process of 
copying the selected data from the application to the clipboard. In this 
mode, the currently selected cells are retrieved from Excel when 
Monologue for Windows receives the command to begin speech, the data 
is converted to speech, and speech output begins. 

DDE Server Mode 

When Monologue for Windows is in DDE Server mode, all input data is 
extracted from the DDE message stream. This advanced capability 
allows various macro languages to initiate a DDE conversation with 
Monologue for Windows. Once a conversation is initiated, Monologue 
for Windows speaks any data sent to it by the other application. 

Applications Using Monologue for Windows 

Monologue for Windows is capable of speaking any text that is made 
available to it through any of the mechanisms described above. This 
means that it works with any application that has the ability to place data 
in text format on the Windows clipboard or any application that has the 
ability to initiate a DDE conversation. Once installed, the speech 
capability is available whenever you want it. 
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Getting Started 
To run Monologue for Windows, complete the following steps: 

•:• Make a backup copy of the Text-to-Speech disk. 

•:• Install Monologue for Windows using the INSTALL program. 

•:• Start the speech interface. 

Disk Backup 

Make a copy of your original disk. To copy the disk, start the Windows 
File Manager and use the Copy Disk ... command from the Disk menu. 
Alternately, you may use the DOS command DISKCOPY. Consult 
Windows on-line help or refer to your Microsoft Windows manual. 

Using the INSTALL Program 

The Text-to-Speech disk contains a program, INSTALL, to install 
Monologue for Windows, SBTalker, and Talking Scheduler on your 
system. The installation program requires Windows; if you have not 
started Windows, do so before proceeding. To start the installation 
program, insert the disk in the disk drive and use the Run ... command 
from the Program Manager's File menu. Enter the drive letter and name 
of the install program-for example, A:INSTALL-and press the 
ENTER key. 

The installation program recommends a configuration for your system. 
You may override the recommendation by making an alternate choice as 
offered by the INSTALL program. After the installation is complete, the 
INSTALL program creates a Monologue for Windows program group. 
This step occurs only if you are using the Windows Program Manager. 

NOTE 
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If you are installing the standard environment for Monologue for 
Windows, you may be presented with a dialog alerting you to restart 
Windows. Failure to restart Windows at this point may result in 
unpredictable behavior of Windows. 

Exit Windows-immediately restart Windows. The installation 
procedure installs the driver Monologue for Windows requires to access 
the system hardware when running in 386 Enhanced Mode. If you are 
not running in enhanced mode, the message does not appear. 

Using a RAM Disk 

If you are running Monologue for Windows from a network file server, 
the slower disk access times may result in either excessive latency as the 
speech data is being constructed or output occurring in a halting, broken 
cadence. If your system is equipped with enough memory, you may find 
that devoting a small portion of that memory to a RAM disk substantially 
improves performance. For best results, be sure to use the 
RAMDRIVE.SYS utility provided with Windows or another 
Windows-compatible RAM disk utility. 
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Using 
Monologue for Windows 
The operation of Monologue for Windows is divided into two steps: 

•!• Starting Monologue for Windows 

•!• Converting text/data to speech 

Starting Monologue for Windows 

Double click the Monologue for Windows icon to start the speech 
interface. The Monologue for Windows screen is displayed. You may 
make selections for Speed, Pitch, Volume, and Mode. The operational 
mode selection is very important-it determines the mechanism used for 
speech requests. The selection must be correct for the type of work you 
will be doing. 

= Monologue for Windows a 
Volume: 

lit' ';ii':;)i~. ' ·.f:ii:cliJ3I:il ~ 
Speed: 

ljil,,;~;;;.sc··q:"it:!I:~Jf,;~::;\lll&~il!l @] 

Mode----, 

OExcel 

®Clipboard 

Pitch: 0 DDE Server 
ld ..• 1,3;j;~;J,,,;t~;~i'i:~i\l!l II] L--------' 

FIGURE 9-1: Preferred Speech dialog 

Refer to "How Monologue for Windows Works" earlier in this chapter 
for help in selecting the correct operational mode. At any time, you may 
hear the results of the current settings by pressing the Sample button. 
Once you are satisfied with the settings, press the OK button. This saves 
the current settings as the defaults and makes your selections active. 
Pressing the Cancel button restores the settings to the last saved values. 

NOTE Changes do not become effective until the OK button is pressed. 
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If your use of Monologue for Windows does not require frequent setting 
of the Volume, Speed, Pitch, and Mode, start Monologue for Windows 
as an icon automatically when Windows loads. This can be 
accomplished by modifying the "LOAD= " line in your WIN.INI file. If, 
on the other hand, you wish to start Monologue for Windows as a 
window, modify the "RUN=" line in your WIN.INI file. In either case, 
append "C:\MONOLOGW\MONOLOGW.EXE" to the appropriate line 
of the WIN .INI file. 

NOTE 
j;,"mtil:lll~~~l~\lllJ~Jr~~~'lU!l*1mlll:!ffi:1:mi1W'lmr;:Jli1!~r;li!lm!ll"a~~-"Jf0 

The example above assumes that the Monologue for Windows 
program files are located on drive C: in the MONOLOGW directory. 
Use the correct drive system. 

Before going any further, perform the following simple checks to make 
sure your hardware and software are functioning properly together: 

•:• Restart Windows and start Monologue for Windows as the only 
Windows application and press the Sample button. If you are able to 
hear the "Testing: 1, 2, 3" message, it is safe to assume that the 
installation of Monologue for Windows is correct. 

•:• If, on the other hand, either no output was heard, or the program or 
Windows failed, it is likely that the installation options were chosen 
incorrectly: 

• If your system is running Windows with the Multimedia 
Extensions, you must not have installed Monologue for 
Windows using either the Sound Blaster or Standard 
Environment options. 

You can determine whether your system is equipped with the 
Multimedia Extensions by starting Windows and observing 
whether the Windows logo screen includes the line "Windows 
3.0 with Multimedia Extensions." If this message displays, you 
must install Monologue for Windows using the Multimedia 
Extensions Environment option. 

• If your installation options are in error, simply run the INSTALL 
program again, making the correct selections. 
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Once Monologue for Windows has been configured, you can reduce its 
icon by either: 

•:• Pressing the minimize button; the minimize button is the small box 
with the downward pointing arrow in the upper right comer of the 
Monologue for Windows window. 

•:• Selecting Minimize from the Monologue for Windows System menu. 

Monologue for Windows is reduced to an icon and is available for use. 

Converting Text/Data to Speech 

Identify the Data 

In most applications, you can use the mouse to identify the data to be 
read: 

1 . Place the pointer/cursor on the data at the point you want to begin speech. 

2. Mark the text by moving the mouse while holding down the left mouse 
button. 

The selected data is highlighted. 

(Some applications use different methods to select a data block-consult 
the application's documentation.) 

Make the Data Available 

If you have selected Clipboard mode, you must copy the selected data to 
the Windows clipboard. In most cases, this is done by using the Copy 
command from the application's Edit menu. Your application may have 
a different method for performing this step. Consult your application's 
documentation for specific information. 

If you have selected Excel mode and your data selection has been made 
within an Excel spreadsheet, you can skip this step. Note that Excel 
mode is only designed for use with Microsoft Excel and, when 
Monologue for Windows is in this mode, only data selected from the 
current Excel spreadsheet is spoken. 
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Command the Data to Be Spoken 

Move the mouse cursor to the Monologue for Windows icon. Press the 
right mouse button to start speech. Once speech output is complete, 
control is returned to your application. 

Applications that run maximized use the full screen by default, obscuring 
the Monologue for Windows icon. To access Monologue for Windows, 
resize the application window to uncover the icon. 

Steps for Clipboard Use 

When Monologue for Windows is in Clipboard mode, the content of the 
Windows clipboard can be converted to speech. However, if you are 
running Excel, Clipboard mode speaks the current selection within 
Excel. You must be in Clipboard mode to speak text from applications 
other than Excel-use Excel mode only when Microsoft Excel is the 
primary Windows application from which speech will be used. 

To use Clipboard mode: 

1 . On the Monologue for Windows dialog, select Clipboard mode. 

2. Open the application and select the data. 

3. Select Copy on the Edit menu to place the data on the Clipboard. 

4. Click the right mouse button over the Monologue for Windows icon to have 
the Clipboard data spoken. 

Steps for Excel Use 

The Excel mode is provided as a convenience to users whose primary 
Windows application is Microsoft Excel. Excel mode does not require 
that you copy the selected data to the clipboard. However, to use 
Monologue for Windows with Excel and other applications, you need to 
switch between Clipboard and Excel modes. 

When Monologue for Windows is in Excel mode, the contents of the 
Windows clipboard are not evaluated. However, if Excel is running 
Monologue for Windows, the current selection within Excel is spoken no 
matter what the mode. This may lead to confusion and speech output 
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that was not intended. For this reason, Excel mode should only be used 
when Microsoft Excel is the primary Windows application for which 
speech is used. 

To use Excel mode: 

1 . On the Monologue for Windows dialog, select Excel mode. 

2. Open an Excel worksheet and mark the cells. 

3. Click the right mouse button over the Monologue for Windows icon to have 
the Excel data spoken. 

Steps for ODE Server Use 

To use DDE Server mode: 

1 . On the Monologue for Windows dialog, select DDE Server mode. 

2. Start the application that is to be the DDE Client. 

3. Run the macro or script that initiates the DDE conversation. 
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Programming with 
Monologue for Windows 

Monologue for Windows provides both DDE and DLL programming 
interfaces. Using these interfaces, you can easily add the power of 
speech to your own or existing Windows applications. The application 
must provide a mechanism for either DDE messaging or DLL calls. 

Select the interface that meets your requirements and the capabilities of 
your programming environment. Generally, the DLL interface provides 
the fastest, most reliable link to Monologue for Windows speech. While 
Windows programming is beyond the scope of this manual, the 
following may help you select the most appropriate interface for your use. 

DDE Speech Example 

The Monologue for Windows DDE Server interface allows applications 
to initiate a DDE conversation and send data to Monologue for Windows 
for speaking. The DDE Server acts as an agent for the DDE Client 
application. The following table demonstrates a conversation between a 
DDE Client application and the Monologue for Windows DDE Server. 

DDE Client Direction DDE Server 
DDE Initiate (Client seek > 
conversation) 

<= DDE Acknowledge (conversation 
starts) 

DDE Poke (data is sent to server) > 
<= DDEAcknowledge (speech begins) 

DDE Terminate > 
<= DDE Acknowledge (conversation 

ends) 

To initiate a conversation, the client must supply an application name 
and topic. This information is used to locate the appropriate Windows 
application. Monologue for Windows uses the application name 
MONOLOG and the topic TALK. 
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Once the conversation begins, Monologue for Windows speaks any data 
received in subsequent DDE poke messages. When the client is finished, 
it sends a DDE terminate message to signal the end of the conversation. 

Creating Macros 

If your frequently used Windows applications provide a macro language, 
you can create macros to perform the task of speaking selected text. 
Using either the DLL or DDE interfaces, you can create macros that 
eliminate the need to locate the Monologue for Windows icon. This is 
handy for applications that usually operate in full-screen mode. 

The following Ami Pro 1.2 macro illustrates the steps to initiate, 
maintain, and terminate a DDE conversation: 

FUNCTION DDESAY() 
'Macro demonstrating the Monologue DDE interface with Ami Pro. 
child=DDEinitiate("MONOLOG","TALK0 ) 

IF (child=O) 
message("Cannot Initiate DDE Conversation") 
EXIT FUNCTION 

ENDIF 
"Note the space in the Location field. 
'The space is required for some reason. 
DDEPoke(child,"","Ami Pro calling Monologue via DDE link") 
DDETer.minate(child) 
END FUNCTION 

Here is a functionally identical macro for Microsoft Excel3.0: 

A B 
1 Excel calling Monologue via DDE link. 
2 
3 SendChnl SpeakData 
4 =INITIATE("MONOLOG","TALK") 
5 =POKE(SendChnl,"",Bl) 
6 =TERMINATE(SendChnl) 
7 =RETURN() 

While the internal function names will be different for your application's 
macro language, the examples demonstrate the basic characteristics of a 
macro that utilizes the Monologue for Windows DDE Server. 
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DLL Speech Example 

The DLL interface is preferred for adding speech to programs that permit 
calls to external libraries and any personally developed Windows 
applications: 

•:• The interface is much more straightforward and inherently more 
reliable. The DLL interface is a direct call to the Monologue for 
Windows speech engine. The DLL interface is direct to the speech 
engine; Monologue for Windows does not need to be started to 
access the speech engine, thus reducing memory requirement. 

•:• Macros or programs using the DLL interface have the ability to 
control the pitch, volume, and speed values used. Since this is 
accomplished without the intervention of Monologue for Windows, 
changes made in this way are local to the caller and independent of 
Monologue for Windows' settings. 

Macro languages supporting a DLL call need to be given the syntax of 
the function that is to be called. The following C language prototypes 
define the parameters and return values for the speech engine functions: 

int FAR PASCAL Say(LPSTR ZpEnglishString); 

The Say function requires a far pointer to a null-terminated string and 
returns an integer result code. 

int FAR PASCAL SetSayGlobals(int Reservedl, int 
Reserved2, int Pitch, int Speed, int Volume); 

The SetSayGlobals function requires five integer parameters and returns 
an integer result code. Note that the frrst two parameters are reserved for 
future use and must be passed as 0. The other parameters must be 
integer values in the range of 0 to 9. 

The following Ami Pro 1.2 macro implements a DLL call to the speech 
engine: 
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FUNCTION DLLTALK() 
'Macro demonstrating the Monologue DLL interface 
DLLld=DLLLocate("SPEECH.DLL","Say","IC") 
result=DLLCall(DLLld,"Ami Pro calling Say via DLL 
interface n ) 

END FUNCTION 

Note, that in both cases, there is a coded parameter used to defme the 
return type and the parameter type expected by the DLL function. In 
both Excel3.0 and Ami Pro, the codes happen to be the same. Refer to 
the documentation for your application's macro language for the 
appropriate codes. 

NOTE 

. NOTE 

Use of the DLL interface when Monologue for Windows is NOT 
loaded requires that Windows be able to locate SPEECH.DLL. To 
assure this, you may either ( 1) add the drive and directory in which 
the Monologue for Windows files are located to the PATH statement 
in your AUTOEXEC.BAT file or (2) copy the Monologue for Windows 
files to the Windows directory. Placing Monologue for Windows files 
on a shared disk (network) may result in behavior. 

, :·,< .t·, ''" :, ,,~···e"' ,,_., .. ,_.;;···-w~rt'<:~··.~:,.'h\th::E!if!l!f:ll!\t:lU.Jtlli81Jiil~'il'lb~~~*'o-:n;f!-4lllll~tm~NHl~~~;iilif;i;;:;;.tLr; 

C PROGRAMMERS: You may call the speech engine directly by 
simply including the function prototypes included in this section. Be 
sure to add the junctions to the IMPORTS section of your .DEF file. 

Distribution Restrictions 

While you may use Monologue for Windows and the speech engine with 
your developed applications, you may NOT distribute these applications 
for profit or non-profit without securing a Speech Distribution license 
from First Byte. For information, contact First Byte at (310) 793-0610. 
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Using the 
Dictionary Manager 
The Monologue for Windows Dictionary Manager manages the 
Monologue for Windows Exception Dictionary. With this tool, you can 
add, delete, and modify entries in the dictionary while interactively 
trying various combinations of English and phonetic constructs. 

Dictionary Concepts 

Before using the Monologue for Windows Dictionary Manager, it is 
importantto have an understanding of some basic concepts. 

Exception Dictionary 

An exception dictionary consists of English words and a string of 
characters. The character strings are not English, they are phonetic 
strings. Exercise care when manipulating phonetics since they are a 
defined set of characters that cannot necessarily be strung together in an 
arbitrary sequence. When you supply the Dictionary Manager with a 
Sounds Like string that is composed of misspelled English, the string is 
converted to phonetics prior to storage. See "First Byte Phonetic Codes" 
later in this chapter for a list of the valid phonetic codes and modifiers. 

~ Monolo9ue ExceptiOn Dl( t10nc;~ry- UNTITLED DIC ~~ 

English Word: fl l S;;ij&r!gll~!l~ord 
~----------------~ 

Sounds Uke: 

Dictionary Contents 

~gg~:~~IED ~. r~1li~\~~ 
:g~~~TE I l;::'!:c~~~t.W::~:. I ACTIVE 
~:~g~~:~t=~~----------~*~l~s=:'r='~:~~~:~;~=:·=··=·"=··~ 

FIGURE 9-2: Exception Dictionary dialog 
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File Options 
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Kernel Dictionary 

Monologue for Windows uses both the rules and tables to convert 
English text into phonetic codes. The kernel dictionary holds the table of 
words commonly used in English that the rule system does not convert 
correctly to phonetic codes. In addition, the kernel dictionary is the 
repository of words that contain special stress codes for improved 
naturalness of output. The kernel dictionary is located in the file 
KERNEL.DIC. All dictionaries are based on the master dictionary, its 
contents should not be modified or deleted-making changes to the 
master dictionary is not recommended. 

Active Dictionary 

As the speech engine is loaded, it looks for and loads a dictionary file. 
By default, this is KERNEL.DIC. The Dictionary Manager allows you 
to specify your own dictionary. The dictionary you specify becomes the 
active dictionary until another selection is made. 

Starting the Dictionary Manager 

Start the Dictionary Manager by double-clicking on its icon in the 
Monologue for Windows program group. Upon startup, the Kernel 
Dictionary is loaded as the basis for a new dictionary. 

Browsing the Dictionary 

The list box on the left side of the window allows you to browse through 
the entries in the dictionary. Selecting a word from the list box causes it 
to be placed in the English Word edit frame and its phonetic string is 
placed in the Sounds Like edit frame. 

Finding an Entry 

Enter the word you want to find in the English Word edit frame. Click 
Find Entry to find the word in the current dictionary file. If the word is 
found, it is displayed in the English Word edit frame and its phonetic 
string is displayed in the Find Entry edit frame. 
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Editing an Entry 

You can change the pronunciation of a word in the English Word edit 
frame by selecting the Insert Entry button. Double click on the word in 
the Dictionary Contents list. The word is displayed in the English Word 
edit frame and the begin/end symbols for the word's phonetic string are 
displayed in the Sounds Like edit frame. Use the tables in "First Byte 
Phonetics" at the end of this chapter to complete the phonetic string. 

Testing an Entry 

You may test the pronunciation of a selection by pressing either the Say 
English Word or Say Sounds Like button. Say English Word causes the 
word to be pronounced based on the rules table. Say Sounds Like causes 
the phonetic string to be pronounced. 

Adding an Entry 

If a word is not found in the dictionary, you can add it by typing the word 
in the English Word edit frame. Select the Say English Word button to 
hear the word spoken from the rules table. 

The word's phonetic string can be created in the Sounds Like edit frame. 
Once you are satisfied with the Sounds Like entry, add the word to the 
dictionary by pressing the Add Entry button. 

Deleting an Entry 

A word can be deleted from the dictionary by pressing the Delete Entry 
button when a dictionary entry is in the English Word edit frame. An 
entry may be brought into the edit frame by either using the Find Entry 
button or by selecting the word from the dictionary list box. 

Saving Your Work 

You can save changes to your dictionary by pressing the Save Dictionary 
button. On the File Save dialog, enter the file name in the edit frame or 
select the name of an existing file from the files list. Press the OK button 
to save the dictionary file to disk. 
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NOTE KERNEL.DIC is rejected as a name for your dictionary file. This 
protects the master dictionary from inadvertent changes. 

Setting the Active Dictionary 

Monologue for Windows opens a dictionary file upon loading. The 
Active Dictionary button allows you to choose the dictionary file to use. 
Press the Set Active Dictionary button to display the dialog and select a 
dictionary file. Press OK to load the dictionary file; the file is loaded and 
saved as the dictionary to use the next time Monologue for Windows is 
loaded. 

Loading Another Dictionary 

Press the Load Dictionary button to edit another dictionary file. A File 
Open dialog is displayed from which you can select a dictionary file. 
Press 0 K to load the selected dictionary file into memory. 

Changing Your Mind 

If you find that some of the changes you made to the exception 
dictionary were not satisfactory, you may undo the changes by reloading 
the same dictionary file by selecting the Load Dictionary button. The 
Dictionary Manager does not modify the disk files until an explicit Save 
Dictionary command is given. 

Dictionary File Location 

The Load Dictionary, Save Dictionary, and Active Dictionary options do 
not facilitate saving dictionary files in any directory other than the one in 
which Monologue for Windows was installed. All files related to speech 
generation need to be located in this directory. 

Leaving the Dictionary Manager 

You may exit the Dictionary Manager by selecting Close on the System 
menu. You are prompted to save any changes that have not been written 
to disk at the time you exit the application. 
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Problem Resolution 

The following information should assist you in solving any problems you 
may encounter with Monologue for Windows. 

Common Problems 

PROBLEM: The installation completed successfully but there is no 
apparent way to start Monologue for Windows. 

Cause: The installation program creates a program group only if 
you are using the Windows Program Manager. 

Solution: If you are using another shell program, consult the shell 
documentation for instructions to make Monologue for 
Windows available for execution. 

PROBLEM: No speech is audible but the system does not hang or fail. 

Cause: Your audio hardware volume level is inadequate. 

Solution: Adjust the volume control on the audio card. 

PROBLEM: Speech is audible but pauses occur at intervals. 

Cause: Monologue for Windows is installed on a disk that cannot 
transfer data rapidly enough to maintain audio output. 
Monologue for Windows should not be installed on either 
a floppy drive or a network drive. The transfer rates on 
these devices may not be adequate for maintaining speech 
continuity. 

Solution: Reinstall Monologue for Windows on a local hard drive. 

Monologue for Windows 9-21 



PROBLEM: An audible click occurs at a regular frequency during 
speech output. 

Cause: Your CPU's speed is not quite fast enough to permit 
buffering with a drop-out. This problem occurs most 
often with slower 386 and 386SX systems running in 
Enhanced Mode. 

Solution: Run the system in Standard Mode in which the interrupt 
latency is considerably shorter. 

PROBLEM: Monologue for Windows seems to cause a problem with a 
network connection or serial communications in another 
Windows program. 

Cause: This problem is most frequent when you use the Standard 
Environment option. When this option is selected, all 
other system activity is halted. This can cause serious 
problems for most communication software. 

Solution: Using either the Sound Blaster or Multimedia 
Environments should eliminate this problem. 

PROBLEM: Speech is audible but seems to stutter or hiccup, but 
seems to improve as speech goes on. 

Cause: This problem occurs when any of the following 
conditions exists: 

• Speech resources are not present in memory and the 
disk is unable to keep up with the speech output. 

• Other applications are forcing an excessive amount of 
data movement to and from disk. 

• A marginal memory situation exists. 

Solution: This problem usually fixes itself as the speech engine is 
repeatedly accessed. If you have loaded several large 
applications, close the less frequently used. 
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First Byte Phonetics 
You can edit or create a phonetic string associated with a word in a 
dictionary file. The following example gives the phonetic string for 
primary: 

<<-pr'AY.mEHr-IY>> 

Without the editing, primary is pronounced: 

<<-prEHm'AXriY>> 

The phonetic string is enclosed in double more-than(<<) and less-than 
symbols. The tables below describe the phonetic codes and modifiers 
used by First Byte's Monologue for Windows. 

Phonetic Codes 

The following table lists all the phonemes used by Monologue for 
Windows along with examples of the sound they represent. 

Phoneme Sample Phoneme Sample 

IY beet r red 

IH bit w wed 

IX d~cide b .b.ed 

EH b~t d dead 

AE b.at g get 

AH but v yet 

AX .about DH then 

AA CQt z zen 

UH book ZH U§_Ual 

uw boot f fit 

ow boat TH thin 

ER bird s §.in 

AY bite SH .shin 

EY bait h him 
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Phoneme Sample Phoneme Sample 

OY b~ p pin 

AW bout PX spin 

LX fall t top 

I low TX stop 

m mow ox butter 

n no k kite 

NG sing KX sky 

y )!_es 

Phonetic Modifiers 

In addition to the phonemes listed in the table, the following symbols are 
also supported. 

Symbol 

I 

" 

nn 

Sn 
Vn 

Meaning 

Shorten the phoneme that follows. 

Lengthen the phoneme that follows. 

Increase the pitch by 20 percent. 

Increase pitch by 30 percent and lengthen. 

Increase pitch by 20 percent and lengthen. 

Increase pitch by 30 percent and shorten. 

Target pitch to this level (two digits). 

Set speed to this level (one digit). 

Set volume to this level (one digit). 

The pitch changes are propagated backward so that placing a pitch digit 
at the end of a phrase defines the ending pitch. The pitch change is 
distributed backward to the last pitch target definition. 
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Creative Talking Scheduler 

Talking Scheduler automatically reminds you of appointments you have 
scheduled by displaying the appointment information on the screen and 
by telling you about it. Sound Blaster 16's voice synthesizer tells you 
the time of the appointment, who it is with, and any information about 
the appointment you have entered. You can record your own message 
about the appointment; and you can attach related information to the 
appointment-a copy of a memo, a spreadsheet, or an E-mail message. 

Starting Talking Scheduler 

To start Talking Scheduler: 

1 . Double-click the Talking Scheduler icon in the 
Text-to-Speech group window. 

The first time you start Talking Scheduler, a message appears 

~ 
Scheduler 

telling you that no existing appointments have been found and Talking 
Scheduler is creating a new appointment file. 

2. Choose OK. The Talking Scheduler window appears: 

Main Appointments Help 

FIGURE 10-1: Talking Scheduler window 
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Setting Up Talking Scheduler 

Before you start entering appointments, set up Talking Scheduler by 
selecting the options that meet your needs. 

To set up Talking Scheduler: 

l. Choose SetUp from the Main menu. The Program Defaults dialog appears: 

Program Defaults 

Animation Characters 

• Simon Perkins Igor 

SJJeech: Pitch j6 l!J Sp;;;;J rn 
First Name: 

Auto launch: 

t/ Greeting v Voice 

v Descript. v Objects 

l Ad;;;,;-;;e Notice: 

JMinutes: EJ!I 

FIGURE 10-2: Program Defaults dialog 

2. Choose the settings you want to use: 

• Animation Characters: Choose either Simon, Perkins, or Igor as the 
character you want to appear to announce your appointments. 

• Speech: Click the box next to Speech to hear the voice-synthesized 
speech of the character you have selected. 

You can change the speech settings in the Pitch and Speed boxes: 

• Pitch: A number between 1 and 9. The lowest pitch is 1, the 
highest is 9. 

• Speed: A number between 1 and 9. The slowest speed is 1, the 
fastest is 9. 

• First Name: Type your first name. The animated character uses your 
first name when it announces an appointment. For example, it begins 
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an announcement by saying something like, "Sandra, you have an 
appointment with ... " 

• Auto Launch: Select the elements you want for the appointment 
reminder: 

• Greeting: Your name, time of the appointment, and the person with 
whom you have the appointment. For example, "Martin, you have 
an appointment with Deborah from 9:00a.m. to 9:30a.m." 

• Description: Information about the appointment. 

• Voice: Automatically plays the voice message you recorded when 
you entered the appointment. 

• Objects: Automatically opens any objects-memos, spreadsheets, 
E-mail messages-linked with the appointment announcement. 

• Advance Notice: Sets the announcement of an appointment to happen 
before the appointment's scheduled time. 

3. Choose OK to save the settings you have chosen. The dialog disappears. 
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Running Talking Scheduler 
When Talking Scheduler is running, it is minimized to an icon. The icon 
appearing on the Windows desktop indicates that Talking Scheduler is 
ready to remind you of any appointments. 

To run Talking Scheduler: 

1 . Open the Talking Scheduler window and choose Run from the Main menu 
(or click the Minimize button). The Talking Scheduler window disappears, 
and an icon appears on the desktop. 

To start Talking Scheduler when you start Windows, move 
or copy the Talking Scheduler icon to the StartUp window. Scheduler 

Entering an Appointment 

To enter an appointment: 

1 . Open the Talking Scheduler window and choose Add/Modify from the 
Appointments menu the Make Appointments window appears: 

Today' s date 

Next month ---­

Previous month 

Next year 

Previous year 

FIGURE 10-3: Make Appointments window: Click the mouse button with the 
pointer on the date on which you want to enter an appointment 

2. Click the date for the appointment you want to enter. The window for the 
date appears: 
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February 2, 1993 
Object Help 

Clock 

-----------1 
Play text 
descnbin 
appointm gent~ 

Objects 
attached 
appcintm 
reminder 

to 
ent -

Elements 
be 
included 
reminder 

to / 

1n 

12 AM Start Time 1:45PM ~ 

·0· End Time IT) 
Person I 

3 ' ' 9 

I I 
Annotated Voice 

PM 12 IRe cordi ~ 
_j Appointment Description 

I L 
Faces~ Auto Launcn 

0 _j Greeting ~ . I Delete I 
• S1mon 

_j Descript. > Perkins ~ _j Voice 
_j Objects > Igor 

FIGURE 10-4: Date window 

·-
·-
·-

·-

/ 

·-
~ 

start time 

End time 

Person 
appcintment 
is with 

Record/play 
voice message 

Animated 
character who 
announces 
appcintment 

Deletes selected 
appcintment 

Saves and 
removes Date 
window from 
screen 

3. Move the pointer to the time on the clock at which the appointment starts, 
click and drag the line from the time the appointment starts to the time the 
appointment ends. Release the mouse button. The appointment is marked 
on the clock by a red time slice. 

Appointments 
afternoon 

PM 12 

6 
Appointments 
before noon 

FIGURE 10-5: Clock: Drag to select time slice; time slice appears in red; 
previously selected time slices appear in blue. 

An appointment has to be at least 15 minutes long. Talking Scheduler does 
not allow you to schedule an appointment during a period that is already 
scheduled . 
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You can use the arrows next to Start Time and End Time to adjust the 
starting and ending times in five-minute intervals. 

4. In the space next to Person, type the name of the person with whom the 
appointment is scheduled. The name you enter, up to 19 characters, is used 
in the greeting when the appointment is announced. 

5. Record a voice message if desired. (For more information, see "Recording 
a Voice Message" later in this chapter.) 

6. In the space below Appointment Description, enter a description of the 
appointment. (You can enter up to 127 characters.) 

7. Change the Auto Launch or Faces settings if desired. (For more 
information about them, see "Setting Up Talking Scheduler.") 

8. Attach any objects-such as memos, spreadsheets, or E-mail messages-to 
the appointment reminder. (For instructions, see "Attaching an Object to an 
Appointment," later in this chapter.) 

9. If you want to add another appointment, repeat steps 4 through 9; or choose 
Done to return to the Make Appointments calendar. 

Remember that Talking Scheduler is ready to remind you of your 
appointments only when it is minimized to an icon. When you have 
finished adding appointments, click the Minimize button or choose Run 
from the Main menu. 

Your Talking Scheduler appoints must begin and end within the same 
24-hour period. For example, an appointment that begins at 11 p.m. and 
ends at 1 a.m. must be scheduled as two appointments-11 p.m. to 
midnight on one day and midnight to 1 a.m. on the following day. 
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Reviewing Appointments 
To review the appointments you have set: 

1 . Open the Talking Scheduler window and choose Review from 
the Appointments menu. The Review Appointments dialog 
appears: 

~ 
~ 

~;cheduler 

2. Click the date for the appointments you want to review. The appointments 
set for that date are listed on the right side of the window. 

Today's 
date 

Next 
month 

Previous - --· 
month 

Review Appointments 

Today: Tuesday Febiua1y 16,1993 
,----------, 

FIGURE I0-6: Review Appointments dialog 

3. Select the appointment you want to review, and choose the Review button. 
The Reminder dialog appears: 

Click to hear __________. 
announcement ----------­
greeting 

February 2. 1993 

r

l="l:"oo PM- _:oo PM: Chris 

-~~~-~1 =
0

=~····· I 
Click to hear 
appointment text 

Play/stop 
appointment 
voice messcge 

• ~Appointment Description 

_ G iscuss schedule for Guppy account. 

I Y 
FIGURE I0-7: Reminder dialog 

Objects attached 
to appointment 
reminder 

Removes dialog 
from screen 

4. When you are finished reviewing the appointment, choose Done. The 
Review Appointments dialog reappears. 

5. Choose Done to close the Review Appointments dialog. 
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Making Changes to an 
Appointment 
To make a change to an appointment: 

1 . Open the Talking Scheduler window and choose Add/Modify 
from the Appointments menu. The Make Appointments 
window appears. Scheduler 

2. Click the date for the appointment you want to change. The window for the 
date appears. 

3. Select the appointment time slice. The slice changes from blue to red. 

4. Make whatever changes you want to the information about the appointment. 

5. When you are finished, if you want to change another appointment, select 
it; or choose Done to remove the window from the screen. 
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Deleting an Appointment 

There are three ways to delete appointments: 

•:• Using the appointment clock 

•:• Single appointments on the Review Appointments dialog 

•:• Appointments for an entire day with the Delete Days command 

Using the Appointment Clock 

To delete an appointment on the appointment clock: 

1 . Select the time slice that represents the appointment you want to delete. 

2. Choose the Delete button. The time slice disappears from the clock. 

Using the Review Appointments Dialog 

To delete an appointment on the Review Appointments dialog: 

1 . Open the Talking Scheduler window. 

2. Choose Review from the Appointments menu. The Review Appointments 
dialog appears. 

3. Click the date for the appointment you want to delete. The appointments 
for that date appear on the right side of the dialog. 

4. Select the appointment you want to delete, and choose the Delete button. 
The appointment is removed from the list. 

5. Choose Done to remove the dialog from the screen, or repeat step 4 to 
delete another appointment. 

Using the Delete Days Command 

To delete all the appointments scheduled on a date: 

1 . Open the Talking Scheduler window and choose Delete Days 
from the Appointments menu. The Delete Appointments 
dialog appears: Scheduler 
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FIGURE 10-8: Delete Appointments dialog 

2. Select the date for which you want to delete appointments, and choose the 
Delete button. The date is removed from the list. 

3. Choose Done to remove the dialog from the screen, or repeat step 3 to 
delete the appointments for another date. 

Recording a Voice Message 

To record a voice message for an appointment: 

1. Open the Talking Scheduler window and choose Add/Modify from the 
Appointments menu to display the Make Appointments window. 

2. Click the appointment date and, when the dialog for the date appears, select 
the time slice for the appointment or create a new appointment. 

3. Make sure the microphone is plugged into the microphone jack on the 
Sound Blaster 16. 

4. Choose the Record button, and record the message. 

The Record Voice Annotation dialog appears. The dialog shows you how 
may seconds of recorded voice the hard disk can hold. Voice messages use 
a lot of disk space-11 KB per second-so keep them short. 

5. Choose the OK button to end the recording. The dialog disappears. 

6. Choose Play to review the message you have just recorded. 

Voice messages take up a lot of disk space. Delete appointments with 
voice messages once they are past, to free up the space. 
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Attaching an Object to an 
Appointment 
You can link or embed an object-memo, spreadsheet, E-mail-in an 
appointment. Placing an object in an appointment allows you to start the 
object directly from the Reminder dialog, instead of switching from 
Talking Scheduler to the application used to create the object. For details 
about object linking and embedding (OLE) works, see the Microsoft 
Windows User's Guide. 

The primary difference between linking and embedding is that linking 
adds a pointer to the appointment and selects the object each time the 
appointment is accessed, while embedding makes a copy of an object and 
attaches it to the appointment. If you embed a copy of an object, the 
embedded copy is physically separate from the original object. If you 
make changes to the embedded copy, the original is not affected. If you 
link an object, the pointer gives the location of the orginal object. Any 
change you make to the linked object is actually made to the original. 

Embedding an Object in an Appointment 

You can embed an object in an appointment using either the Embed 
command or the Paste command: 

•:• Use Embed when the object's application is not running. 

•:• Use Paste when the object's application is running or when you want 
to embed just part of an existing object. 

To embed an object using the Embed command: 

1 . If the Talking Scheduler window is not on the screen, double- ~ 
click the Talking Scheduler icon to display it, then choose .B 
Add/Modify from the Appointments menu to display the Scheduler 
Make Appointments window. 

2. Click the date for the appointment and, when the window for the date 
appears, select the time slice for the appointment or create a new 
appointment. 

3. Choose Embed on the Object menu. The Embed Object dialog appears: 
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FIGURE 10-9: Embed Object dialog 

4. Select the appropii.ate application for the object, then choose OK. The 
application starts. 

5. To embed a new object, create the object and choose Update from the 
application's File menu; exit the application. 

To embed an existing object, open the object and exit the application. A 
message appears asking if you want to update the object-choose Yes. 

The application window disappears. An icon representing the object you 
embedded appears in the OLE Objects area. 

To use the Paste command to embed an object: 

1 . On the object's application window, select all or part of the object. 

2. Choose Copy from the application's Edit menu. 

3. If the Talking Scheduler window is not on the screen, double-click the 
Talking Scheduler icon to display it, then choose Add/Modify from the 
Appointments menu to display the Make Appointments window. 

4. Click the appointment date and, when the window for the date appears, 
select the time slice for the appointment or create a new appointment. 

5. Choose Paste from the Object menu. An icon representing the object you 
embedded appears in the OLE Objects area. 

Linking an Object to an Appointment 

To link an object to an appointment: 

1 . Go to the object's application window, and select all or part of the object. 

2. Choose Copy from the application's Edit menu to place a copy of the object 
on the Clipboard .. 
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3. If the Talking Scheduler window is not displayed, double-click the Talking 
Scheduler icon. Choose Add/Modify on the Appointments menu to display 
the Make Appointments window. 

4. Click the date on which the appointment falls. When the window for the 
date appears, select a time slice or create a new .appointment. 

5. Choose Paste Link from the Object menu. An icon representing the 
embedded object appears in the OLE Objects area. 

To check or update appointment links, choose Links on the Object menu. 
For information about linking, see the Microsoft Windows User's Guide. 

Detaching an Object from an Appointment 

To detach an object from an appointment: 

1. Open the Talking Scheduler window. Choose Add/Modify 
from the Appointments menu to display the Make 
Appointments window. Scheduler 

2. Click the date on which the appointment falls and, on the window for the 
date, select the time slice for the appointment. 

3. Select the icon of the object you want to detach and choose Clear from the 
Object menu. The icon disappears from the OLE Objects area. You can 
detach all objects linked/embedded in an appointment by choosing Clear 
All on the Objects menu. · 

Quitting Talking Scheduler 
To quit Talking Scheduler: 

1. Choose Quit from the File menu. 

Choosing Quit deactivates Talking Scheduler-it will no longer remind 
you of any appointments. To remove the Talking Scheduler window 
from the screen, but keep it active, choose Run from the File menu. 
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Talking Scheduler Menus 
Main Menu Description 

SetUp Displays the Progmm Defaults dialog. See "Setting Up Talking 
Scheduler." 

Clock Displays the Windows clock. 

Run Minimizes Talking Scheduler to an icon and sets it to announce 
appointments. 

Quit Quits Talking Scheduler. 

Appointments 
Menu Description 

Review Review the appointments you set up. 

Add/Modify Add or change an appointment. 

Delete Days Delete all of the appointments scheduled for a given day. 

Help Menu Description 

Help Index List topics for which you can get on-line help. 

About Version number and copyright information for Talking Scheduler. 

Date Window Menu 

Object Menu 

Paste 

Paste Link 

Links 

Embed 

Clear 

Clear All 

Object 

Help Menu 

Description 

Copies all or part of an object and attaches it to an appointment 

Creates a link with all or part of an object and attaches the link to an 
appointment. 

Displays the links set up with an appointment. For more 
information, see the Microsoft Windows User's Guide. 

Creates an object and attaches it to an appointment. 

Detaches the selected object from an appointment 

Detaches all the linked or embedded objects from an appointment. 

Edits the selected object. 

Each item is a topic. Select the item for information about the topic. 
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Eleven 

SB l 6SET Utility 

The SB16SET utility allows you to control the Sound Blaster 16 Mixer 
settings interactively. With the Mixer, you can control volume, gain, and 
tone of the audio sources. 

You can enter commands at the DOS prompt or invoke the SB 16SET 
interface to control the mixer settings. 

SB 16SET Command 

The syntax for using the SB16SET command and Mixer settings is: 

SB16SET [/B I /?l [/Ql [/Pl [/MA: vol [;ball l 
[ /VO: vol [,ball l [/MJ:: vol [,ball l [/CD: vol [,ball l 
[ /LJ:: vol [,ball l [/MJ:C: voll [/SP: voll 
[/TR: vol [,ball l [/BA: vol [,ball 
[/OPS:dev{+l-}[ dev{+l-}l [ ••• 11 
[/J:PL:dev{+l-}[ dev{+l-}l [ ••• 11 
[/J:PR:dev{+l-}[ dev{+l-}l [ ••• 11 
[/J:PG:lgain[,rgainl [/OPG:lgain[,rgainll 
[/AGC:{+I-}l 

Options Description 

IH or/? Displays help messages. 

IQ Runs SB 16SET without displaying the setting information. 
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Options 

IP 

/MA:vol;bal 

NO:vol;bal 

/MI:vol;bal 

/CD:vol;bal 

ILI:vol;bal 

IMIC:vol 

/SP:vol 

/TR:vol;bal 

IBA:vol;bal 

/OPS:dev 

IIPL:dev 

IIPR:dev 

Description 

Configures the Mixer according to the Preset settings in the 
CTMIX.CFG file. 

Sets the MAster volume (0-255) and balance (-5 to +5) ofleft 
and right channels. 

Sets the VOice volume (0-255) and balance (-5 to +5) ofleft 
and right channels. 

Sets the MIDI volume (0-255) and balance (-5 to +5) ofleft 
and right channels. 

Sets the CD volume (0-255) and balance (-5 to +5) ofleft and 
right channels. 

Sets the Line-in volume (0-255) and balance ( -5 to +5) of left 
and right channels. 

Sets the MICrophone volume (0-255). 

Sets the PC SPeaker volume (0-255). 

Sets the TReble level (0-255) and balance (-5 to +5) ofleft 
and right channels. 

Sets the BAss level (0-255) and balance (-5 to +5) ofleft and 
right channels. 

Sets the audio ouput switches (OPSW) on or off. dev is one 
or more of the following: 

CD 
LI 
MIC 

Each dev must be followed by either+ (on) or- (off). 

Tum left input switches (IPLSW) on or off. dev represents 
one or more of the following: 

CDR CDL 
MDL MDR 
LIR LIL 
MIC 

Each dev must be followed by either+ (on) or- (off). 

Turns right input switches (IPRSW) on or off. See IIPL. 

IIPG:lgain,rgain Sets input gain (IPGAIN) ofleft (!gain) and right (rgain) 
channels. Valid entries for either channel is 1, 2, or 4. 

/OPG:lgain,rgainSets output gain (OPGAIN) of left (!gain) and right (rgain) 
channels. Valid entries for either channel is 1, 2, or 4. 

/AGC:{+I-} Turns automatic gain control (AGC) on(+) or off(-). 
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Options that can accept volume and balance settings may include either 
or both. If volume is not included, the balance value must be preceded 
by a semicolon ( ; ). Values for volume range from 0 to 255; for balance 
the range is -5 to +5. For example, /MA:200;5 sets the master volume to 
200 and the balance decreases volume in the left channel. 

If you enter multiple MI, IP, or OP switches, the order of precedence is 
MI (MIDI), IP, and OP. 

SB 16SET Command Examples 
The following are examples of how you can use the SB16SET command: 

To set the PC speaker volume to 200: 

1 . Type SB16SET /SP:200 and press ENTER. 

To set the master volume to 200 with balanced output through left and 
right channels: 

1 . Type SB16SET /MA:200 and press ENTER. 

If balance is not specified, both channels are set equally. 

To set all from the two examples above in a single command: 

1 . Type SB16SET /SP:200 /MA:200;0 and press ENTER. 

SB 1 6SET Control Screen 
The SB16SET control screen gives you interactive access to the mixer 
controls in DOS. 

To display the SB16SET control screen: 

1. Change to your sound directory. 

2. Type SB16SET and press ENTER. The SB16SET control screen (Figure 
11-1) displays. 
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FIGURE 11-1: SBI6SETcontrol screen 

Volume Control 

The sliders for each of the audio sources-Voice, MIDI, CD, Line, 
Microphone, PC Speaker, Master, Treble, and Bass-control the volume 
or level for each source. The volume control slider is the larger; the 
smaller, immediately below, is the balance control slider. 

Balance Control 

The balance control sliders are used to adjust the balance of right and left 
speakers for audio sources with stereo capability. Moving the slider to 
the left decreases the volume of the right speaker; the left speaker 
volume remains the same. Moving the slider to the right decreases the 
volume of the left speaker; the right speaker volume remains the same. 

Automatic Gain Control (AGC) 

The automatic gain control (AGC) box, when filled, automatically 
adjusts input gain from the microphone to a level suitable for recording. 
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Save Button 

The Save button writes all changes made to the control screen to the 
CTMIX.CFG file. The new settings are used the next time you set the 
Mixer with the SB 16SET /P command. 

Input Box 

The Input box enables you to select the audio sources you want to control 
as input to the Mixer. The audio sources available are MIDI, Line, and 
Microphone input, and CD-ROM. You can direct these audio sources 
through the left and/or right input channels of the Mixer. 

For stereo, the left channel of the audio source must be directed to the 
Left-In channel and the right channel of the audio source to the Right-In 
channel. 

The arrow buttons can be used to manually increase/decrease the input 
gain. (Gain increases or decreases the amplification of an audio source.) 

Output Box 

The Output box enables you to select the audio sources you want to 
control as output from the microphone, Line-in, and CD-ROM to the left 
and right speakers. You can select one or a combination of the above 
audio sources playing through the card. 
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Mixer Controls 
You can adjust the Mixer control settings by using the mouse or the 
keyboard. 

Mouse Control 

• To change a check box, position the mouse pointer on the box and click 
the left mouse button. 

• To adjust a volume or balance slider, use the mouse pointer to 
click-and-drag the slider. Release the mouse button when the slider is 
at the desired point. 

Alternatively for the volume control, use the mouse pointer to click on 
the arrows at either end of the volume scale. Continue to click the 
slider until it reaches the desired point. 

• To quit the Mixer control screen, click on the box in the upper left 
comer. 

Keyboard Control 

• To move from one group of controls to another, press the TAB key. 

• To move backwards through control groups, press SHIFf+ TAB. 

• To move from one control to another within a group, press the up or 
down arrow key. 

• To adjust volume or gain, press the left or right arrow key. 

• To change a check box, use the TAB or arrow keys to select the box 
and press the SPACEBAR or ENTER key. 

• To quit the Mixer control screen, press the ESC key. 

11 -6 DOS APPLICATIONS 



Twelve 

PLAY Utility 

The PLAY utility allows you to play audio CDs and a wide range of 
sound files. By simply entering a command, you can now play Microsoft 
Wave (.WAV), Creative Voice (.VOC), MIDI (.MID), and Creative 
Music ( .CMF) files. And, if you want to play a set of files with the same 
file name extension, the utility gives you the flexibility to play them in 
sequence without requiring you to specify each file individually. 

Playing Sound Files 

The syntax for the PLAY command to play sound files is: 

PLAY filel [file2 • • • ] [/Q] [/B) [!?] 

Option 

CD/T:xx 

file] 

file2 ... 

/Q 

/H or/? 

PLAY Utility 

Description 

Play CD beginning with track number xx. 

Name ofthe first file you want to play. 

Name(s) of additional file(s) ofthe same type you want to play. 

Disables display of playback information (file format, play 
time, file names, key menu, and the copyright messages) while 
a ftle is playing. 

Displays description for using the PLAY command. 
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When using the PLAY command: 

•!• If you enter the PLAY command without parameters, a description 
for using the command is displayed. 

•!• If you enter a file name without specifying and extension, PLAY will 
search the current directory for that file name. If more than one file 
name extension exists for the file name, the utility plays only one file 
in the following order of preference: .W A V, .VOC, .MID, and 
.CMF. 

•!• Before you play a Creative Music (.CMF) file, you have to load the 
SBFMDRV.COM driver into memory. This is done by typing 
SBFMDRV in the directory in which the driver is found. 

•!• When you enter a file name, you can specify part of the file name 
and use an asterisk ( * ) or question mark ( ? ) to represent the 
remaining missing characters. The asterisk represents one or more 
characters while the question mark represents only a single character 
but can be used repeatedly. 

For example, if you enter PLAY * .W A V, all wave file are played. If 
you enter PLAY TEST* .W A V, all wave files with the file name 
beginning with TEST are played. If you enter PLAY TEST? .W A V, 
all wave file with a file name containing five characters beginning 
with TEST are played. 

PLAY *. * or PLAY TEST.* are not valide commands. The PLAY 
command only works with files of one type collectively. 

•!• When you play a MIDI file, the progam searches for the MIDI 
environment variable. 

The MIDI environment variable specifies the MIDI file format used 
and the destination of MIDI data. The MIDI data can be sent to the 
FM chip, Sound Blaster MIDI, or MPU-401 port. Generally, there 
are three MIDI file formats available: General MIDI, Extended 
MIDI, and Basic MIDI. 

The command for setting the MIDI environment is: 
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SET MID=SYNTH:x MAP:y 

Option 

SYNTH:x 

MAP:y 

Description 

x = 1 Internal synthesizer (default) 
2 MIDiport 

y= G General MIDI file format 
E Extended MIDI file format (default) 
B Basic MIDI file format 

Playing Audio COs 

The syntax for the PLAY command to play audio CDs is: 

PLAY CD [/T:xx] [/Q] [/H] [/?] 

Option 

CD 

IT:xx 

/Q 

IH or/? 

NOTE 

Description 

Specifies CD-ROM drive as the source of audio input. 

Specifies the CD track with which you wish playing to start 
(xx is the track number). 

Disables display of playback information (current track, total 
tracks, playing time, and the key menu) while a track is 
playing. 

Displays description for using the PLAY command. 

jL~t,h:,~·IJ;J,;l';l;\li!lafiJ!!m§l;JrY:~;;::,;;:-,,;1$JNl~l!ll!ml(tlWi~ll .• ;)'U:1i'Wfll:l!li~~ffii!Ji",fo\l!rl.Niililmtl~lml!irnlllm!:li'l\it·i13!~;~"lilll:li1l!,;~V~.·.'~~:il:.!'.~VP]~i:( 1•: .. ,.t~'01%'~1o~; 

If you do not specify the track number (fl':xx) option, you must press 
the P key to start playing the CD. 
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PLAY Command Examples 

The following are examples of how you can use the PLAY command to 
play sound files and audio CDs in DOS: 

To play a Creative music file (for example, SONG.CMF): 

1. Type SBFMDRV.COM and press ENTER to load the FM driver into 
memory. 

2. Type PLAY SONG.CMF and press ENTER. 

To play three voice files (for example, TEST I. VOC, TES12. VOC, and 
TEST3. VOC) in sequence: 

1. Type PLAY TESTl.VOC TEST2.VOC TEST3.VOC and press ENTER. 

NOTE [j~'fi[~"';~7:ifi~'d"'d~';;"~~(";";t;[;;;''~"':/:::z;tJ;"";j;;~;:;th;''?iA7"'"""~'-" 
command is not executed. 

To play a voice file (for example, TEST I. VOC) without displaying the 
playback information. 

1 . Type PLAY TESTl.VOC /Q and press ENTER. 

To play a CD without specifying the starting track: 

1 . Type PLAY CD and press ENTER. 

To play a CD starting at track 5: 

1 . Type PLAY CD ff:S and press ENTER. 

Th~am~~~~d5~~w~~~~m~ 
assignments: 

1 . Type PLAY CD ff:S/Q and press ENTER. 
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Controlling Playback 

You can control the playback of files using the keyboard. A menu of 
available keys appears when you enter the PLAY command without the 
!Q switch. 

Wave (.WAV) File Control Keys 

The following control keys are available while playing wave files: 

Key Description 

C Resumes playing the wave file. 

ESC Stops the wave file and exits the program. 

N Plays the next wave file. 

P Plays the previous wave file in a specified set. 

SPACEBAR Pauses the wave file. 

< or > and ENTER Selects and plays another wave file if more than one file 
is specified. 

Voice (.VOC) File Control Keys 

The following control keys are available while playing voice files: 

Key Description 

B Stops a repeating section of the voice file and proceeds 
to the next section. 

C Resumes playing the voice file. 

ESC Stops the voice file and exits the program. 

N Plays the next voice file in the set. 

P Plays the previous voice file in the set. 

SPACEBAR Pauses the voice file. 

< or > and ENTER Selects and plays another wave file if more than one file 
is specified. 
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MIDI (.MID) File Control Keys 

The following control keys are available while you are playing MIDI 
files: 

Key 

c 
ESC 

Left or right arrow 

M 

N 

p 

SPACEBAR 

Up or down arrow 

< or> and ENTER 

Description 

Resumes playing the MIDI file. 

Stops the MIDI file and exits the program. 

Reproduces the sound in a different key by raising or 
lowering the pitch. 

Changes to a different set of musical instruments based 
on the Basic, General, and Extended standards on the 
MIDI mapper. 

Plays the next MIDI file in the set. 

Plays the previous MIDI file in a the set. 

Pauses the MIDI file. 

Changes the tempo of the MIDI file. 

Selects and plays another MIDI flle if more than one file 
is specified. 

Creative Music (.CMF) File Control Keys 

The following control keys are available while you are playing .CMF 
files: 

Key Description 

C Resumes playing the .CMF file. 

ESC Stops the .CMF file and exits the program. 

Left or right arrow Reproduces the sound in a different key by raising or 
lowering the pitch. 

N Plays the next .CMF file. 

P Plays the previous .CMF file in a specified set. 

SPACEBAR Pauses the .CMF file. 

< or> and ENTER Selects and plays another .CMF file if more than one file 
is specified. 
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Audio CD Control Keys 

The following control keys are available while you are playing an audio 
CD: 

Key 

c 
ESC 

F 

L 

N 

p 

R 

s 
SPACEBAR 

X 

PLAY Utility 

Description 

Resumes playing the track. 

Stops the track file and exits the program. 

Fast forwards the track. 

Plays the previous track. 

Plays the next track. 

Plays the track. 

Rewinds the track. 

Stops the track. 

Pauses the track. 

Exits the program. 
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Thirteen 

RECORD Utility 

The RECORD utility allows you to record sound to a file by specifying 
the file type and recording parameters such as sampling rate and 
recording mode. 

Sound is recorded into a sound file in Microsoft Wave (.WAV) or 
Creative Voice (.VOC) file format. 

Recording Sound Files 
The syntax for using the RECORD command to record wave or voice 
files is: 

RECORD file [/A:xx] [/C:xx] [/M:xx] [/R:xx] [/S:x] 
[/Q] [/H] [?] 

Option 

file 

RECORD Utility 

Description 

Specifies the name of the file including the file name 
extension (.WA V or .VOC) to which you want to record 
sound data. 
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Option 

/A:xx 

/C:xx 

/M:.xx 

!R:xx 

/S:.xx 

/Q 

/H or I? 

Description 

Sets the recording source: 
xx = MIC Microphone 

CD AudioCD 
LINE External device using line-in jack on 

Sound Blaster 16 
FM FMfile 

You can record from more than one source. 

Sets the compression format: 
xx= ALAW 

MULAW 
CTADPCM 

Sets the recording mode: 
XX= MONO 

STEREO 

Sets the sampling resolution: 
XX= 8 bits 

16 bits 

Sets the sampling rate: 
. VOC format: xx = 
.WA V format: xx = 

5000 to 44100 Hz 
11025 Hz 
22050Hz 
44100Hz 

The higher the sampling rate, the better the recording quality. 

Disables display of recording information. 

Displays a description on using RECORD. 

When using the RECORD command: 

•!• If you enter the RECORD command without parameters, the online 
description for the command displays. 

•!• If you do not specify the recording mode, sampling rate, and 
resolution, the sound is recorded in monaural, 8-bit wave file format 
with a 11025 Hz sampling rate. 

•!• If you want to stop the recording, press the ESC key. 

•!• The recording stops when the disk is full. 

•!• A new file is created or an existing file overwritten during recording. 
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RECORD Command Examples 

The following are examples of how you can use the RECORD command 
to record sound files in DOS: 

To record from an audio CD to a soundfile (for example, SONG. VOC) 
in . VOC fonnat: 

1 . Play the audio CD in the background. 

2. Type RECORD SONG.VOC /A: CD and press ENTER. 

To record a sound file without displaying the recording information: 

1. Type RECORD SONG.VOC /A:CD /Q and press ENTER. 

To record a stereo sound file from a line-in source in. WAV format with 
MUlA W compression: 

1. Type RECORD SONG.VOC /A:LINE /M:STEREO /C:MULA Wand 
press ENTER. 
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Fourteen 

Text-to-Speech 

The text-to-speech program uses phonetic rules to translate the text and 
is able to speak virtually any word. It reads ASCII text, outputting it 
vocally through the audio card speakers or headphones. 

SBTALKER 
SBTALKER is the speech synthesizer that converts typed text to speech. 
You must have the Sound Blaster 16 software installed and SBTALKER 
in memory before using the READ command. 

Installing SBTALKER 

SBTALKER is installed at the end of the Monologue for Windows (see 
Chapter 9) installation. (Review the Monologue for Windows 
instructions if you did not elect to install SBTALKER at that time.) 

To install SBTALKER: 

1 . Insert the Text-to-Speech diskette in the disk drive. 

2. Type A:\INSTALL following the Windows Program Manager Run 
command. 

3. Press ENTER. 
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Starting SBTALKER 

To run SBTALKER, exit Windows and change to the 
\SB16\SBTALKER directory. 

To start SBTALKER: 

1. Change to the \SB16\SBTALKER directory. 

2. Type SBTALK and press ENTER. 

SBTALK is a batch file (SBTALK.BAT) located in the 
\SB 16\SB TALKER directory. 

Creating Echo Effect 

With SBTALKER, you have the ability to create an echo effect for any 
of the applications you are reading. 

To set echo effect: 

1 . Type SET -ECHO [dddd] 

2. Press ENTER. dddd Sets the delay time for the echo effect. The range is 
from 0 to 4,000. Entering 1,000 provides a good echo effect with a 0.1 
second delay. A delay setting of 500 produces a reverb effect. 

Extended Memory Specification 

SBT ALKER automatically loads itself into expanded memory 
specification (EMS), if the proper EMS driver is installed in the system. 
The usage of expanded memory is advantageous because it can hold a 
larger amount of text, allowing for faster access of data and minimizing 
breaks between various text. SBT ALKER is compatible with most EMS 
drivers available. However, if you have one that does not work properly 
with SBTALKER, it may be necessary to remove the EMS driver to run 
SBTALKER. 
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Removing SBTALKER 

SBT ALKER stays in memory until you remove it or reboot the system. 
You may not be able to run other applications with SBT ALKER in 
memory. 

To remove SBTALKERfrom memory: 

1. Change to the \SB16\SBTALKER directory. 

2. Type REMOVE and press ENTER. 

NOTE To remove SBTALKER, it must be the last program loaded into 
memory. 

Read 
The Read program can read ASCII text files or text typed from the 
keyboard. Text can be entered in either upper or lower case. The three 
ways of reading text are: 

•:• DOS command 

•:• Text reader 

•:• ASCII text files 

Reading from the DOS Command 

To read text from DOS command: 

1 . At the DOS prompt, type: 

READ any-text 

2. Press ENTER. The READ command converts any-text to speech. Once the 
text is read, it returns to the DOS prompt 

For example, to have the program say, "Hello, how are you?": 

At the DOS prompt, type READ ''HELLO, HOW ARE YOU?" 
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3. Press ENTER. You will hear, "Hello, how are you?" from your speakers. 
Now, try typing "READ "HELLO, HOW ARE YOU?"" (without the 
quotation marks) and press ENTER. Notice any difference in the output? 

NOTE You do n~t"h~~eto'i~~~~de the quotatio~~~;k when typt~g the text. 

Reading from the Text Reader 

To read from the Text Reader: 

1 . Type READ at the DOS prompt. 

2. Press ENTER. The Text Reader waits for text to be entered from the 
keyboard before sending it to the speakers. 

To stop the program, press CONTROL+Z or CONTROL+C, followed by 
ENTER. You immediately return to the DOS prompt. 

Reading from ASCII Text Files 

To read text from ASCII text files: 

1 . At the DOS prompt, type: 

READ > input-file [/w] 

2. Press ENTER. The READ command gets its input from input-file-an 
ASCII text file . The program reads any text within this file and terminates 
when it reaches the end. 

NOTE The /w option displays the text as it is being read. 

For example, type the following command at the DOS prompt, in the 
\SB 16\SBTALKER directory, and press ENTER: 

READ > SBTEST.TXT /w 

The program begins reading the text that is in the file SBTEST.TXT and 
displayse the text on the screen. To stop reading the file, press ESC. 
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NOTE SBTEST.TXT is an ASCII text file supplied with the software. You 
can ask SBTALKER to read any ASCII text by including the path in 
which the file is located. ASCII text files can also be accessed from 
the COMJ communications port: 

To read an ASCII text file from the COM I communications port: 

1 . Type READ> COMl. 

2. Press ENTER. 
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Fifteen 

QuickCD 

QuickCD is a DOS interface that allows you to play audio compact 
discs (CDs) in your computer's CD-ROM drive. 

Starting QuickCD 

To start QuickCD: 

1. Change to the Sound Blaster 16 directory. For example, type CD \SB16 
(for the default installation) and press ENTER. 

2. Type QCD at the DOS prompt and press ENTER. The QuickCD control 
panel appears . 

FIGURE 15-1: DOS QuickCD control panel 
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QuickCD Control Panel 

QuickCD has the same controls found on most CD players as well as 
some additional features. 

Display Panel 

The display panel shows the current operating mode. It provides you 
with information on the playing track and the time the track has been 
playing. 

Current track 

Drive 

Additional tracks to be played 

FIGURE 15-2: QuickCD display panel 

Power Button 

Time current 
track has been 
playing 

~ 

The power button allows you to quit QuickCD by clicking with the 
mouse button. 

CD Load/Un load Button 

The CD load/unload button allows you to load or unload a CD from a 
caddy-less CD-ROM drive. The CD-ROM tray opens (unload) and 
closes (load) when you click on the button. 
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Playback Control Buttons 

The playback control buttons allow you to command the audio CD in the 
CD-ROM drive. 

Stop i 
Pause 

Play ·~ Fast • Next 
forward I track 

Reverse Previous 
track 

FIGURE 15-3: Playback control buttons (Play is currently selected) 

Button 

Stop 

Pause 

Play 

Reverse 

Fast forward 

Previous track 

Next track 

Track Selector 

Description 

Stops playing the current track. 

Pauses playing the current track; press again to resume. 

Begins playing the current track. 

Quickly returns to the beginning of the current track. 

Quickly advances the current track. 

Begins playing the previous track. 

Begins playing the next track. 

The track selector consists of buttons that allow you to select a track on 
your audio CD by entering its number. 

FIGURE 15-4: Track selector buttons 

To play a track numbered 1-10, press the appropriate number. 0 plays 
track 10. 

To play a track number 11 or higher, press the" .. / .. " button before 
entering the two-digit track number. 
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Function Buttons 

The function buttons allow you to view and select sets of tracks that you 
want to play. 

Selects the operating mode you want to use. To confirm 
selection, choose the Set button. The modes of operation 
are: 

Normal plays tracks in the order in which they are 
arranged on the CD. 

Random plays tracks in random order. 

Programmable allows you to arrange the tracks in any 
sequence. You are prompted to enter the track number 
and press the Set button. When you have completed 
ordering the tracks, push the Play button to listen to the 
tracks as arranged. 

Repeat Track continuously repeats the track that is 
currently playing. 

Repeat Disk repeats the entire audio CD when the last 
track is finished. 

~· J ~ ~ Confirms the operating mode you selected. 

15-4 

Plays from ten seconds of each track on the CD in Normal 
mode. 

Cancels any functions and incorrectly entered track 
number. 

Shows credits and copyright notices from the audio CD. 

Allows you to go to another CD-ROM drive if more than 
one is installed. Does not disrupt a drive that is currently 
playing. 
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Gain Contro ls 

The gain increases or decreases the amplification of your audio source. 

Increase 
amplification 

Amplification 
level 

Decrease 
amplificat ion 

Left speaker 

FIGURE 15-5: 

Increase 
amplification 

Amplification 
level 

Decrease 
; ampl ification 

IUl~'=-; :.. -. . ~ Right speaker 
!~. .:::rw..~. ~· 

Gain controls 

You can increase the gain levels by two, four, or eight times. 

Volume/Tone Controls 

The volume/tone controls allows you to adjust the volume and tone 
levels of the microphone, master, and CD sources. 

Volume/tone 
level indicator 

Microphone Master 
volume volume 
(left/right) (left/right) 

FIGURE 15-6: Volume/tone controls 

CD 
volume 
(left/right) 

Bass 
level 
(left/right) 

Treble 
level 
(left/right) 



Microphone Controls the microphone volume. 

Master Controls the master volume for both left/right speakers. 

CD Controls the volume for CD input. 

Treble Controls the level of the higher frequencies of an audio 
source. 

Bass Controls the level of the lower frequencies of an audio 
source. 

Channel Lock 

The Channel Lock allows you to lock together 
the left and right channels of audio 
sources-when the channels are locked, they 
move together whenever you adjust volume or 
tone level. 

The box above the lock indicates the status. 

Controlling QuickCD 

You can use either mouse or keyboard to make changes on the QuickCD 
control panel. 

Mouse Control 

• To increase/decrease the volume or tone level, click-and-drag or click 
on the indicator. 

• To increase to maximum level, click above the volume or tone level 
indicator. 

• To decrease to minimum level, below the volume or tone level 
indicator. 
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Keyboard Control 

• To advance to an option, press the TAB key. 

• To move backwards through the controls, press SHIFI'+TAB. 

• To increase/decrease volume, tone level, or gain, press the up or down 
arrow key. 

• To begin an operation (press a button), select the button and press 
ENTER. 

• To quit QuickCD, press the ESC key. 

In addition, the following key combinations can by used to operate the 
QuickCD control panel. 

Key(s) 

ALT+A 

ALT+B 

ALT+C 

ALT+E 

ALT+I 

ALT+M 

ALT+N 

ALT+O 

ALT+P 

ALT+T 

SPACEBAR 

Oto9 

I 

Description 

Scan mode: Preview tracks on the current audio CD. 

Select the bass tone level indicator. 

Select the CD volume indicator. 

Select additional CD-ROM drive. 

Display information about QuickCD. 

Select master volume indicator. 

Cancel current program mode. 

Toggle through program modes. 

Select microphone volume indicator. 

Select the treble tone level indicator. 

Press the currently selected button. 

Select a track from 0 to 9. 

Set track selector to accept only two-digit track number. 

Quitting QuickCD 

To quit QuickCD: 

• Select the Power button. 

• Press the ESC key. 
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Sixteen 

Intelligent Organ 

Sound Blaster 16's Intelligent Organ transforms your computer 
keyboard into an organ keyboard. You can play musical pieces on your 
computer keyboard-and Intelligent Organ helps you learn them. Or, 
you can use a MIDI keyboard with Intelligent Organ by connecting it 
through Sound Blaster 16's MIDI interface. 

Loading Intelligent Organ 

To load Intelligent Organ: 

1. At the DOS prompt, type CD \SB16\PRO_ORG and press ENTER to 
switch to the directory in which Intelligent Organ is located. 

2. Type PRO_ORG and press ENTER. The main screen appears: 

FIGURE 16-1: Intelligent Organ main screen 

Intelligent Organ 

J Four octaves ore 
available on the 
computer 
keyboard at one 
time 
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3. Press the F2 key. The play mode screen is displayed: 

CMS's Intell~gent Organ 

Key 1= c F1: PIANO F5: march 

Tempo: 120 F2: ORGAN1 F6: rhumba 

Scale: major F3: VIOLIN F7: swing 

Arpeggio: 1 F4: SYNTH1 FS: waltz 

FIGURE 16-2: Intelligent Organ play mode screen 

Melody vol : 8 

Arpg vol: 5 

B-C-R vol: 6 

Buffer Status 

For more information, see "Playing Intelligent Organ" later in this 
chapter. 

How the Keyboard Works 

Intelligent Organ's keyboard covers a total of seven octaves (in figure 
16-3, they are labeled A, B, C, D, E, F, and G). The first note of octave 
D is middle C. 

You can assign a block of either two or four octaves to the computer 
keyboard. In two-octave mode, you have access to the notes that 
correspond to both black and white keys oflntelligent Organ's keyboard. 

I Octave A I Octave B I Octave C I Octave Dl Octave E I Octave F I Octave G I 

11111111111111111111111111111111111111 II IIIII IIIII 
ZXCVBNM QWERTYU 

ASDFGHJ 1234567 

FIGURE 16-3: Seven octaves; keyboard equivalents are shown for four 
octaves (white keys only) 

In four-octave mode, you have access only to the notes that correspond 
to the white keys. Four-octave mode is the default. 
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Four-Octave Mode 

In four-octave mode, each octave in the block is assigned to one row on 
the computer keyboard (see figure 16-3). 

The green bars above and below the keyboard on the screen indicate 
which four octaves are currently selected. 

To select a different block of octaves: 

1 . Press the left or right arrow key in play mode. 

The green bars shift to indicate the block that is selected. 

If you press the right arrow key to shift the block one octave higher, 
octave D shifts from computer keys ASDFGHJ to ZXCVBNM: 

Sound Blaster Pro Intelligent Organ Uersion 1. 84 
Copyright (c) Creative Technology Pte Ltd, 1988-1991. All rights reserved. 

F Octave D 9 

1m 1m 1111!11111111111111111111111111 

liJ-help ~play lij-replay IIJ-non stop le-default !it-load [if-save iitMore 

FIGURE 16-4: Four octaves shifted right 

If you press the left arrow key to shift the block one octave lower, octave 
D shifts from computer keys ASDFGHJ to QWERTYU. 
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Two-Octave Mode 

To switch to two-octave mode: 

1 . Press the TAB key. The green bars shorten to indicate the two octaves that 
are selected. 

Sound Blaster Pl"o Intelligent Organ Uersion 1.04 
Cop~right (c) Crealiue Technolog~ Pte Ltd, 1988-1991. All rights reserved. 

liJ-help !ft-pla~ ~replay lld-non stop !~a-default tit-load lfi-Saue !Ia-More 

FIGURE 16-5: Two octaves active 

In two-octave mode, each octave in the block is assigned to two rows on 
the computer keyboard: 

FIGURE 16-6: Two octave mode showing keyboard equivalents 

To select a different set of two octaves: 

1 . Press the left or right arrow key. The green bars shift to indicate the block 
that is selected. 

Press the right arrow key to shift the block one octave higher, octave D 
shifts off the computer keyboard and octave E and F shift to computer 
keys ZXCVBNM and ASDFGHJ. 

Press the left arrow key to shift the block one octave lower, octave D and 
E shifts to computer keys QWERTYU and 1234567. 
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Learning to Play a Song 
Intelligent Organ helps you learn a song by playing the song and 
showing you which keys on the computer keyboard correspond to the 
notes of the song and then by cueing you to press the right keys at the 
right time. 

To learn a song: 

1. Press F6. 

A list of the available songs is displayed. 

2. Select the song you want and press ENTER. 

The list disappears from the screen, and Intelligent Organ loads the song 
into memory. 

Sound Blaster Pro Intelligent Organ Uersion 1. 84 
Copyright (c) Creative Technology Pte Ltd, 1988-1991. All rights reserved. 

liJ-deHo lfriearn lEt-quit 

FIGURE 16-7: Learn mode screen: Numbers on the bottom of the keys 
correspond to the numbers above each note on the music (see 
figures 16-9 and 16-10) 

3. Press F8 then Fl to switch to learn mode. 

4. Press Fl to have Intelligent Organ play the song for you. 

As the song plays, Intelligent Organ highlights the key that corresponds to 
each note. 

5. Press F2 to have Intelligent Organ lead you through the song as you play. 

Intelligent Organ begins playing the accompaniment for the song. It cues 
you to prepare to press a key by highlighting the letter on the key in brown, 
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then signals you to press the key by highlighting the number that represents 
the note in magenta. 

Intelligent Organ accommodates your skill level by pausing if you do not 
press the key on time and waits until you do so. 

To stop the lesson at any point: 

1 . Press ESC. 

To exit learn mode and return to the main screen: 

1 . Press ESC. 
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Playing Intelligent Organ 
To play Intelligent Organ: 

1. Return to the main screen if necessary. 

2. To return Intelligent Organ to its default settings, press FS, and, on the 
Default Setting window, type 0 (original values), and press ENTER. 

Each time you load a song, Intelligent Organ alters the settings on the play 
mode screen for the song. The default settings allow you to start a new 
song with standard settings. 

3. Press F2 to start playing Intelligent Organ. The screen changes to: 

Metronome 

Current I Instrument 
Rhythms 

Volume 
settings 

tempo so nds 

CMS's Intelligent Organ 

Fl: PIANO 

F2: ORGANl 

F3: VIOLIN 

F4: SYNTHl 

FS: march Melody vol: 8 

120 

major 

1 

Accompaniment uses 
major or minor chords 

F6 : rhumba Arpg vol: 5 

F7: swing B-C-R vol: 6 

FS: walt 

Volume of the 
accompaniment 

Buffer Status 

FIGURE 16-8: Intelligent Organ play mode screen 

In play mode, everything you play is recorded. "Buffer Status" flashes 
red when memory is nearly full. The instrument and rhythm currently 
selected are shown in red. Each of the function keys, Fl through F4, can 
be pressed to select from five different instruments; each of the second 
four function keys, F5 through F8, can be pressed to select from four 
different rhythms. 

To change the volume: 

1 . Press the HOME key to increase the volume. 

2. Press the END key to decrease the volume. 
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To change the key: 

1. Press the+ (plus) key or the- (minus) key on the numeric keypad. 

Music to "Twinkle, Twinkle, Little Star" and "When the Saints Go 
Marching In" appears below. The number above each note corresponds 
to the number shown on the learn mode keyboard (see figure 16-7). You 
can play either song on any row of the keyboard. 

Twinkle, Twinkle, Little Star 
(File name TWINKLE) 

1 5 5 6 6 5 4 4 3 3 

r r r 1 f f r I c c r r I 
2 2 5 4 4 3 3 2 

i c c r r r r 1r r r 
554 4 33 2 1 1 5 5 

ir r r r 1r r r lr r r r 1 

665 44 33 2 2 

if f r 1r r r r 1 r r r 
FIGURE 16-9: Twinkle, Twinkle, Little Star 

When the Saints Go Marching In 
(File name: SAINTS) 

II 

13 4 5 13 4 5 

@i 1 j J le iJ 1 J 
1 3 4 5 3 3 

1 j J I J lj J 
3 3 2 3 5 

j J J I~ I J J 
3 4 5 3 2 

J J I J lj J 
FIGURE 16-10: When the Saints Go Marching In 
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Changing Instruments 

Intelligent Organ can reproduce the sound of 20 different instruments. 
The instrument that is currently selected is highlighted on the control 
panel. 

The function keys Fl through F4 can be pressed to select an instrument: 

Fl F2 F3 F4 

Piano Organ 1 Violin Synthesizer 1 

Harp Trumpet Oboe Bass Synthesizer 

Electric Guitar Saxophone Flute Sitar 

Marimba Trombone Harmonica Javaican 

Alien Mars Clarinet Bells 

To select an instrument: 

1 . Press the function key to which the instrument you want is assigned. 

2. Keep pressing the function key until the instrument you want appears. 

Adding Accompaniment 

Intelligent Organ can add rhythmic accompaniment to whatever you 
play. The rhythm that is currently selected is highlighted in the control 
panel. 

The function keys F5 through F8 control which rhythm is in effect: 

FS F6 F7 FS 

March Rumba Swing Waltz 

March 1 Samba Swing 1 Waltzl 

March 2 Bosanova Rock & roll Waltz 2 

March (6/8) Tango Disco Jazz waltz 

To select a rhythm: 

1 . Press the function key to which the rhythm you want is assigned. 

2. Keep pressing the function key until the rhythm you want appears. 
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To turn accompaniment on and off: 

1 . Press the SPACEBAR. 

2. Press ENTER to end the accompaniment at the end of the phrase that is 
currently playing. 

To change the accompaniment volume: 

1 . Press the PgUp or up arrow key to increase the volume. 

2. Press the PgDn or down arrow key to decrease the volume. 

To change the accompaniment tempo: 

1 . Press the INS key to increase the tempo. 

2. Press the DEL key to slow down the tempo. 

To switch between major and minor chords: 

1. To switch from major to minor chords, press FlO. 

2. To switch from minor to major chords, press F9. 

To transpose a melody: 

1. To transpose a melody up one semitone, press the+ (plus) key on the 
numeric keypad. 

2. To transpose a melody down one semitone, press the- (minus) key on the 
numeric keypad. 

3. To transpose a melody up four full tones, hold down SHIFT and press the+ 
(plus) key on the numeric keypad. 

4. To transpose a melody down five full tones, hold down SHIFT and press the 
-(minus) key on the numeric keypad. 
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Adding an Automatic Arpeggio 

You can have Intelligent Organ add an automatic arpeggio as you play 
(an arpeggio is the notes of a chord played in succession rather than 
simultaneously). There are six arpeggios to choose from. 

To play an arpeggio: 

1 . Press the left bracket ( [ ) or right bracket ( ] ) key to select and play an 
arpeggio. 

2. Intelligent Organ plays the selected arpeggio (the number of the arpeggio is 
shown at the bottom of the first column on the control panel). 

To select an arpeggio: 

1 . Keep pressing the [ key or the ] key until you hear the arpeggio you want to 
use. 

To turn off the arpeggio: 

1. Press the apostrophe (' ) key. 

To change the arpeggio volume: 

1 . Press the up arrow key to increase the volume. 

2. Press the down arrow key to decrease it. 

The current volume setting is shown in the last column on the column 
panel, next to Arpg vol. 
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Playing an Artificial Melody 

You can have Intelligent Organ improvise an artificial melody based on 
what you are playing. 

To play an artificial melody: 

1. Press one of the following keys: 9, 0, -, =. 

The volume is controlled by the same keys that control the volume of the 
arpeggio. 

To change the volume: 

1 . Press the up arrow key to increase the volume. 

2. Press the down arrow key to decrease it. 

The current setting is shown in the last column on the column panel, next to · 
Arpgvol. 
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Saving/ Loading/ and 
Replaying a Song 

Intelligent Organ automatically stores whatever you play in a buffer in 
memory. (When the buffer is nearly full, the Buffer Status indicator in 
the lower right corner of the control panel begins to flash). Intelligent 
Organ records everything from the moment you press F2 to enter Play 
mode until you press ESC to return to the main screen. It records even if 
you are not playing, as though the silence were a rest in the music. 

Saving a Song 

To play the music in the buffer before you save it: 

1 . Press ESC to return to the main screen. 

2. Press F4. The control panel reappears on the screen, and Intelligent Organ 
plays the music in the buffer over and over until you press ESC to exit. 

NOTE Intelligent Organ clears the when you press F2 to enter Play 
mode. If you want to save what is in the buffer, save it before you 
re-enter Play mode. 

To save the music in the buffer: 

1 . Press ESC to return to the main screen. 

2. Press F7. The message below is displayed: 

Enter organ file to save: 

3. Type the name you want to give the file, then press ENTER. 

To clear the buffer: 

1 . Press ESC to return to the main screen if you need to. 

2. Press F2 to enter Play mode. 
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Loading and Replaying a Song 

To load a song: 

1. Press ESC to return to the main screen if necessary. 

2. Press F6. A list of the available songs is displayed. 

3. Select the song you want, and press ENTER. 

To play the song: 

1 . Press F3 to play the song once. You can add to the song after it plays and 
save those additions. Follow the steps as though it were a new song. 

2. Press F4 to play the song over and over until you press ESC. 
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Changing Default Settings 

You can change the default settings for the Intelligent Organ or for 
individual songs. 

To change the default settings: 

1 . Return to the main menu if necessary. 

2. Press FS. The Default Settings window appears: 

Sound Blaster Pro Intelligent Organ Uersion 1. B4 
Cop~right (c) Creative Technolog!:J Pte Ltd~ 1988-1991. All rights reserved. 

DEFAULT SETTING - Title : Unterlanders HelMueh 

Keyboard type : big Suitch 
Base Octave - big kbd : c - ~hythn : on 

- snail kbd : D - arpeggio : off - TeMpo : 14B Key 1 = c 
Scale : ttajor Arpeggio : 4 

InstruMent RhythM UoluMe 
Active - F2 Active - FS - Melody : 8 

F1 - PIANO FS - March - arpeggio : 5 
FZ - TRUMPET F6 - rhuMba - BCR : G 
F3 - UIOLIN F7 - swing 
F4 - SVNTH1 F8 - ualtz ORIGINAL UALUE 

ID or highlighted-Move cursor ;;-rotate option ~end B-abort change 

FIGURE 16-11: Intelligent Organ default settings window 

3. Press the T key and type either of the following: 

• The line below to set the default title for Intelligent Organ: 

CMS's Intelligent Organ 

• The name of the song for which you want to set defaults. 

4. To go to the setting you want to change, press the up or down arrow key, or 
press the key that matches the letter in red. 

5. To change the setting, press the left or right arrow key until the setting you 
want appears. 

6. To change all the settings to the factory defaults, press the 0 key. 

7. When you are finished, press ENTER. 

8. If you set defaults for a song, save the song. (See "Saving a Song" earlier in 
the chapter.) 
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Quitting Intelligent Organ 
To quit Intelligent Organ and return to DOS: 

1. Press F8 (more), then F4 (quit). The following message is displayed: 

Exit to DOS (y/n)? 

2. Press the Y key. 

The Intelligent Organ screen disappears and the DOS prompt returns to the 
screen. 
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Using a MIDI Keyboard 

If you have a MIDI keyboard, you can use it instead of your computer 
keyboard with Intelligent Organ. 

To use a MIDI keyboard: 

1 . Connect the Sound Blaster MIDI adapter to the joystick connector on 
Sound Blaster 16, if you have not already done so. 

2. Connect the MIDI cable to the MIDI-in connector on the MIDI adapter and 
the MIDI-out on the MIDI keyboard. 

3. Turn on the MIDI keyboard and set it to MIDI mode. 

4. Start Intelligent Organ. 

5. When the main screen appears, press FS then F5. 

The MIDI mode window appears: 

Sound Blaster Pro Intelligent Organ Version 1.e4 
Cop!-)right (c) Creative Technolog!:J Pte Ltd, 1988-1991. All rights reserved. 

,,1 111111111111111111111111~~ MIDI MODE 
Ke~ Signature: 

i!IIJ- Change Ke~ Signature f.mm-Select 

FIGURE 16-12: MIDI mode window 

Intelligent Organ is now ready to receive MIDI code from the MIDI 
keyboard. You can continue to use the computer keyboard to play a melody 
or select any function. 

6. Select the key signature you want to use (so Intelligent Organ can add the 
correct accompaniment). Press: 

• Up or left arrow to increase key by one semi tone 

• Down or right arrow to decrease key by one semi tone 
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7. Press ENTER to record the key signature, then press F2 to enter Play mode. 

To quit MIDI mode: 

1 . Press ESC to return to the main screen, then press F8 and F5. 

If the key signature of the song you are playing changes in the middle, 
use Intelligent Organ's transpose functions to match the key used by the 
MIDI keyboard (see "To transpose a melody" in "Adding 
Accompaniment," earlier in this chapter for more information). You can 
save a song you have played on the MIDI keyboard and replay it. You 
will not, however, hear the tune from the MIDI keyboard. 
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Appendix 



A 

Troubleshooting 

Sound Blaster 1 6 

PROBLEM: The installation program does not run properly, locks up, 
or does not complete. 

Cause: You probably have less than 420KB of free memory in 
your system. 

Solution: INSTALL.EXE requires 420KB of free memory to run 
properly. Make sure you have 420KB of free memory 
before you run INSTALL.EXE. 

To check the amount of memory that is free, type MEM 
at the DOS prompt and press ENTER. (If you are using 
DOS version 5.0 or earlier, type CHKDSK.) The system 
displays the memory that is available. The value for the 
largest executable program size must be more than 
430080 bytes. 

If you do not have enough memory, remove any 
memory-resident programs that are running before you try 
to run INST ALL.EXE again. 
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PROBLEM: The system cannot find the SOUND and/or BLASTER 
environment parameter values, or the settings are invalid. 

A-2 

Cause: The SOUND and/or BLASTER environment parameter 
values are not set correctly. 

Solution: Type SET at the DOS prompt and press ENTER to list 
the current environment settings. (Check your DOS 
manual for information on the Set command.) 

If the two environment strings are listed on the screen, 
call technical support for help. 

If the two environment settings are not listed: 

1 . Type CD\ and press ENTER to change to the root 
directory. 

2. Type TYPE AUTOEXEC.BAT and press ENTER. 

Your AUTOEXEC.BAT file appears on the screen. 

If the two environment strings are listed, it means they are 
not being executed. The two statements probably come 
after a DOS shell or menu software command. Such 
commands prevent SET SOUND and SET BLASTER 
from being executed. Move the SET SOUND and SET 
BLASTER statements to the first two lines of the file. 

If the two environment strings are not listed in the 
AUTOEXEC.BAT file, add them. To do so, use the 
Sound Blaster 16 configuration program. For 
instructions, see "Running the Configuration Program" in 
Appendix B, "Changing Sound Blaster 16's 
Configuration." 

After you have run the Sound Blaster 16 configuration 
program, restart the computer, then type SET at the DOS 
prompt and press ENTER to list the current environment 
settings. If the two environment strings still are not 
listed, call technical support for help. 
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PROBLEM: The message "Out of environment space" appears. 

Cause: The system environment allocation is too small. 

Solution: Add or modify the following line in the CONFIG.SYS 
file: 

SHELL=C:\COMMAND.COM /E:512 /P 

The switch IE sets a size for the system environment 
space. If the message displays again after you have 
increased the size to 512, change the size from 512 to 
1024. Check your DOS manual for information about the 
Shell command. 

PROBLEM: The system hangs during the 16-bit digitized sound test. 
The 8-bit test works fine. 

Cause: Your system is not handling 16-bit DMA transfer 
properly. 

Solution: Have the system transfer 16-bit data using the 8-bit DMA 
channel. You can do that by running the 
Sound Blaster 16 configuration program. For 
instructions, see "Running the Configuration Program" in 
Appendix B, "Changing Sound Blaster 16's 
Configuration." 
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CD-ROM Drive 

PROBLEM: There is no sound from speakers. 

Cause: The audio cable may not be connected properly or the 
volume is not adjusted to an audible level. 

Solution: The problem may be corrected by: 

• If your speakers are connected to the jack on the front 
of the CD-ROM drive, adjust the volume control on 
the drive. 

• If your speakers are connected to Sound Blaster 16, 
adjust the volume through the mixer or volume 
control on the back of the card. 

• Connect headphones to the jack on the front of the 
CD-ROM drive. If there is no sound from your 
headphones, check the audio cable connection to the 
Sound Blaster 16 (see Chapter 1, "Installing Creative 
Multimedia Kit"). 

PROBLEM: No valid CD-ROM driver is detected. 

A-4 

Cause: MSCDEX.EXE or SBCD.SYS is not loaded or could not 
be found. 

Solution: Your CD-ROM drive requires MSCDEX.EXE and 
SBCD.SYS to access the drive. Check your 
AUTOEXEC.BAT file for the following line: 

C:\SB16\DRV\MSCDEX.EXE /V /D:MSCDOOl /M:lS 

Check the CONFIG.SYS file for the following line: 

DEVICE=C:\SB16\DRV\SBCD.SYS /D:MSCDOOl /P:220 
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Windows Applications 

PROBLEM: Windows refuses to install a device driver, or the error 
message "Device not found" appears when you try to play 
a wave form or MIDI file or use CD audio. 

Cause: SYSTEM.INI may not include the necessary drivers. 

Solution: Display the SYSTEM.INI file: 

1 . In Windows, open the Program Manager and select the 
Control Panel icon. 

2. On the Control Panel, double click the Drivers icon. 
Your drivers list must include: 

[MC:I] Sound 
[MC:I] M:ID:I Sequencer 
[MC:I] CD Audio 

Add any of the three that is missing. 

3. Make sure you have the following settings in the [mci] 
section of the SYS1EM.INI file: 

WaveAudio=mciwave.drv 
Sequencer~iseq.drv 
CDAudio~icda.drv 

PROBLEM: There is no sound when Windows starts up. 

Cause: The drivers are not installed properly, or sound is disabled. 

Solution: Make sure the sound driver is installed: 

1 . Start Windows if it is not already running. 

2. Display the Program Manager, then go to the Main 
window and double-click the Control Panel icon. The 
Control Panel window appears. 

3. Double-click the Drivers icon. The Drivers dialog 
appears. 

4. Make sure the following drivers are listed in the dialog: 
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Creative Sound Blaster 16 Auxiliary Audio 
Creative Sound Blaster 16 Wave and MIDI 
MIDI Mapper 
Timer 
Voyetra /Sound Blaster SuperSAPI FM Driver 
[MCI] CD Audio 
[MCI] MIDI Sequencer 
[MCI] Sound 

5. Make sure the following settings appear in the 
[sndblst.drv] section of your SYSTEM.INI file: 

Port=220 
MidiPort=330 
Int=S 
DmaChannel=1 
BDmaChannel=S 

The values shown above are the factory settings. The 
values that appear in your SYSTEM.INI file must match 
the settings you have chosen for the Sound Blaster 16. 

PROBLEM: Duplicate icon items appear in the Sound Blaster 16 
group window. 

A-6 

Cause: If you have run the WIN SETUP program (in the \SB 16 
directory) a second time, one or more of the icons in the 
Sound Blaster 16 program group may have been 
duplicated. 

Solution: Delete any duplicate icons from the program group. 
Refer to your Windows manual for instructions. 
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PROBLEM: Sound Blaster 16 drivers are not installed when Windows 
starts. 

Cause: Drivers for another Sound Blaster audio card may be 
installed when you start up Windows. 

If Windows 3.1 was installed using "Express 
Installation," your hard disk was scanned for programs to 
be installed. Older versions of the Sound Blaster 
applications may have been installed if they were on your 
hard disk. 

Solution: Remove all existing Sound Blaster drivers from the 
"Installed Drivers List" and restart Windows. Add the 
drivers for Sound Blaster 16 and restart Windows. 

The following settings should appear in the [drivers] 
section of SYSTEM.INI: 

Timer=timer. drv 
Midimapper=midimap. drv 
Aux=sb16aux.drv 
MIDI=sb16fm.drv 
Wave=sbl6snd.drv 
MIDil=sb16snd.drv 
Super SAPI=sap! sb3. drv 

PROBLEM: The playback sounds jerky. 

Cause: Your Windows swap file may be fragmented. 

Solution: A temporary swap file tends to become fragmented. If 
possible, use a permanent swap file for Windows. Refer 
to your Windows manual for instructions on creating a 
permanent swap file. 
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PROBLEM: You do not get output after recording in Talking 
Scheduler. 

Cause: The recording source in Windows Mixer is not set up 
correctly. 

Solution: Select both the left and right audio source of the left input 
channel. 

PROBLEM: You do not hear any MIDI output. 

A-8 

Cause: MIDI mapper may not be set up correctly. 

Solution: In the Windows Control Panel, MIDI Mapper redirects 
MIDI output to various devices. Sound Blaster 16 has 
two MIDI devices: 

External MIDI port 
Internal MIDI synthesizer 

Normally, MIDI output is mapped to the internal MIDI 
synthesizer; if MIDI output is mapped to the external 
MIDI port, you need to connect external MIDI equipment 
or Wave Blaster. Before you make any changes to MIDI 
Mapper, refer to the Windows 3.1 documentation. 
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DOS Applications 

PROBLEM: The message "No interrupt vector available" appears 
when you are running SBFMDRV. 

Cause: All the DOS software interrupt vectors (INT SOH to 
OBFH) have been taken by a resident program. 

Solution: The SBFMDRV driver needs an interrupt vector ranging 
from INT SOH to INT OBFH. 

Usually those interrupt vectors are free. To solve the 
problem, you can do either of the following: 

• Use a DOS start-up disk to reboot the computer. 
Install SBFMDRV from the SB16 directory. 

• Install SBFMDRV before running the program that is 
causing the problem. 

PROBLEM: The system hangs during voice output. 

Cause: There is a hardware conflict between Sound Blaster 16 
and another adapter card. 

Solution If the interrupt setting on Sound Blaster 16 is IRQ7, you 
may have to change it to another setting. To help you 
identify the card that is in conflict with Sound Blaster 16 
and aid in resolving the conflict, see Appendix B, 
"Changing Sound Blaster 16's Configuration." 

PROBLEM: There is no sound. 

Cause: The volume is not turned up or speakers are not connected. 

Solution: Adjust the volume control on the back of the card. Use 
SB 16SET to adjust the volume (for instructions, see 
Chapter 11, "SB 16SET Utility"). 

Check the speaker connections. 
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Joystick 
PROBLEM: The joystick port is not working. 

Cause: Sound Blaster 16' s joystick port conflicts with another 
joystick port in the system. 

Solution: Change Sound Blaster 16'sjoystick port jumper, and use 
the joystick port that is in the system. For instructions, 
see "Changing the Joystick Port Jumper" in Appendix B, 
"Changing Sound Blaster 16's Configuration." 
(Disabling the joystick port does not affect its use as a 
MIDI port.) 

PROBLEM: The joystick is not working properly in some programs. 

Cause: This is a classic problem with programs that use CPU 
timing to calculate the joystick position. When the CPU 
is very fast, the program may not be able to determine the 
position of the joystick correctly because the program 
assumes the position of the joystick is out of its 
acceptable range. 

Solution: Switch the computer to its lowest possible speed. If the 
problem persists, try a different joystick. 
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Changing 
Sound Blaster l6's 
Configuration 

Installing Sound Blaster 16 with the default settings is desirable and 
successful for most computer configurations. If you are unable to 
successfully run the Sound Blaster 16 test program (DIAGNOSE), the 
problem may be one of the following: 

•:• BLASTER setting in the AUTOEXEC.BAT file does not match the 
jumper settings on the Sound Blaster 16. · 

B 

•:• One of the settings on the card is already being used by another card 
in your computer. 

When the installation program adds the BLASTER setting to the 
AUTOEXEC.BAT file, it uses the factory settings that are preset on the 
Sound Blaster 16. Before you change any of the jumper settings, make 
sure the card is set correctly with the factory defaults. 
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FIGURE B-1: A closed jumper is shown on the left, an openjumper on the 
right 

The Sound Blaster 16 factory settings are shown in the following table. 

Feature Setting Jumper Setting 

Base I/0 address 220H IOSO closed 
IOSl closed 

MIDI port base I/0 address 330H MSELclosed 
Interrupt line IRQ5 N/A 
Low (8-bit) DMA channel Channell N/A 
High (16-bit) DMA channel ChannelS N/A 
Joystick port Enabled JYEN closed 
Audio output amplifier Audio output amplified internally; N/A 

no external amplifier needed 

If any of the jumpers on your card do not match the factory settings, 
change them to the settings shown in the table, then run the 
Sound Blaster 16 test program again. (See "Changing the Jumper 
Settings," later in this appendix for instructions.) 
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Identifying a Card with -a 
Conflicting Setting 
If the Sound Blaster 16 test program indicates one of the setting is being 
used by another card in your computer, you need to change either the 
Sound Blaster 16 setting or the card with which it is in conflict. The 
Sound Blaster 16 initial settings are designed to work with many 
applications. Before you make changes to the Sound Blaster 16, try 
changing the settings of the card causing the conflict. 

To identify the card that is causing the conflict: 

1 . Tum off the computer. 

2. Remove the cover from the computer. 

3. Remove the nonessential cards from your computer one at a time. (Remove 
only nonessential cards--do not, for example, take out the hard disk 
controller or the video adapter card to which the monitor is attached.) To 
remove a card, remove the screw holding the card to the computer's frame, 
then pull up on the card to remove it from the slot. 

4. Tum on the computer. 

5. Run the Sound Blaster 16 test program (DIAGNOSE). 

If the Sound Blaster 16 test program runs without hanging or displaying 
any errors, the card you removed is the one causing the conflict. If the 
card has another setting you can use, make the changes and replace the 
card in the computer. Run the Sound Blaster 16 test program again to 
make sure changing the setting resolved the conflict. 

If the card does not have an alternate setting or if the alternate setting 
causes a conflict with yet another card, you need to change the 
Sound Blaster 16 settings. 
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Changing the Jumper Settings 
The jumpers on the Sound Blaster 16 control the following: 

•:• Base l/0 address 

+:• MIDI port base 1/0 address 

•:• Joystick port 

To change the position of one or more of the jumpers: 

1 . Tum off the computer. 

2. Remove the cover from the computer. 

3. Remove the screw holding the Sound Blaster 16 to the computer's frame, 
then pull up on the card to remove it from its slot. 

4. Change the position of the jumpers as described in the following sections. 
The location of the jumpers is shown in figure B-2 on page B-2. 

Write down the address that corresponds to the jumper settings you choose. 
You need that information when you run the configuration program. 

5. When you fmish changing the jumpers, replace Sound Blaster 16 in the 
computer. Replace the screw that holds the card to the computer's frame. 

6. Tum on the computer. 

If you changed the jumpers for the base 1/0 address, an error message may 
appear because the I/0 address in the CONFIG.SYS file no longer matches 
the 1/0 address set for the card. 

7. Run the configuration program (DIAGNOSE) to update the CONFIG .SYS 
file. 
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Changing the Base 1/0 Address Jumpers 

Four base 110 addresses are available: 

220H (factory setting) 
240H 
260H 
280H 

220H 240H 260H 280H 

1080 E..d] c:........:::J E.....!] c:........:::J 
1081 1::..=:::1 l:ba c:........:::J c:........:::J 

FIGURE B-3: 110 address settings; 220H is the default 

To select an address, set the jumpers as follows: 

Address Jumper Settings Notes 

220H (factory setting) IOSO closed Uses addresses 220H to 
IOSl closed 233H 

240H IOSO open Uses addresses 240H to 
IOSl closed 253H 

260H IOSO closed Uses addresses 260H to 
IOSl open 273H 

280H IOSO open Uses addresses 280H to 
IOSl open 293H 

NOTE //0 address 280H is a new address unavailable on 
Sound Blaster and Sound Blaster Pro. It is not recognized by 
applications designed for those cards. 
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Changing the MIDI Port Base 1/0 Address Jumpers 

Two MIDI port base 110 addresses are available: 

300H 
330H (factory setting) 

330H 300H 

MSEL IL-l r:..._:] 
FIGURE B-4: MIDI port IIO address settings; 330H is the default 

To select an address, set the jumper as follows: 

Address Jumper Setting Notes 

330H (factory setting) MSEL closed Uses addresses 330H and 331H 

Uses addresses 300H and 301H 300H MSEL open 

NOTE Most software written for MPU-401 (see "MPU401" in Appendix C, 
"Technical Information") only works if the MIDI port base UO 
address is set to 330. 

The MIDI port IIO address setting 330 and the DMA channel setting 
5 may conflict with the settings for Adaptec SCSI controllers. 

Changing the Joystick Port Jumper 

If there is a game card or a card with a joystick port installed in your 
computer, you need either to remove the card or to change the JYEN 
jumper on the Sound Blaster 16 card to disable its joystick port. To 
enable or disable the joystick port, set the jumper as follows: 

Joystick Port Jumper Setting Notes 

Enabled (factory setting) JYEN closed 

Disabled JYENopen 

8-6 

Port works both as a joystick port 
and a MIDI port 

Port works only as a MIDI port 
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Running the Configuration 
Program (DIAGNOSE) 

The configuration program: 

•:• Verifies your Sound Blaster 16 hardware settings 

•:• Performs audio functionality test 

•:• Updates system files with corrected settings 

To run the configuration program: 

1. On the disk drive on which the Sound Blaster 16 software is installed, type 
CD \SB16 to switch to the directory in which the configuration program is 
located. 

2. Type DIAGNOSE and press ENTER to start the program. 

3. When the Sound Blaster 16 Configuration screen appears, read the 
information displayed, then press ENTER. The Base I/0 Port menu appears. 

Base 1/0 and MIDI Port 1/0 

The DIAGNOSE program verifies the base 1/0 address and MPU-401 
MIDI port. 

To set up and test the base IIO address and the MIDI port IIO address: 

1 . Highlight the base I/0 address you have set the jumpers to use, or choose 
Auto Scan, then press ENTER. (Auto Scan selects the first address that is 
available and checks to see if it is already in use.) 

The program displays a message: "If other peripheral cards on your system 
are using the same address that you have chosen, the system might halt due 
to hardware setting conflicts." 

If the address you choose is available, the program displays a message that 
confirms the I/0 address. 

If the system hangs, turn off the computer, change the jumpers on the card, 
and run the configuration program again. 
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2. Press ENTER. The MIDI Port menu appears. 

3. Highlight the address you set the jumper to use, or choose Auto Scan, then 
press ENTER. 

If the system hangs, tum off the computer, change the jumpers on the card, 
and run the configuration program again. 

If the address you choose is available, the program displays the new MIDI 
port address. 

4. Press ENTER. A screen appears that explains how to test and select 
interrupt and DMA settings. 

5. Press ENTER again. The Interrupt (IRQ) menu appears. 

Interrupt and DMA Channels 

To set up and test the interrupt: 

1 . The option with the word current next to it is the interrupt currently set in 
the AUTOEXEC.BAT file. 

IRQ 2 

IRQ 5 (Current) 
IRQ 7 

IRQ 10 
Auto Scan 

Choose an interrupt setting and press ENTER. 

If the interrupt you choose is available, the program displays a message that 
tells you the interrupt is detected. 

If the system hangs, reboot the computer and run DIAGNOSE again. This 
time choose a different setting for the interrupt (or select Auto Scan to have 
the program choose a setting). 

2. Press ENTER. The program displays a message confirming the interrupt 
setting. 

3. Press ENTER again. The Low DMA Channel menu appears. 

NOTE must switch from IRQ 5 to a interrupt and you mainly 
use Windows applications, try IRQ 10 (applications designed for 
Sound Blaster 16 do not IRQ 10 ). 
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To set up and test the Low (8-bit) DMA channel: 

1 . The option with the word current next to it is the channel currently set in 
the AUTOEXEC.BAT file. 

Channel 0 
Channel 1 (Current) 
Channel 3 
Auto Scan 

2. Press ENTER. 

If the channel you choose is available, the program displays a message that 
tells you the channel is detected. 

If the system hangs, tum off the computer and run DIAGNOSE again. This 
time change a different setting for the low DMA channel (or select Auto 
Scan to have the program select a setting) and press ENTER. 

The program displays a message confirming the low DMA channel setting. 

3. Press ENTER to display a high DMA information screen. 

To set up and test the High (16-bit) DMA channel: 

1 . Information about the high DMA channel settings is displayed. Read the 
information and press ENTER to display the High DMA Channel menu: 

Channel 5 (Current) 
Channel 6 
Channel 7 
Use Low DMA 

Auto Scan 

The option with the word current next to it is the channel currently set in 
the AUTOEXEC.BAT file and press ENTER. 

If the channel you choose is available, the program displays a message that 
tells you the channel is detected. 

If the system hangs, tum off the computer and run DIAGNOSE again. This 
time change a different setting for the low DMA channel (or select Auto 
Scan to have the program select a setting) and press ENTER. 

Press ENTER. The program displays the new configuration settings and 
requests the boot drive for the CONFIG.SYS and AUTOEXEC.BAT files. 
Enter your boot drive and press ENTER. 
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2. The program asks for the WINDOWS directory. Type the path of your 
WINDOWS directory and press ENTER. The settings you select are wrtten 
to the BLASTER environment line in AUTOEXEC.BAT. The default 
settings are: 

SET BLASTER=A220 Dl IS HS P330 T6 

Letter Setting Example 
==== ==~======== 
A Base I/0 address A220 is I/0 address 220H 
D Low DMA channel Dl is channel I 

H 
p 

T 

Interrupt I5 is IRQ 5 

High DMA channel H5 is channel 5 
MIDI port base I/0 address P330 is I/0 address 330H 
Type of Sound Blaster card T6 is Sound Blaster 16 

3. Press ENTER. The program asks if you want to restart your system so the 
new settings can take effect. 

4. Press theY key. The computer restarts. The new settings are now in effect. 

The AUTOEXEC.BAT and CONFIG.SYS files have been modified. 
The originals are saved with the file name extension .B-K. 

If changing the 16-bit DMA channel setting does not solve the problem 
you are having with 16-bit digitized sound, your computer is not 
handling 16-bit DMA transfer properly. If that is the case, the system 
may hang, or you may get a memory parity error. You can solve the 
problem by having the system transfer 16-bit data using the 8-bit DMA 
channel. For instructions, see "Running the Configuration Program" 
later in this appendix. 

NOTE The DMA channel setting 5 and the setting 
330 may conflict with the settings for Adaptec SCSI controllers. 
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Resetting the BLASTER 
Environment 
The Sound Blaster 16 configuration program-DIAGNOSE-lets you 
reset the interrupt and DMA channel options and write the changes to the 
BLASTER environment line in the AUTOEXEC.BA T file. 

To reset the interrupt and DMA channel options: 

1. Type CD \SB16 to switch to the Sound Blaster 16 directory. 

2. Type DIAGNOSE and press ENTER to run the configuration program. 

3. Read and follow the instructions in the program. Only the settings for the 
interrupt and DMA channel options can be changed-the 1/0 addresses 
must be changed by resetting the jumpers on the audio cards (see 
"Changing the Jumper Settings" earlier in this appendix). 

At the end of the configuration program, the BLASTER environment line is 
updated in your AUTOEXEC.BAT file. And, the line below is added to the 
AUTOEXEC.BAT file to ensure that Sound Blaster 16 reads the BLASTER 
environment for the interrupt and DMA channel settings: 

C:\SB16\DIAGNOSE /S 

4. Restart your computer for any change in the settings to take effect. 

NOTE If the BLASTER settings are not in the AUTOEXEC.BATfile, 
DIAGNOSE IS returns an error message when the computer is 
started. 
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Connecting Additional 
CD-ROM Drives 
The following information explains how to change the ID jumpers on the 
back of your CD-ROM drive and use a daisy chain cable to connect 
additional drives. 

Changing the ID Jumper 

When you connect or daisy-chain more than one CD-ROM drive, each 
drive must have a unique ID setting. The ID jumper on the back of the 
CD-ROM drive allows you to set four different IDs. 

To change the configuration of the jumpers: 

1 . Tum off your computer and other connected devices. 

2. Remove the computer cover and CD-ROM drive from your computer. 

3. Select the ID for the drive by placing the jumper block on the desired set of 
pins (see figure B-5). A jumper block is a removable plastic hood that fits 
over a pair of pins. 

0 1 2 3 

Drive ID 0 

0 1 2 3 

0 1 2 3 

Drive ID 1 

Drive ID 2 Drive ID 3 

FIGURE B-5: ID settings for each of four CD-ROM drives 

NOTE 

B-12 
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If you use model52x CD-ROM drive for daisy-chaining, its ID is not 
cnc.mJ?,eao•te and is assumed to be 0. 
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Connecting the Drives 

You need a daisy-chain cable to connect the drives as shown in figure 
B-6. Connect the audio cable to drive ID 0. 

I 
Min. Length 
about 
6"' (15cm) 

FIGURE B-6: Daisy-chaining the CD-ROM drives 
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Technical Information 

Sound Blaster l 6 

Music Synthesizer 
•:• Enhanced FM OPL3 synthesizer using four operators 

•:• Frequency modulation (FM) sound generation 

•:• Compatible with previous Sound Blaster versions and Adlib FM 

•:• Two-operator mode: 20 voices (15 melodies and 5 percussion) 

•:• Four-operator mode: 11 voices (6 melodies and 5 percussion) 

Stereo Digitized Voice Channel 
•:• 16-bit and 8-bit digitizing in stereo and monaural 

•:• Standard format for PCM data 

c 

•:• Programmable sampling rate: 5 kHz to 44.1 kHz in 228 linear steps 
in DOS 

•:• 16-bit and 8-bit DMA channels using a single interrupt 

•:• FIFO buffer for high speed data transfer 

•:• Dynamic filtering for digital audio recording and playback 
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Built-in Digital/Analog Mixer 

•!• Analog mixing of six audio sources: 

• Digital audio (stereo) 

• CD audio (stereo) 

• Synthesized music (stereo) 

• Extra line level audio (stereo) 

• Microphone level audio (monaural) 

• PC speaker (monaural) 

•!• Software programmable volume control: 

• Master volume (stereo, 32-level attenuation in 2-dB steps) 

• Digital audio (stereo, 32-level attenuation in 2-dB steps) 

• CD audio (stereo, 32-level attenuation in 2-dB steps) 

• Synthesized music (stereo, 32-level attenuation in 2-dB steps) 

• Extra line level audio (stereo, 32-level attenuation in 2-dB steps) 

• Microphone level audio (monaural, 32-level attenuation in 2-dB 
steps) 

• PC speaker (monaural, 4-level attenuation in 6-dB steps) 

•!• Master treble and bass control (left and right channels) 

• 16 levels from -14 dB to + 14 dB in 2-dB steps 

•!• Recording source control: Independent selection of input sources for 
both channels or a combination of the following: 

• CD audio left channel 

• CD audio right channel 

• Synthesized music left channel 

• Synthesized music right channel 

• Line level audio left channel 

• Line level audio right channel 

• Microphone level audio 

·:· Output and input gain control 
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Built-in Stereo Power Amplifier 

•:• Four watts per channel (PMPO) with four ohms stereo output 

•:• Automatic gain control or fixed gain amplifier for microphone level 

MIDI Interface 

•:• Built-in MIDI interface for connection to external MIDI devices 

•:• Sound Blaster compatible or MPU-401 UART mode 

•:• MIDI specification fixed at 31.2 kHz 

•:• FIFO for smooth operation 

•:• Internal expansion option for Wave Blaster daughter board 
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CD-ROM Drive 

Performance 

•:• Storage Capacity 

•:• Buffer Memory 

•:• Transfer Rate 

•:• Access Time 

•:• Audio Specifications 

• Headphone Out 

• Line Out 

• Number of Channels 

• Frequency Response 

• Dynamic Range 

• Signal-to-Noise Ratio 

• Distortion 

• Stereo Separation 

C-4 

680 MB ( 12 em disk) 
180MB (8 em disk) 

64KB 

150 KB/sec (normal) 
300 KB/sec (double speed) 

320 ms (double speed) 

0.6 Vrms (RL:32W) 

0.8 Vrms (RL:50W) 

2 

100 Hz to 20 kHz (headphones) 
20 Hz to 20 kHz (line out) 

80 dB (headphones) 
80 dB (line out) 

80 dB (headphones) 

0.2% at 1kHz 

45 dB (headphones) 
60 dB (line out) 
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Sound Blaster 1 6 
Software Programs 
The Sound Blaster 16 software includes the installation program 
(INSTALL.EXE), and the Windows setup program (WINSETUP.EXE). 

Sound Blaster 1 6 Software Installation 

The installation program first creates a directory and a number of 
subdirectories on your hard disk. It then copies the software on the disks 
into the directory and subdirectories. It adds lines to the CONFIG.SYS 
and AUTOEXEC.BAT files. 

The installation program adds four lines to the AUTOEXEC.BAT file 
similar to the following: 

SET BLASTER=A220 Dl IS HS P330 T6 
SET SOOND=C:\SB16 
SET MIDI=SYNTH:l MAP:E 
C:\SB16\DIAGNOSE /S 
C:\SB16\SB16SET /P 

SET SOUND specifies the location of drivers used by Sound Blaster 16. 
SET BLASTER specifies the hardware settings. (SET SOUND and SET 
BLASTER are described in Appendix B, "Changing Sound Blaster 16's 
Configuration.") The third line executes the DIAGNOSE program that 
programs the card's settings. (For more information, see Appendix B, 
"Changing Sound Blaster 16's Configuration.") The fmalline sets the 
master, voice, CD-audio, and MIDI (FM) music volume settings to 
preset values (see Chapter 11, "SB16SET Utility," for more information). 
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Windows Driver and Application Setup Program 

The INSTALL program: 

•:• Copies the following files into the \WINDOWS\SYSTEM directory: 

sb16aux.drv 
sb16fm.drv 
sb16snd.drv 

•:• Adds the lines in the left column to the [drivers] section of the 
Windows system initialization file, SYSTEM.INI: 

Aux=sbl6aux.drv 
MIDI=sb16fm.drv 
MIDI1=sb16snd.drv 
Wave=sb16snd.drv 

Auxiliary driver 
Internal MIDI synthesizer 
External MIDI port driver 
Wave driver 

•:• Adds a new section named [sndblst.drv] to the SYSTEM.INI file. 
The section contains the information in the left column: 

port=220 
int=S 
dmachannel=l 
MidiPort=330 
HDmaChannel=S 

Base l/0 address 
Interrupt setting 
8-bit DMA channel 
Base MIDI port l/0 address 
16-bit DMA channel 

The WIN SETUP program in the \SB 16 directory does the following: 

•:• Creates a new program group for Sound Blaster 16 and TextAssist, 
and adds, to the group windows, an icon for each of the applications. 

C-6 Technical Information 



1/0 Address Map 

The following is an overview of the I/0 addresses used in 
Sound Blaster 16. For information about the jumper settings, see 
Appendix B, "Changing Sound Blaster 16's Configuration." For 
information about programming specifications, refer to the Developer 
Kit available to application developers registered with Creative Labs. 
(For more information, call Creative Labs' Developer Relations at ( 408) 
428-2345, or FAX at (408) 432-6717.) 

The four functional blocks using I/0 addresses are: 

•:• Sound Blaster 16 

•:• MPU-401 UART mode 

•:• Game port 

•:• FM music synthesizer 

Sound Blaster 1 6 

Sound Blaster 16 uses 20 consecutive I/0 addresses. The I/0 addresses 
selectable from 220H, 240H, 260H, and 280H are as follows: 

Base Address 

220H 

240H 

260H 

280H 

110 Address Used 

220Hto 233H 

240Hto 253H 

260Hto273H 

280Hto 293 H 

The description of each port is as follows: 

Address 

Base+OH 

Base +OH 

Base+ lH 

Base+2H 

Base+ 3H 

Base+4H 

Base +5H 

1/0 Address Map 

Port 

FM music status port 

FM music register address port 

FM music register data port 

Advanced FM music register address port 

Advanced FM music register data port 

Mixer and 1/0 setup register address port 

Mixer and 110 setup data port 

Read/Write 

Read 

Write 

Write 

Write 

Write 

Write 

Read/write 
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Address Port 

Base+6H DSP reset port 

Base +8H FM music register address port 

Base +9H FM music register data port 

Base+OAH DSP read data 

Base+OCH DSP write data or command 

Base +OCH DSP write buffer status 

Base+ODH DSP timer interrupt clear port 

Base+OEH DSP data available status 

Base+OFH 16-bit voice interrupt clear port 

Base+ IOH Reserved 

Base+ 11H Reserved 
Base+ 12H Reserved 

Base+ 13H Reserved 

MPU-401 

MPU-401 UART mode uses two consecutive addresses: 

Base Address 

330H 

300H 

110 Address Used 

330H to 331H 

300Hto 301H 

The description of each port is as follows: 

Address 

MPUBase+O 

MPUBase+ 1 

MPUBase+ 1 

Game Port 

Port 

MPU-401 data port 

MPU-401 status port 

MPU-401 address port 

Read/Write 

Write 

Write 

Write 

Read 

Write 

Read 

Read 

Read 

Read 

Read/Write 

Read/write 

Read 

Write 

The I/0 address used by the game port is similar to a game or joystick 
port. 

Address 

200H-207H 
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Port 

Game port 

Read/Write 

Read/write 
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FM Music Synthesizer 

The following I/0 addresses used by the FM music synthesizer are 
compatible with other synthesizer cards such as Adlib. 

Address Port Read/Write 

388H FM music status port Read 

389H FM music register address port Write 

389H FM music register data port Write 

38BH Advanced FM music register address port Write 

38BH Advanced FM music register data port Write 
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Pin Definitions 

Audio Connector Pin Definitions 

PC Speaker Connector 

Pin Signal 1/0 
==========~~============ 

+5V 

2 SPK 

In 

In 

CD-IN Connector 

Pin Signal 1/0 

Ground In 

2 . CD left channel In 

3 Ground In 

4 CD right channel In 

Audio Extension Pin Definitions 
Pin Definition Description 

I LININ Line input 

2 MICGND Input ground 

3 MICIN Microphone input 

4 SPKGND Speaker output: ground 

5 SPKR Speaker, right channel maximum output: 
0.8 Vrms at lOk ohms (pins l-2 on jumper OPSR: Line out) 
3 Vrms at 4 ohms (pins 1-2 on jumper OPSR: Speaker out) 

6 SPKL Speaker, left channel maximum output: 
0.8 V rms at lOk ohms (pins l-2 on jumper OPSR: Line out) 
3 V rms at 4 ohms (pins 2-3 on jumper OPSR: Speaker out) 

7 SPKRL Speaker output return signal: Left channel 

8 SPKRR Speaker output return signal: Right channel 
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Internal Extension Pin Definitions 
Pin Signal Pin Signal 
1 Digital ground 2 Ne 
3 Digital ground 4 MIDI output 

5 Digital ground 6 vee 
7 Digital ground 8 Ne 
9 Digital ground 10 vee 
11 Digital ground 12 Ne 
13 Ne 14 vee 
15 Analog ground 16 Ne 
17 Analog ground 18 +12V 

19 Analog ground 20 Line in left 

21 Analog ground 22 -12V 

23 Analog ground 24 Line in right 

25 Analog ground 26 ResetB 
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Technical Support 

At Creative Labs, we are committed to giving our customers the best 
product possible as well as excellent technical support. The information 
below is correct as this manual goes to press; check the software disks 
for a README file that will give any changes. 

Technical Support 

When you contact us, be prepared with the following information: 

•:• Computer's CPU type and speed (for example, 486/33), and memory 
available 

•:• Name of memory management utility, if any (for example, QEMM, 
HIMEM, or EMM386) 

•:• Type of video card and any add-in cards (for example, SCSI controller) 

•:• Version of DOS and Windows 

North, Central, and South America 

If you need technical assistance, call 405-7 42-6622. Technical support is 
available seven days a week from 8:00a.m. to midnight, Central time. 
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You can get the latest program and driver updates from Creative Labs' 
bulletin board, 24 hours a day. Call405-742-6660; use modem settings: 

Baud rate 
Data bits 
Parity 
Stop bits 

300 to 14400 (V.32N.42 bis) 
8 
none 
1 

You can also send us a FAX at 405-7 42-6633 or write us at: 

Technical Support 
Creative Labs, Inc. 
1523 Cimarron Plaza 
Stillwater, OK 74075 

If you write or FAX us, include a description of your problem and the 
information listed above. 

Europe 

In Europe, the telephone, FAX, and bulletin board numbers are: 

+ France: Telephone: (33) 1.39.20.04.21 

+ Germany: Telephone: (49) 2131-102838 
Bulletin Board: (49) 2131-919820 

+ Ireland: Telephone: (353) 1-820-7 555 

+ United Kingdom: 

FAX: (353) 1-820-5052 

Telephone: (44) 734-344744 
Bulletin Board: (44) 743-360287 

Direct all F AXs to Ireland. You can also write us at: 

Creative Labs (Ireland) Ltd. 
Blanchardstown Industrial Park 
Blanchardstown, Dublin 15 
Ireland 

If you write or FAX us, include a description of your problem and the 
information listed above. 
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Asia 

For locations throughout Asia, call Creative in Singapore at 65-773-4048 
for technical support. Operating hours, Singapore time, are: 

Monday-Friday 
Saturday 
Sunday and holidays 

9:00 a.m.-6:00p.m. 
9:00 a.m.-1:00 p.m. 
Closed 

You can also send us a FAX at 65-773-0353 or write us at: 

Technical Support Department 
Creative Technology Ltd. 
Blk 75, #01-04 
Ayer Rajah Crescent 
Singapore 0513 

If you write or FAX us, include a description of your problem and the 
information listed above. You can get copies of software and driver 
updates from Creative Technology's bulletin board; ca1165-776-2423. 

Compuserve 
The Creative Labs Forum on Compuserve allows you to address 
questions directly to our company representatives, and receive new 
product information and software updates. ' 

If you are a member of Compuserve, use the following command at the 
Compuserve prompt to access the Forum: 

GO BLASTER 

If you are not a member of Compuserve, receive a free introductory 
membership by calling 1-800-524-3388, ask for representative #228. 
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Product Return 
In order to return a Creative Labs product for factory service, you must 
have a Return Merchandise Authorization (RMA) number. You can 
obtain an RMA number by calling the Technical Support office nearest 
you (see above for locations and telephone numbers). Creative Labs will 
not accept a return without an RMA number. 

When returning a product for factory service: 

•:• Shipment to Creative Labs is at your expense-you assume all risk. 
Ship the package through a carrier that provides proof of delivery; 
insure the shipment at full product value. 

•> Place the RMA number on the outside of the package. 

•:• Use proper materials for packing the product for shipment. 

•:• You must include a copy of a dated proof of purchase (store receipt), 
proving that the product is within the warranty period. 

Creative Labs may replace or repair the product with new or 
reconditioned parts, and the replaced parts or product become the 
property of Creative Labs. Creative Labs warrants the repaired or 
replaced product to be free from defect in material and workmanship for 
a period of the greater of: (1) ninety (90) days from the return shipping 
date, or (2) the period of time remaining on the original one-year 
warranty. 

Outside the United States 

When shipping a product to Creative Labs in the United States from 
another country, you must obtain and complete an official customs form 
before shipping the product to avoid any tariffs. Creative Labs may 
include charges for return shipment to ensure delivery of the product. 

D-4 Technical Support 



Index 

.CMFfiles: 12-1-12-2 

.MID files: 12-1-12-2 

.VOC files: 12-1-12-2 

.WAV files: 7-2, 12-1-12-2 
See also WaveStudio 

A 
Adlib Music card: 3-14, C-9 
ADPCM 

See compression 
amplifier 

external: 1-2, 2-5, 3-11 
internal: 2-2, 2-5, B-2, C-3 

amplitude: 5-1 
applications 

See also DOS applications 
See also Windows applications 
installing: 3-12 
third-party: 3-14 

AUTOEXEC.BAT: 3-6,3-8, A-2, B-1, 
B-8-B-11, C-5 

B 
BLASTER environment 

See SET 

c 
cassette player, connecting: 2-5 
CCITT !J.-Law 

See compression 
CCITT A-Law 

See compression 
CD-ROM drive: 1-4-1-5, 3-1, C-4 
compression 

ADPCM: 5-30, 7-4 
CCITT !J.-law: 5-30, 7-4 
CCITT A-law: 5-30, 7-4 

CONFIG.SYS: 3-8-3-9, A-3, B-4, C-5 
connectors: C-10-C-11 
conventions: v 
Creative Labs' Bulletin Board: D-2 
Creative Mixer: 4-l-4-8, C-2 

D 

devices, connecting: 2-1,2-3,2-5 
DMA channels: 3-10-3-11, A-3, B-2, 

B-9-B-11, C-6 
DOS applications: 3-14, A-9 

See also Intelligent Organ 
See also PLAY Utility 
See also QuickCD 
See also RECORD Utility 
See also SB16SET 
See also Text-to-Speech 
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drivers 

E 

auxiliary audio: A-6-A-7 C-6 
installing: 3-12 ' 
MCI: A-5-A-6 
MIDI: A-6-A-8, C-6 
SuperSAPI FM: A-6 
third-party: 3-14 
Timer: A-6-A-7 
Voyetra: A-6 
wave and MIDI: A-6-A-7 
Windows: 3-12 

embedding 
See object 

EnsembleAV: 6-1-6-36 
EnsembleCD: 6-8-6-16 
EnsembleMIDI: 6-28-6-36 
EnseinbleRemote: 6-2-6-7 
Ensemb1eWave: 6-17-6-27 

EnsembleCD 
See EnsembleA V 

EnsembleMIDI 
See EnsembleA V 

EnsembleRemote 
See EnsembleA V 

Ensemble Wave 
See EnsembleA V 

F 
FM music synthesizer: C-1, C-9 
frequency: 5-1 

G 
game port: C-8 

H 
hardware configuration: 3-8-3-10 
headphones: 2-2, 3-11, B-7 
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I/0 address: 3-10, B-2, B-5, B-7-B-8, 
B-10, C-6-C-7, C-9 

installation: 1-1-1-7,2-3,3-1-3-14, 
16-6, A-1-A-3, C-5--C-6 
software: 9-6 

Intelligent Organ: 16-1-16-17 
adding accompaniment: 16-9-16-10 
arpeggio: 16-11 
artificial melody: 16-12 
defaults: 16-15 
four-octave mode: 16-3 
instruments: 16-9 
keyboard controls: 16-2-16-3 
learn mode: 16-5 
loading: 16-1 
loading a song: 16-13-16-14 
MIDI keyboard: 16-17 
playing a song: 16-7-16-12 
quitting: 16-16 
replaying a song: 16-14 
saving a song: 16-13 
two-octave mode: 16-4 

interrupt: 3-10-3-11 A-9 B-2 B-8 
B-10-B-11, C-6 ' ' ' ' 

J 
~oystick: 1-2, 2-3, A-10, B-2, B-6, C-8 
JUmper: 1-2, B-1-B-2, B-4--B-5 

L 
linking 

See object 

M 
microphone 

connecting: 2-5 
MIDI: 1-2, 2-3-2-4, 12-2-12-3, 

16-17,C-3 
I/0 address: B-2, B-6-B-8, B-10 
output: A-8 

Mixer: 4-1-4-8 



audio source: 4-2 
balance: 4-3 
gain control: 4-6 
LED display: 4-4 
recording source: 4-2,4-5-4-6 
volume: 4-3 

Monologue for Windows: 9-1-9-24, 
14-1 
applications: 9-5 
Clipboard mode: 9-4, 9-10-9-11 
ODE interface: 9-13-9-14 
DOE Server mode: 9-5,9-12 
Dictionary Manager: 9-17-9-20 
DLL interface: 9-13-9-16 
Excel mode: 9-5,9-10-9-11 
installation: 9-6, 9-10 
network: 9-13 
phonetics: 9-23-9-24 
problems: 9-21-9-22 
programming: 9-13-9-16 
speech generation: 9-4 

Mosaic: 8-1-8-4 
menus: 8-4 
quitting: 8-4 
starting: 8-1 

MPU-401 UART: 2-3, 12-2, B-6, C-8 
Multimedia Extensions for Windows: 

9-3 

0 
object 

p 

embedding: 7-6-7-7, 10-9-10-10 
linking: 7-6-7-8,10-9-10-11 

PLAY utility: 12-1-12-7 
.CMF files: 12-6 
.MID files: 12-6 
.VOC files: 12-5 
.WAV files: 12-5 
audio COs: 12-3, 12-7 
examples: 12-4 
playback: 12-5-12-7 

Q 

QuickCD (DOS): 15-1-15-7 

R 

Read 
See Text-to-Speech 

README: 3-7 
RECORD utility: 13-1-13-3 

.VOC files: 13-1 

s 

.WAV files: 13-1 
examples: 13-3 

sampling: 5-1-5-2 
SB16SET utility: 11-1-11-6 

Mixer (DOS): 11-1, 11-3-11-6 
SBFMDRV: 12-2, A-9 
SBTALKER 

See Text-to-Speech 
SET 

BLASTER: 3-13, A-2, B-1, 
B-10-B-11, C-5 

SOUND: 3-13, A-2, C-5 
sine waves: 5-1 
Sound Blaster: B-5 
Sound Blaster 16 

configuration: 3-8, B-1-B-11, 
C-7-C-9 

connecting devices: 2-1-2-5, 3-11 
drivers: 3-12, A-7 
l/0 address: 3-10, C-7 
installation: 1-1-1-7, 3-1-3-13, C-5 
testing: 3-9, B-3 

Sound Blaster Pro: 1-2, 3-2, 3-14, B-5 
Sound Blaster type: B-10 
SOUND environment 

See SET 
Soundo'LE: 7-1-7-9 

.WAV files: 7-2 
compression: 7-4 
embedding: 7-6-7-7 
File Open dialog: 7-2 
keyboard controls: 7-2 
linking: 7-6, 7-8 
menus: 7-10 
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Object dialog: 7-7 
quitting: 7-9 
recording: 7-3---7-4 
Save As dialog: 7-9 
saving: 7-9 
starting: 7-1 

speaker, internal: 2-4 
speakers, external: 2-3, 2-5, 3-11 
system requirements: iv 
SYSTEM.INI: A-5---A-7 

T 
Talking Scheduler: 10-1---10-13 

animation characters: 10-2 
appointments: 10-3---10-5 
clock: 10-4 
Date window: 10-4 
Delete Appointments dialog: 10-5 
deleting appointments: 10-5 
deleting object: 10-12 
editing appointments: 10-5 
Embed Object dialog: 10-10-10-11 
embedding an object: 10-9---10-10 
linking an object: 10-9---10-11 
Make Appointments window: 10-4 
menus: 1 0-13 
output: A-8 
Program Defaults window: 10-2 
quitting: 10-13 
Record Voice Annotation dialog: 

10-6-10-7 
Reminder dialog: 10-9, 10-12 
Review Appointments dialog: 10-12 
running: 10-3 
setting up: 10-2 
speech settings: 10-2 
starting: 10-1 
window: 10-1 

technical support: D-1---D-2, D-4 
testing: 3-11, B-1, B-3 
Text-to-Speech: 14-1---14-5 

installation: 14-1 
Read: 14-3---14-5 
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SBTALKER: 14-1---14-3 
troubleshooting: A-1---A-10 

v 
volume control 

devices: 3-11 
sound card: 3-11, A-9 

w 
Wave Blaster: 2-4, A-8 
wave files 

See WaveStudio 
WaveStudio: 5-1---5-31 

CD Sync: 5-31 
customizing: 5-27---5-28 
Edit window: 5-5 
file compression: 5-30-5-31 
file management: 5-29 
memory requirements: 5-29 
menus: 5-8---5-12 
mouse: 5-7 
Preview window: 5-6 
starting: 5-3 
Status bar: 5-6 
toolbar: 5-3---5-4 
wave files: 5-13---5-26,5-30 

Windows 
drivers: A-5 
swap file: A-7 

Windows applications: 3-12, 3-14, A-1, 
A-5---A-7, C-6 
See also Creative Mixer 
See also EnsembleA V 
See also Monologue for Windows 
See also Mosaic 
See also Soundo'LE 
See also Talking Scheduler 
See also WaveStudio 

WINSETUP: 3-12---3-13, A-6, C-6 



Software Warran1y 
CREATNE LABS, INC., warrants that the physical disks and the physical 
documentation enclosed herein to be free of defects for a period of 60 days from the 
date of purchase. In the event of a defect in material or workmanship during the 
warranty period, Creative Labs will replace the defective media or documentation 
when the defective product is returned to Creative Labs by the owner. The remedy 
for this breach of warranty is limited to replacement only and shall not cover any 
other damages, including but not limited to the loss of profit, special, incidental, 
consequential, and other similar claims. 

Hardware Warran1y 
Creative Labs warrants that the product enclosed herein to be free of defects for a 
period of one year from the date of purchase. In the event of a defect in material or 
workmanship during the warranty period, Creative Labs, at its discretion, will repair 
or replace the defective product when the defective product is returned to Creative 
Labs by the owner. The remedy for this breach 6f warranty is limited to servicing or 
replacement only and shall not cover any other damages, including but not limited to 
the loss of profit, special, incidental, consequential, and other similar claims. 

Creative Labs specifically disclaims all other warranties, expressed or implied, 
including but not limited to implied warranties of merchantability and fitness for a 
particular purpose with respect to the defects of the products and program license 
granted herein. With respect to the use of this product, in no event shall Creative 
Labs be liable for any loss of profit or any commercial damage, including but not 
limited to special, incidental, consequential, or other damages. Some 
states/countries do not allow the exclusion of limitation of liability for 
consequential, or incidental damages, in which case the above limitation may not 
apply to you. 

If the product is found to be defective, Creative Labs, at its option, agrees to replace 
or repair the product at no charge except as stated below, provided that you deliver 
the product with a return material authorization (RMA) number and a dated proof of 
purchase. If you ship the product to Creative Labs, you must assume the risk of 
damage or loss in transit. You must use the original container (or the equivalent) 
and pay the shipping charge. 

Creative Labs may replace or repair the product with new or reconditioned parts, 
and the replaced parts or product become the property of Creative Labs. Creative 
Labs warrants the repaired or replaced product to be free from defects in material 
and workmanship for a period of the greater of: (1) ninety (90) days from the return 
shipping date, or (2) the period of time remaining on the original container one-year 
warranty. 

Before returning any product, contact Creative Labs' Technical Support (for 
telephone numbers and addresses, see the Technical Support section of this 
document). If Creative Labs' Technical Support verifies that the product is 
defective, the Return Authorization Department will issue an RMA number to place 
on the outer package of the product. Creative Labs cannot accept any product that 
does not include an RMA number on the package. 



Sound Blaster® Compatibility Logos 

Sound Blaster is synonymous with high quality, industry standard audio cards 
for the IBM personal computer and compatibles. The Sound Blaster 
compatibility logos you see below are an extension of this commitment to 
quality from Creative Labs to you, our valued customer. Products bearing any 
of these logos have been tested by Creative Labs for compatibility with the 
Sound Blaster line of audio cards.* Look for these logos as your assurance of 
compatibility on software and peripherals that you purchase for use with your 
Sound Blaster audio card. 

* 

Sound 
BLAST::::::R 

Sou rid 

Sou rid 

Products bearing this logo work with the 
Sound Blaster line of audio cards. 

Products bearing this logo work with the 
Sound Blaster line of audio cards and contain 
16 bit audio files. 

Products bearing this logo work with the 
Sound Blaster line of audio cards and have direct 
MIDI support for the AW£32 and/or use the 
downloadable SoundF ont capabilities of the A W £32. 

Some software and peripheral products require specific IRQ, DMA, and 1/0 settings on the 
Sound Blaster audio card to function properly. 

Sound Blaster is a registered trademark and the Sound Blaster compatib ility logos are trademarks of 
Creative Technology Ltd. 
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1 90 1 rvlcCarthy Boulevard 
Milpitas, CA 95035 
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